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CHAPTER 1: INSTALLING GIGASTUDIO 4 
 

 
GigaStudio 4 can be extremely powerful; the more powerful your computer, the more you can take advantage 
of GigaStudio 4’s features. Following is important information about optimizing and configuring your 
computer for best results with digital audio production in general, and GigaStudio 4 in particular. 
 
Windows Operating Systems Compatibility 
GigaStudio 4 is compatible with Windows XP (Home or Professional Edition) running the Service Pack 2 
patch (SP2), Vista 32-bit, and Vista-64 bit. GigaStudio 4 is not supported for systems running Windows XP 
Media Center Edition, Windows 2000, Server 2000, 98, ME, NT, 95, or 3.1, nor under Apple’s Boot Camp 
utility for the Macintosh. Although GigaStudio 4 may run under Windows 2000, XP Media Center Edition, 
or Boot Camp, this is not approved by TASCAM and users do so at their own risk. 
 
To find out if your version of XP is running Service Pack 2, right-click on the “My Computer” icon in the 
Start Menu and select “Properties.” In the General section, it will read “Service Pack 2” below the listed op-
erating system if SP2 is installed. 
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With Other Programs and Peripherals 
While GigaStudio 4 co-exists well with other programs, removing or disabling startup applications, system 
utilities (e.g., Norton Utilities or McAfee), internal and external hardware devices (e.g., tape drives, scanners, 
TV tuners, non-essential sound or MIDI drivers), and other non-essential elements may increase GigaStudio’s 
performance. Remember—the more you demand of GigaStudio, the more GigaStudio will demand of your 
system resources. 
 
It’s also a good idea to use the latest drivers for various peripherals (graphics card, audio interfaces, etc.). 
 
With HyperThreading 
GigaStudio 4 is not compatible with HyperThreading techonology. However, it is not necessary to disable 
this in the system BIOS.  
 
A Word About Computers 
The original GigaSampler was ahead of its time, and in some respects, had to wait for computer technology to 
catch up. As a result, it required top-of-the-line computers. Thanks to modern technologies like dual core 
processors and inexpensive RAM, even many of today’s less expensive computers can run GigaStudio 4. 
However, the better your computer, the further you can push GigaStudio—for example, a really good 
computer might make the difference between being able to run 16 and 128 instruments simultaneously. 
 
For those seeking the ultimate level of performance, GigaStudio 4 can run on newer, 64-bit operating systems 
like 64-bit Vista that let GigaStudio access virtually unlimited amounts of RAM. But it’s equally at home with 
32-bit systems like Windows XP. 
 
Disk Management 
It’s best to have separate drives for your: 
 
• OS and applications (C: drive) 
• DAW data files 
• GigaStudio 4 sound libraries. Defragment this drive often using the Windows Defragment 

utility. (Start > Programs > Accessories > System Tools > Disk Defragmenter) 
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As all these processes are hard disk-intensive, dividing the load over different drives allows for 
more complex projects, with more stable operation. Creating a separate audio partition on the 
same drive as your OS and programs is not satisfactory; this causes the OS drive to work even 
harder, as it is simultaneously seeking application data in one partition and streaming audio data 
from another. A dedicated drive for your content frees up both drives to separately access the 
program data and the audio data. 
 
If your motherboard has only two IDE or SATA connectors, you would normally connect the 
system drive to the primary connector (IDE 1 or SATA 1) and the audio drive to the secondary 
connector (IDE2 or SATA 2). Set each hard drive’s jumper to master (a diagram on the drive itself 
will show where to place the jumper to select master mode). Configure your CD or DVD drive as 
the slave device on IDE1 or SATA1, and make sure that it is sharing the system drive connection 
ribbon cable and not the audio drive connection ribbon cable to which your dedicated audio drive 
connects. This will insure uninterrupted data flow to and from the more critical audio drive. If 
your motherboard has a separate IDE or SATA controller(s), your setup will be more flexible as 
well as allowing for more physical drives. 
 
The impulse content should ideally be placed on yet another separate drive from the .Gig content, 
or on the system drive with the OS and programs. 
 
Also, each IDE drive must have DMA enabled (System > Control Panel). To do this in Windows 
XP: 
 
1.  Right-click My Computer, located on the Desktop or in the start menu, and choose Properties.  
2.  Select the Hardware tab.  
3.  Click the Device Manager button.  
4.  Double-click on the IDE ATA/ATAPI Controllers entry to expand it. 
5.  Locate and double-click the device for your IDE/ATA controller channel.  
6.  In the Properties dialog, click the Advanced Settings tab.  
7.  Under Transfer mode, select DMA if available, and click OK.  
8.  Repeat for any additional IDE/ATA drives.  
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9.  Click OK to close the Device Manager dialog.  
10.  Close the System Control Panel.  
 
Once you have restarted, follow steps 1-6 above once again to make sure “DMA” is in fact still set to enabled. 
If your computer is unable to keep this setting or your computer doesn’t allow enabling DMA, and you are 
having problems running GigaStudio, you (or one of your technically-minded friends) may need to change a 
setting in your system BIOS (Basic Input Output System). 
 
To access your computer’s BIOS you must restart your computer. During the initial startup your computer 
will tell you which key to press in order to enter the setup program. Typically, repeatedly pressing either the 
[Delete] or [F2] key during the initial stages of the boot process will access the BIOS on most (but certainly not 
all) motherboards. Refer to your motherboard manual for manufacturer specific BIOS commands. Press the 
corresponding key during startup. You should see an “Entering Setup” message. If present, make this change 
to your computer’s BIOS: 
 

Allow PCI Bus Masters = Enabled 
 
In addition to checking the BIOS if DMA is not available, you can also check in device manager under “Hard 
disk controllers” and make sure that you have the IDE controller and not the ATA controller. If you have an 
ATA controller, update the hard disk controller driver to “standard dual IDE controller.” 
 
Removing a Previous Installation of GigaStudio 
Before installing GigaStudio 4, you will need to remove any previous version of GigaStudio from your 
computer. If you attempt to install GigaStudio 4 without removing a previous version, you’ll see a screen that 
tells you a previous version of GigaStudio 4 is installed, and will be removed. 
 
However, you may have performance (.GSP), articulation (.ART), and/or instrument (.GIG) files saved in the 
same directory as you GigaStudio installation. Any .GSP, .ART, or .GIG files that show up under either of 
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the directories C:\Program Files\Nemesys or C:\Program Files\Tascam will be removed during the 
uninstall process and you will lose all of the data in those directories. 
 
Be sure that you back up any performance files (.GSP), articulation files (.ART), and instruments 
(.GIG) before proceeding with the uninstall. You will still be able to use any of these with GigaStudio 4. 
Check for these file types visually with the Windows file explorer, or using the Windows search tool. 
 
To uninstall your previous GigaStudio installation: 
 
1.  Click the Windows Start button.  
2.  Go to the Control Panel item on your Start Menu. Double-click the Add or Remove Programs option 

in the list.  
3.  In the installed programs list, locate and click on the Tascam GigaStudio item. 
4.  Click the Change/Remove button to remove the previous version of GigaStudio. 
 
Windows will ask you if you want to continue with the removal of the previous version of GigaStudio. When 
the removal process is complete, you will be prompted to restart the computer. At this point you may want to 
save any open files and close any open programs. If you just want to keep working and install GigaStudio 4 
later, you can choose not to restart at this time. 
 
Once the computer has restarted, you have successfully uninstalled your previous version of GigaStudio. 
 
Installing GigaStudio 4 
1.  Insert the GigaStudio 4 Installation disc in your computer’s drive; allow it to spin up and be recognized. 
 
2.  When the “splash” screen appears, click on Install GS4. (If this screen does not appear, navigate to your 

CD drive, right-click on it and select Open, then double-click on the Giga4_Install.exe file.) 
 

 
 
3.  If you are prompted to remove a previous version of GigaStudio, refer to the preceding section on 

Removing a Previous Version of GigaStudio. It is not possible to proceed any further until you have 
successfully removed your existing version of GigaStudio. Otherwise, continue. 
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4.  The GigaStudio 4 Setup Wizard screen appears. After reading the Warning, click on Next to continue. 
 

 
  
5.  Look over the license agreement, which is a legally binding contract between you and TASCAM. If you 

agree to the terms, click on “I Agree” then click on the Next button. Otherwise, click on Cancel. 
 

 
 
6.  The Select Installation Folder screen appears. Here you can choose whether to install GigaStudio 4 for 

all users (Everyone) or just yourself. Unless you have a compelling reason not to install GigaStudio on 
your C: drive under Program Files, TASCAM highly recommends that you retain the defaults. 
Otherwise, you can click on Browse and navigate to a different drive. 
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7.  The Confirm Installation screen appears. Click on Next to start the installation process, or Back if you 

entered information incorrectly and want to re-enter it. After clicking on Next, a progress bar appears 
to inform you of the overall progress. 

 

 
 
8.  After a successful installation, the Installation Complete screen appears. If this screen does not appear, 

the two most likely causes are that your system does not meet the minimum requirements, or that you 
have tried to install GigaStudio 4 into a drive that lacks sufficient space. Correct the source of the 
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problem, reboot your computer, then start the installation process over. Otherwise, click on Close. The 
main GigaStudio 4 program is now installed. 

 

 
 
9.  Restart your computer before attempting to use GigaStudio 4. 
 
Installing GigaStudio 4 Content 
The content provided with GigaStudio 4 can be installed now or later. To install all or part of the content now, 
double-click on the content you want to install, and follow the instructions to assign the drive and folder 
location for the content to be installed.  
 
•  The folder destination option for factory instruments is [drive letter]:\Tascam\Gigs. 

The folder destination option for factory impulses is [drive letter]:\Tascam\Gpulse\Common. 
 
•  When you run GigaStudio for the first time, you will need to make some settings and specify some user 

information. Also, see the GigaStudio Configuration Manager section for details on matching 
GigaStudio with the sound and MIDI hardware installed on your system. 

 
Getting Help 
The first place to check is the TASCAM web site at www.tascam.com. GigaStudio 4 receives periodic updates 
to improve performance, and you should check for these first. Also, updates to this manual, as well as 
tutorials, are posted there, as well as all information regarding how to contact tech support.  
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CHAPTER 2: USER INTERFACE BASICS 
 

 
The user interface has many user-definable features that let you customize GigaStudio 4’s look and feel for the 
way you like to work. As with any set of tools, as your experience increases you’ll be able to refine 
GigaStudio’s look and feel to best fit your working style. 
 
GigaStudio consists of many components that can be resized, selected, hidden, and further configured and 
manipulated in multiple ways. 
 
Selecting MIDI Ports 
 
At the bottom of the MIDI Mixer Port window are tabs for each of the eight available MIDI Ports. (Note: Your 
MIDI interface hardware may not support eight independent ports.) Each port allows up to 16 MIDI channels 
of instruments, and you can stack up to 128 instruments per channel. So, with a sufficiently powerful 
computer, it’s theoretically possible to have 16,384 instruments loaded simultaneously.  
 
Click on a port’s tab to view the 16 MIDI channels of the selected MIDI Port. Or, use the keystroke Alt + n 
where n is the number of a MIDI Port. Example: Alt + 3 selects the Port 3 view and brings its 16-channel 
display to the front. (For a complete list of keystroke shortcuts, see the Keystroke Appendix.) 

 

 
 
Selecting Components with the Toolbar 
The toolbar selects various views and functions; clicking on a button calls up a particular function. When you 
hold your mouse cursor over a button, a tooltip text tells you the button’s function. From left to right, these 
buttons are: 
 

 
 
New Performance: Creates a new GigaStudio 4 performance (alternate: Go File menu > New Performance or 
type Ctrl-N) 
Open Performance: Opens a browser to find a GigaStudio 4 performance (alternate: Go File menu > Open 
Performance or type Ctrl-O). 
Save Performance: Save the current GigaStudio 4 performance (alternate: Go File menu > Save Performance 
or type Ctrl-S). 
Launch Giga Editor: Opens GigaStudio 4’s Instrument Editor. 
Launch Sequencer: Opens the sequencer program specified when configuring GigaStudio 4. 
Launch Wave Editor: Opens the wave editing program specified when configuring GigaStudio 4. 
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Launch QuickSound: Opens the QuickSound Explorer database for finding files easily (alternate: Go Tools 
menu > Launch QuickSound Explorer or hit the F10 function key on your computer’s keyboard). 
Show/hide MIDI Mixer: Toggles between showing and hiding the MIDI Mixer window (alternate: Go View 
menu > MIDI Mixer or type Ctrl-M). 
Show/hide DSP Station: Toggles between showing and hiding the DSP Station window (alternate: Go View 
menu > DSP Station or type Ctrl-D). 
Show/hide Loaded Instruments: Toggles between showing and hiding the Loaded Instruments window 
(alternate: Go View menu > Loaded Instruments or type Ctrl-L). 
Show/hide Virtual Keyboard: Toggles between showing and hiding the Virtual Keyboard window (alternate: 
Go View menu > Keyboard or type Ctrl-K). 
Start Audio Capture: Click to capture GigaStudio’s master output channels to disk. (Note: This is not 
available in ReWire mode, described later). 
Stop Audio Capture: Click to stop audio capture. 
Discard: Click to discard a complete or partial audio capture. 
Capture tool status: Shows the status of the audio capture tool. This has no editable parameters. 
Available hard disk space for recording: Shows the hard drive space available for recording. This has no 
editable parameters. 
Audio Engine on/off: When on, click on the red square to stop the engine. When off, click on the green arrow 
to start the engine. 
Reset: Reset GigaStudio 4 to a preferred state. The options are described later in this chapter. 
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Changing Pane Heights: Splitter Bar 
When several panes are viewable within the main GigaStudio 4, splitter bars appear between the windows. 
When the cursor is over a splitter bar, it becomes an up/down arrow cursor. Click and drag to move the 
splitter bar so that one pane increases in height while the other decreases. 
 

 
 
Changing Component (Window) Size 
According to standard Windows protocol, you can adjust a component’s overall size by placing the cursor 
over any of its corners. When the cursor becomes a diagonal two-headed arrow, click and drag the component 
to increase or decrease its size. 
 
Floating and Docking Components 
You can “float” or “dock” the Loaded Instruments list, Virtual Keyboard, and DSP Station components (the 
QuickSound Explorer opens in its own window, so it is inherently floating). Docking places the component 
within the main GigaStudio window. Floating allows removing the component from the window, which is 
particularly handy with dual- and triple-monitor setups—for example, you might want to place the MIDI 
Mixer in one monitor, and the DSP Station in another. 
 
Floating Components 
To float a component, click on its name label along the left-hand edge, and drag it away from where it is 
docked. The component will now float above the rest of the user interface. 
 

 
 



GigaStudio 4 Reference Manual  16 

Note that to float the DSP Station, you must first select the View Menu option “Show DSP Station in a separate 
pane.” 
 

 
 
To move a floating object around the screen, grab its title bar and drag it with the mouse. When you find a 
suitable place for the component, release the mouse and the object will stick in place until it is moved again or 
hidden from view. 
 
To hide a component and free up screen space, you have several options (remember, the component is only a 
click away if you need to use it again). 
 
If the component is floating, click on the X (standard Windows close function) in the upper right corner. 
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If the component is docked, click on the X in the upper left corner, above the name label, of the component you 
want to hide. 
 

 
 
In the View menu, you can check (show) or uncheck (hide) the MIDI Mixer, DSP Station, Loaded Instruments 
Pane, and Keyboard Pane. 
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Docking Components 
To dock a floating component, click on the title bar, and drag so that the left side of the component’s window 
approaches the left side of the main GigaStudio window. Upon releasing the mouse, the component will dock 
within GigaStudios’s main window. 
 

 
 
 
Other View Menu Options 
Bring to Foreground 
This option allows selecting a particular window and bringing it to the front. For example, if the DSP Station 
and Loaded Instruments components are floating on top of the Keyboard and you go Bring to Foreground > 
Keyboard (or type the Alt – K shortcut), the Keyboard will jump to the top of the stack. 
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Show One DSP Channel in the MIDI Mixer 
This is somewhat like the “Inspector” feature found in DAWs like Cubase and Sonar, as it shows the DSP 
channel strip for the selected MIDI Mixer channel. Its location is fixed toward the right side of the MIDI 
Mixer. 
 

 
 
Link Loader Pane Visibility to MIDI Mixer 
If checked, the Loaded Instruments Pane will show if you’ve selected the MIDI Mixer, and will hide if you 
select the DSP Station. However, note that the Show/Hide Loaded Instruments toolbar button or menu option 
takes priority, even with the DSP Station selected and the Link Loader option checked. 
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Status Bar 
This shows/hides the Status Bar along the bottom that displays CPU and memory consumption, MIDI Port 
activity, and the like. Hide this to regain a little bit of screen space. 
 

 
 

Saving User Interface Settings 
All the aspects of the user-defined interface components can be saved in the “Save As…” options (located in 
the File menu) of a saved performance. To do this, check the Use Customized Performance button, and click on 
Customize to see your options of what can be saved. 
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Resetting User Interface Settings 
 
There are several user-defined options from the adjacent drop-down menu. 
 

• Reset just Instruments (unloads all instruments from memory) 
• MIDI Mixer and Channel Properties (returns mixer to the default state) 
• Hardware (re-establishes audio connection) 
• DSP Station Mixer (returns DSP Station to the default state) 
• User Interface (returns window sizes and positions to the default state) 
• Load Default Performance Settings (loads user-defined default settings). 
• All (resets all of the above options to the default state). All will likely reset any instruments you may 

have loaded, so you will be asked if you want to save anything before the reset occurs. 
 

 
 
Fader, Knob, and Slider Adjustments 
To adjust the various control widgets in GigaStudio 4, click directly on the control and drag.  
 

 
 
As soon as you drag the mouse, the cursor will disappear so you can see the widget movement as well as its 
displayed value. If you prefer that the cursor not disappear, go Configuration > GigaStudio Settings > General 
tab and under Visual Preferences, uncheck the “Auto hide cursor” option. 
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The direction in which you drag the mouse determine the widget movement behavior: 
 

 
 
For knobs, click and drag the cursor: 
 
• Up or right to adjust knob clockwise 
• Down or left to adjust knob counter-clockwise 
• Diagonally for fine adjustment 
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For faders (vertical), click and drag the cursor: 
  
• Up to adjust the fader upward 
• Down to adjust the fader downward 
• Diagonally left-to-right to make fine adjustments upward 
• Diagonally right-to-left to make fine adjustments downward 
 

 
 
For Sliders (horizontal), drag the cursor: 
 
• Right to adjust the slider right-ward 
• Left to adjust the slider left-ward 
• Diagonally left-to-right to make fine adjustments rightward 
• Diagonally right-to-left to make fine adjustments leftward 
• Hold the [Alt] key while dragging for fine adjustment either way
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CHAPTER 3: MIDI MIXER 
 

 
The MIDI Mixer section is where you load instruments (as well as stack/layer them) and perform basic MIDI 
mixing functions such as mute, solo, tune, pan, and set volume. Note that all of these controls affect only MIDI 
data; the audio data of each instrument is then routed to the DSP Station where you can apply EQ, effects, 
dynamics control, and more. 
 

 

 
 
MIDI Basics 
The MIDI spec provides for 16 channels of data, each of which can drive a separate instrument. MIDI was 
invented in the early 1980s, when a synthesizer was hardware that cost thousands of dollars, so 16 channels 
was considered adequate. Over time, this became more and more of a limitation, so interfaces started including 
multiple MIDI ports, each of which could provide 16 channels of data. Thus, a MIDI interface with four ports 
could send data to (4 x 16) 64 different instruments. 
 
GigaStudio 4 can accept data from up to 8 MIDI ports, with 16 channels per port — that’s 128 instruments. 

 
 

 
 Furthermore, you can layer up to 128 instrument sounds on a single channel (referred to as Sub-Channels), 
giving the ability to address a theoretical maximum of 16,384 instruments! So for all practical purposes, 
GigaStudio provides an unlimited sonic palette. 
 
MIDI Mixer Parameters 
 

Each MIDI port channel (and sub-channel) has a full complement of mixer-like controls. Following is a 
numbered diagram and description of each parameter in the MIDI Mixer view. 
 
1. Channel Slot: The channel slot field is where you load and “detach” (remove from channel) instruments 
that are assigned to a particular MIDI channel. Upon attaching an instrument to a channel or sub-channel, the 
instrument’s name appears in the channel slot field. Clicking on the Channel Slot drop-down menu opens a 
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channel-specific menu that allows you to Load, Stack, or Detach instruments, edit Stack and Channel 
properties (keyboard mapping), and more. 
 
2. MIDI activity meter: Illuminates when the channel receives MIDI data, with higher velocities causing 
more meter segments to light. 
 
3. Mute: Silences the channel’s incoming MIDI so it produces no sound. This affects all sub-channels. 
 
4. Solo: Silences all channel’s Incoming MIDI other than the soloed channel. This affects all sub-channels. 
 
5. Q(uickEdit) button: When a MIDI channel contains an instrument, the Q button turns bright green 
(active). Clicking the Q button opens the QuickEdit View for the instrument loaded on that particular channel. 
Multiple QuickEdit views for multiple instruments can be open simultaneously. 
 
6. FX: For instruments that have an embedded convolution effect using the GigaPulse Convolution Processor 
included with GigaStudio, this button will be bright green. Clicking on the FX button displays the GigaPulse 
view. If the instrument has more than one embedded instance of GigaPulse, a popup menu appears that allows 
you to select the desired instance. 

  
7. Assignable MIDI sliders: The three available MIDI sliders default to controlling a channel’s Volume, 
Tune, and Pan, but can be assigned to any MIDI controller from 1 to 119 as well as program change, fine tune, 
and course tune via the controller name’s drop-down menu. This provides a convenient way to adjust MIDI 
continuous controller (CC) data from the main MIDI Mixer view. Note that changing a slider assignment does 
not alter the value of any previous assignment. Example: If you use a slider to set a channel’s volume level, 
then change the slider to control LFO modulation, the volume level remains where you set it. 
 
8. Output assign: This allows assigning a channel to a specific input of the DSP Station mixer. GigaStudio 4 
defaults to the DSP Station having 32 channels (16 stereo), but this can be changed by opening Configuration 
> Mixer and selecting the Mixer tab. Usually, the default of one stereo DSP input for each of Port 1’s MIDI 
channels is the most convenient setup, where MIDI Mixer channel 1 goes to DSP Station inputs 1+2 MIDI 
Mixer channel 2 goes to DSP Station inputs 3+4, etc.  

 
 

 



GigaStudio 4 Reference Manual  26 

The MIDI Mixer: Loading, Unloading, Attaching, and Detaching Files 
 

GigaStudio 4 File Formats 
You can load (and save) a variety of file formats into MIDI mixer slots via the File menu. These are: 
 

.GIG Files: These can contain multiple (single) instruments, arranged in banks, that may be loaded or stacked 
into the MIDI mixer’s individual channels using the MIDI Channel drop-down menus or the Quicksound 
Explorer. When loading a GIG file that contains multiple instruments, all of the contained instruments are 
loaded into RAM, but only the first instrument is attached to the specified MIDI channel. .GIG files are created, 
edited and saved using the GigaEditor Application. 
 
.GSP Files: GigaStudio Performance files contain no audio or MIDI data, but instead are small files (they 
require hardly any disk space) and contain a map of every instrument loaded, every knob, fader, audio effect 
(NFX and VST), slider setting, and GigaPulse plug-in setting, as well as the size and arrangement of the 
various graphical components as they are displayed on your monitor(s). There are two main ways to create a 
new performance file: 
 

• Start with a blank new performance by going File > New Performance. The default Performance has 
empty instrument loader slots, faders at nominal settings, and no FX. After loading the desired 
instruments and making any desired tweaks, you can then save the performance. 

 

 
 

• Open an existing performance file, change it as desired, then go File > Save Performance As… to 
create an additional performance with a new and unique name. This lets you create variations derived 
from the same basic template of loaded instruments, mixer settings, tweaks, and plug-ins, but each 
tailored to a specific application. 

 
 
.GSI Files: GigaStudio Instrument files are simplified .GSP files that recall loaded instruments, MIDI Mixer 
settings/routing, as well as instrument specific QuickEdit and GigaPulse tweaks. The main difference is that 
loading a .GSP file resets (clears) the sampler before loading any instruments, while a .GSI file can be loaded 
into a session that already contains instrument assignments. .GSI files can be loaded on any empty MIDI 
channel and do not recall any DSP Station or graphical UI settings. 
 
.GSI files can contain single or multiple instruments that are either loaded on separate MIDI channels or on a 
single MIDI channel as a stacked instrument. If you load multiple .GSI files, you can always save this 
collection as a .GSP file.  
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Stacking vs. Loading 
There are two ways to add instruments to a channel in the MIDI mixer after clicking on a MIDI Channel’s 
drop-down menu: Load and Stack. 
 
Load: This replaces anything currently loaded in a MIDI Mixer channel. If the channel already contained 
instruments, they are “detached” from the channel but not “unloaded” from memory (see below). 
 

 
 

Stack: This adds an instrument to a MIDI mixer channel without detaching any currently loaded 
instrument(s), thus layering the new instrument with any instruments already loaded in the channel. The 
“Stack” option is not available until at least one instrument is loaded on a MIDI mixer channel. 
 

 
 

Detaching vs. Unloading 
There are two ways to remove instruments from the MIDI mixer: Detach and Unload. 
 
Detach Instrument: This is available from the MIDI Channel’s drop-down menu. Detaching clears the 
Instrument from a MIDI mixer channel assignment. However, the instrument remains loaded in the Sampler’s 
memory (RAM) and can therefore be recalled by a program change either into the original channel to which it 
was assigned, or into an alternate MIDI channel. 
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Unloading: This is available from the Loaded Instruments window (described later) and removes the 
Instrument both from any MIDI channel assignments and from the Sampler’s memory altogether, thus 
freeing up RAM.  
 

 
 
 

Loading a Single File into a MIDI Channel 
A MIDI channel that contains no instrument displays “Instruments...” in its channel slot field. To load a File 
using a channel’s drop-down menu: 
 
1. Click on the Down Arrow located on the right border of the channel slot field of an empty MIDI channel to 
open that channel’s drop-down menu. 
2. Move the cursor over the “Load” menu item. Up to four Load options/sections will appear in the following 
order: Browse, VST Instruments, GVI Instruments, and Recently loaded Instruments. 
 
Browse 
The “Recent” field shows recently-accessed folders. If you select one of these, it will appear in the “Look In” 
field, which uses standard Windows navigation techniques to find folders containing GigaStudio 4-
compatible files. The drop-down button (a) shows your computer’s file tree; the four navigation buttons are 
Back button (b), Up One Level of the file tree (c), create New Folder (d), and View Options (e). 
 
 

 
 

Upon selecting a folder, the main pane shows any .GIG or .GSI files within the folder. 
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In the Files of Type field, you can choose to display only .GIG, only .GSI, both types of files, or All Files 
(including non-GVI compatible types). Note that .GSP files are loaded using the main GigaStudio File menu 
since performances affect all MIDI channels simultaneously. 
 

 
 

Click on a file name, and its name appears in the File Name field. 
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Clicking on the downward arrow in the File Name field shows a list of recently-accessed files. 
 

 
 

The individual instruments contained in a highlighted .GIG file show up in the “Instruments to load” 
pane. Here you can select to load an individual instrument or “All Instruments in Gig File.” 

 
 

 
 



GigaStudio 4 Reference Manual  31 

The Properties section shows the file name, version, and other information. 
 

 
 

Once you’ve selected the instrument(s) you want to load, click on Open. This closes the “Open” dialog and 
loads the selected Instrument(s) into GigaStudio. 
 
Loading VST Instruments 
The second section of the Channel Load Menu lists all available VST Instruments. Here you can select any 
Giga-compatible VST instrument that’s installed on your computer. Note that for a VSTi to appear in this 
menu, it must be included in the VSTi search paths as defined in the Giga Configuration Manager’s 
Rewire/Plugins tab. 
 

 

 
Loading GVI Compatible Virtual Instruments 
The third section of the Channel Load Menu Lists all the GVI wrapped content that is installed on your system. 
It is possible to load GVI based third-party protected and non-protected content (e.g., Sonivox Muse, 
DigitalSoundWorks Dramatic Percussion, Ilio Plectrum, etc.) directly into GigaStudio to take advantage of 
extended functionality and Kernel mode performance. Once loaded into Giga, these Instruments behave in the 
same fashion as traditional .GIG instruments.  
 
Like VSTi’s, wrapped GVI search paths are specified in the Rewire/Plugins section of Configuration Manager. 
Each GVI wrapped instrument installer will give you the option of where to install, however, the default 
directory is: 
 
C:\Program Files\Tascam\Instruments 
 
Wrapped GVI instruments installed into this directory will automatically be added to the GS4 channel load 
menus. If you choose to install a wrapped GVI instrument in a directory other than the default, it will be 
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necessary to manually add the specified install directory to the Configuration Manager’s GVI-Compatible 
Virtual Instruments Search Paths. 
 
When a wrapped GVI instrument is loaded into GS4, the sample data is loaded directly into the specified MIDI 
channel and appears as traditional GIG content would appear. The GVI UI (Custom or otherwise) is not loaded 
into GS4, only the raw instrument and sample data. 
 
Of course since wrapped GVI’s are embedded content by design, it is not possible to open wrapped GVI 
instruments in the Giga Editor. You can however make changes to the instrument using QuickEdit and save 
those changes into a GSI or GSP performance. 

 

 
 

Recent Files List 
Below the GVI wrapped instrument section of the Channel Load Menu is the Recent Files list. This shows 
recently-loaded instruments; to prevent the list from getting excessively long, there are additional sub-
categories for Past 7 Days, Past 30 Days, and Older. If you choose one of the files from this list, it will load 
automatically on the specified channel. 
 

 
 

The Load Status Bar 
The Status Bar along the bottom of the GigaStudio main interface monitors loading progress. Note: When 
loading a multi-instrument GIG file, only the first instrument will be attached to the specified MIDI channel. 
The other instruments are loaded into memory and appear in the Loaded Instruments pane.  
 
There are three components to the Load Status bar. From left to right, these are: 
 

 Pause button (1). Click to pause or cancel the loading process. 
 Status field (2). This field monitors the overall progress of all instruments currently loading. 
 Progress field (3). If multiple Instruments are being loaded, this field shows which of the set of 

instruments is being loaded (e.g., 2/7 means that the second of seven instruments is being loaded), the 
instrument’s name, and how much of the instrument has been loaded. 

 



GigaStudio 4 Reference Manual  33 

 
 

Stacking Files on a MIDI Channel 
Once a channel contains one or more loaded instruments, the option to Stack instruments appears in that 
channel’s drop-down menu. Stack works similarly to Load and uses the same type of browser, but layers the 
newly selected instrument on the same channel with the currently loaded instrument. Without defining a 
Keyswitch (see below), MIDI messages sent to that channel are passed to all instruments on the stack, which 
play back simultaneously. 
 

 
 

Note: To drag-and-drop a .GIG file from QuickSound or the desktop into a mixer channel and have it stack 
with an instrument instead of overwrite it, hold down the Ctrl key as you drag-and-drop. 
 
A Stacked Instrument has two components, the “Main” Instrument channel (1) and the subsequent stack 
“Members” (2)  that appear in “sub-channels” (3) beneath the Main Stacked Instrument MIDI channel. 
 

 

 
 
 

• Changes made to a Main Stacked Instrument’s MIDI Mixer parameters affect all of the sub-channels. 
• Changes made to a sub-channel’s MIDI Mixers parameters affect only that single instrument. 
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Detaching a Sub-Channel Instrument 
To detach one sub-channel instrument while leaving the other ones in place, click on the downward pointing 
arrow toward the right of the sub-channel field, and select ‘Detach instrument’. 
 

 
 
Note: When detaching single sub-channel instruments from a Stacked Instrument that contains a 
Keyswitch, it may be necessary to redefine the Keyswitch within the channel’s Stack Properties (see 
below). 
 

Renaming a Stacked Instrument  
The simplest way to rename a stacked instrument is to click the current stack name within the Main 
channel’s slot field (the field’s background turns yellow, and the name is highlighted with a blue background), 
type in a new name and press ‘Enter’ to confirm. 
 

 
 
You can also rename a stacked instrument using the Stack Properties dialog, as described in the Stack 
Properties section. 
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Show/Hide Sub-Channels 
Because a stacked instrument can contain many sub-channels, it may be useful to collapse a stacked 
instrument so that only the Main Instrument channel is visiblein the MIDI Mixer. The black arrow to the 
left of the Main Instrument channel field toggles between showing or hiding the stack’s sub-channels. 
 
 

 
 

 

Instrument Loading via Drag-and-Drop 
There are several ways to load instruments into the MIDI mixer via drag-and-drop. 
 

• Drag-and-drop a .GIG or .GSI file from the desktop into a MIDI mixer channel. If the channel already 
contains an instrument, the existing file will be detached. To stack files on a MIDI channel, hold down 

the Ctrl key while dragging and dropping. 

• Drag-and-drop a .GIG or .GSI file from the QuickSound Explorer into a MIDI mixer channel. If the 
channel already contains an instrument, the existing file will be detached. To stack files on a MIDI 

channel, hold down the Ctrl key while dragging and dropping from Quicksound. 

• Drag-and-drop a .GIG or .GSI file from the Loaded Instruments pane into a MIDI mixer channel. If the 
channel already contains an instrument, the existing file will be detached. To stack files on a MIDI 

channel, hold down the Ctrl key while dragging and dropping. 
 
Unloading Instruments Using the Loaded Instruments Window 

Once an instrument is loaded into GVI, it remains loaded in memory (RAM) whether it is presently attached 
to a MIDI channel or not. This makes it possible to attach/detach loaded instruments quickly using MIDI 
program changes. 
 
However, if you want to reclaim RAM, you need to unload an instrument, not just detach it. This requires 
using the Loaded Instruments Window, which shows all instruments currently loaded into GigaStudio 
memory. 
 
There are three unload options available by right-clicking on an instrument in the Loaded Instruments 
window. 
 
• Unload selected: Unloads the single selected instrument on which you right-clicked. 
• Unload all: Unloads all loaded instruments displayed in the Loaded Instruments window. 
• Unload unmapped: Unloads all instruments that are not currently attached to a MIDI channel. 
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Stack Properties 
Once multiple instruments have been stacked on a MIDI channel, the Stack Properties menu item becomes 
available in that MIDI channel’s drop-down menu. 
 

 
 
 
The Stack Properties dialog allows several functions: 
 
• Rename stacks (1 - remember to hit ‘Enter’ to confirm rename). 
• Enable and define Key or MIDI Controller-based instrument switching (Keyswitching) among the sub-

channel instruments (2).  
• Limit an instrument’s keyboard range to create splits (3). 
• Load, save, and edit stack templates (4). 
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Adding a Keyswitch to an Instrument Stack  
The default behavior for a Stacked Instrument is for all of the sub-channel instruments to play back when a 
note is triggered, making it easy to create rich, layered instruments. However, you can limit Stacked 
Instrument playback to one sub-channel instrument at a time and control which sub-channel is active using 
either a MIDI Controller or a Keyboard-based Keyswitch. 
 
With a MIDI controller, moving the controller “scrolls” through the sub-channels. Example: Rotating the 
mod wheel fully back might select one sub-channel, rotating it forward might select a different sub-channel, 
and rotating it between these extremes select yet another sub-channel. With a Keyswitch, hitting C might 
choose one sub-channel, C# another, and D a third.  
 
 
Instrument Selector 
To enable MIDI switching for a Stacked Instrument, open the Stack Properties dialog from the Main MIDI 
channel’s drop-down menu. Within the Stack Properties dialog, choose either Keyswitch or MIDI Controller 
from the Instrument Selector drop-down menu. Choosing None (default) causes all stack members to play 
back simultaneously. 
 

 
 
Filter CC messages: 
When Keyswitching is enabled, the ‘Filter CC messages’ option will block incoming MIDI CC messages from 
all inactive sub-channels.  
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Keyswitch: Define the Keyswitch keyboard range by either typing in the boundaries manually or using the 
Learn feature (click on Learn, then play the low boundary note first, then the high boundary note). The 
Keyswitch range should include one note for every instrument on the stack. 
 

 
 
MIDI Controller: Specify a controller using either the Controller drop-down menu or the Learn feature 
(click the Learn button and move the desired controller to make the assignment). 
 

 
 
Use (X) Instruments: Use this drop-down list to specify how many of the stack members are to be included 
in the instrument switching. Unless you are including embedded GigaPulse instruments on your stack that do 
not contain playable playable regions, leave this value set to All. Note: Because GigaPulse FX Modules are to 
be applied to all sub-channels and because they are not sample-based instruments, they do not need to be 
included in a Keyswitch. Therefore, you would exclude GigaPulse FX Modules from a Stacked Instrument 
keyswitch. 
 

 
 
Click “OK” to confirm changes and close the Stack Properties dialog. 
 
Renaming a Stacked Instrument  
With the Stack Properties dialog open, click on the Stack Name field. The background turns yellow, and the 
name acquires a blue background. Type in the new name, then hit the computer keyboard’s Enter key to apply 
your changes. Click “OK” to close the Stack Properties dialog. 
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Playzones Section 
The Virtual Keyboard in the Stack Properties dialog’s Playzones section can trigger notes as well as provide a 
visual reference for the various keyboard ranges of each instrument on the stack. Instruments in the stack are 
listed below the Virtual Keyboard in strips, with small triangular “handles” showing the upper and lower 
keyboard range covered by the instrument. Click in a strip to make that instrument the current instrument. 
 

 
 
The Virtual Keyboard uses color-coding to identify various aspects of the layers. 
 
Yellow: The currently-selected instrument layer. 
Light purple: Other instrument layers. 
Light blue: Stack Keyswitches. 
Diagonal blue stripes: These indicate note regions on the stack that are beyond the range of the currently 
selected instrument layer. 
 
To modify an instrument’s active (playable) keyboard range, use the triangular handles located in the lower 
half of each instrument strip. First select the instrument layer by clicking in the strip, then move the upper and 
lower boundary brackets to the desired range. 
 
Template Toolbar 
Stack Properties templates store and recall all Stack Properties parameters except for the stack name. They can 
be organized in Collections (banks) and contain user-specified comments or descriptions. The following 
options are available. 
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Clear Settings: Resets all Stack Properties parameters to their default settings. 
Load Template: Click to display a drop-down menu from which you can load a previously-saved template. 
Save Template: Click to bring up a dialog that allows specifying the Template and Collection name, as well as 
adding template-specific descriptions. 
Edit Templates: Use this dialog to rename templates, reorganize templates, create new Collections, modify a 
template’s description, delete templates, or view a template’s properties. 
 
Channel Properties Window 
Each MIDI channel has a Channel Properties window that allows remapping incoming MIDI data (Source 
Keys) to alternate outgoing note values (Destination Keys) on a note-by-note basis. To open the Channel 
Properties window, select the Channel Properties menu item from the desired MIDI channel’s drop-down 
menu. 
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Source Keys 
The upper keyboard in the channel properties window represents the channel’s Source Keys. These incoming 
MIDI note values are constant, regardless of its Destination note. Example: When you change the Source Key’s 
Destination note from C2 to C3, an incoming C2 Note-On message will trigger the sample that is mapped to 
C3 on that channel. 
 

 
 
Destination Keys 
The lower keyboard in the channel properties window displays the channel’s Destination Keys, which 
represent the note values that are passed on to the sampler in place of the incoming Source Keys original note 
value. 
 
Channel Properties Tools 
 

 
 
Remap/Play 
The Remap/Play button (default) allows auditioning and remapping samples by dragging them from the 
Source Key window into the Destination Key window. To select multiple Source keys, ctrl-click or shift-click 
them. 
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Revert to Original 
If a Key is highlighted in the Destination Key window, it has been remapped. The highlighted key represents 
the pitch of the Source Key, while the Destination Key pitch is shown as text near the top of the keyboard. 
Example: If the C6 key is highlighted in the Destination Keys keyboard and the text at the top of the key says 
D6, then the C6 Source Key has been remapped to D6.  
 
To clear a remapped key, click on Revert to Original, then click on the remapped Source Key on either 
keyboard. 
 
Map to Silence 
To disable incoming MIDI data on a particular key, click the Map to Silence button and click on the key you 
would like to silence on either the source or destination keyboard. Silenced keys are colored dark gray in the 
Destination Keys keyboard. 
 
Re-Mapping Via Learn Mode 
Instead of using the Channel Properties virtual keyboards, you can select a MIDI controller from the Learn 
Mode drop-down menu that allows you to remap keys by toggling between source and destination input keys. 
Example: If you select Sustain pedal as the controller, you can remap keys by pressing the sustain pedal, 
selecting the Source Key, releasing the pedal, then selecting the Destination Key. 
 

 
 
Display By Option 
Use this menu to choose whether remapped keys in the Destination Keys keyboard have pitches displayed as 
note names (e.g., A#, C, etc.) or MIDI note numbers (e.g., 64, 75, etc.).  
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Set self-mask on all regions  
There is now an option to enable self-masking from the MIDI Mixer channel pulldown 

menus, and also by right-clicking on an instrument in the loaded instruments window. This 

setting gets saved with a performance. Enabling self-masking in this fashion (as opposed to 

using Quickedit or the GigaEditor) will affect all regions within the instrument. Changing 

this setting on an instrument that had some regions set to self mask while some were not will 

force all regions to the new setting. 
 

 
 

Show/Hide Single DSP Channel in MIDI Mixer 
This is a cool new feature that allows users to always have a channel’s DSP controls visible without showing 
the entire DSP Mixer. This feature is enabled by selecting the “Show one DSP Channel in the MIDI Mixer” 
option from within the GigaStudio View Menu. 
 
The active/visible DSP channel corresponds to the currently selected MIDI channel. I.E. If MIDI channel 2 is 
selected (outlined blue) and routed to DSP Channels 7,8, then the visible DSP channel Strip controls will 
correspond directly to DSP Channels 7,8. 
 
You will also notice that small grey arrows appear on the left hand column of the DSP channel strip; these 
correspond to which MIDI channels are routed through the currently active DSP channel. In other words, 
when an arrow is present between the horizontal MIDI strip and the DSP Channel Strip, it means that the 
corresponding MIDI channel is routed thru the visible DSP channel. 
 

 
 
Wide/Narrow view 
Just like in the DSP Mixer, The MIDI Mixer’s optional DSP Channel Strip can be seen in either Wide view or 
Narrow view. You can toggle between the two views by clicking on the small black triangle located in the 
upper right hand corner of the DSP Channel Strip. 
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CHAPTER4: QUICKSOUND EXPLORER 
 

 
As your sample library grows, it becomes essential to find, audition and load sounds rapidly. QuickSound 
Explorer provides an efficient library management system within a single application. 
 
Performing a QuickSound search is simple: 
 

1. Select and highlight the local sampler, a drive, or a folder you want to search. 
2. Type in a search keyword or choose a default file extension from the drop-down list 

of the QuickSound search field. 
 
QuickSound will then look for files that match your search terms. In the following example, QuickSound 
Explorer has returned results for ‘guitar’ sounds. 
 

 
 
Incidentally. the QuickSound function has been completely re-designed for GigaStudio 4. In previous 
versions, the QuickSound search/database/load function was built as an internal view in GigaStudio. It has 
now become a standalone application in order to provide unified QuickSound functionality to both 
GigaStudio and GVI (Giga Virtual Instrument). 
 
QuickSound also includes an easy way to audition selected sounds via the Windows Sound System, so it’s not 
even necessary to have a GSIF-compatible interface connected in order to listen to potential GigaStudio 
sounds. 
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Launching QuickSound 
There are three main ways to launch QuickSound: 
 
• Click on the QS button in the GigaStudio 4 toolbar. 
 

 
 
• Go Start > Programs > TASCAM > QuickSound > QuickSound Explorer. 
 

 
 
 
• If QuickSound Explorer’s file monitoring function is on (as described later), then a QS button will appear 

in the System Tray. Right-click on the button, then select Launch QuickSound Explorer. 
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Editing QuickSound Settings 
When you first launch QuickSound it may be necessary to customize your database by configuring various 
QuickSound settings. To open the QuickSound configuration choose Database > Edit Settings from the main 
menu section, or click on the Configure button (the one with the gear) in the QuickSound toolbar. 
 
 

 
 

Following are the functions you’ll find under each of the three Edit Setting tabs. 
 
 
Search Configuration Tab 
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Search Mode 
Choose Recursive to include all tree-level drives, folders (sub-directories) and file names that are within the 
top branch selected in the QuickSound window.  
 
Choose Local to look in only a specific location, excluding any contained sub-directories. 
 

 
 
Search Properties  
• Auto Complete Existing Criteria. Check this for searches that involve files with names like .gig, *.gig, 

etc. Auto Completion speeds up searches for known file types. 
• Auto Search. When enabled, GigaSampler will start to search for files as soon as you add a character to 

the QuckSound search field. This is normally disabled as the process can be intensive for large databases, 
but for smaller databases, this feature can often save you the trouble of typing in an instrument’s full 
name. 

• Restore to last search on startup. If checked, QuickSound Explorer will automatically default on startup 
to the most recent search in your last QuickSound session. 
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Results Properties 
• Show only instruments that match search.  This option will ONLY show those instruments within a 

file that match a particular search criteria. The recommendation is to uncheck this option if the desired 
results are to see all the instruments of a file. With this option selected, you will not see the '+' icon in 
your results  

• Automatically expand gigs to show instruments. Folders containing GigaStudio instruments that meet 
the search criteria will be expanded automatically to show all instruments within the .gig files. You 
therefore don’t need to expand each view manually. 

• Show keyword hit report. Check this to display the number of keyword results in a search. Example: 
Searching with the keyword “piano” might display “<PIANO> 7 files under selected directory” above the 
search field. 

• Verbose hit reporting. Check this to see detailed information about the list of files that match the 
specified keywords. 

• Clear search favorites list. During the course of doing searches, you will likely develop a list of 
favorites. Click on this to clear the list so you can build a new list of favorites. 
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Results Window’s Reset Configuration 
You can determine which results are shown, and the order in which they’re sorted. Example: If you don’t care 
about an instrument’s size, uncheck “Size Column” and size won’t appear as part of the results report. 
Conversely, if Sample Rate is important, you can check that. Following are descriptions of Properties you can 
decide to show (box checked) or hide (box unchecked). 
 
• Name displays the .gig file name (expandable to show all instruments contained within the .gig file). 
• Folder displays the instrument’s file path and the name of the containing folder. 
• Size displays the instrument file size in kilobytes. 
• Type shows brief details regarding the file type such as “16 bit wave file,” “Gig file 4.0,” and 

“Performance.” 
• Modified displays the date and time the file was last edited or changed. 
• MemFootPrint displays the amount of memory (in kilobytes) needed to load the instrument. 
• Chans is for wave files and displays “stereo” or “mono,” depending on the file type. 
• SampleRate is for wave files (e.g., a sample rate of 44.1kHz). 
• Group Flag displays a defined group for the instrument. 
• Usage displays a percentage, a bar display, and the number of times an instrument, wave file, or 

performance has been loaded. 
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Furthermore, you can change the order in which results are displayed. To do this: 
 
1. Click on a field to highlight it. 
2. Click on the Move Up or Move Down arrows to change the field’s position in the list. 
 

 
 

Watch Folders Configuration Tab 
This tab lets you determine the folder(s) that Quicksound will use to create the QuickSound Database. On this 
tab, you can also choose to enable/disable ‘file monitoring’ functionality, which when enabled will update the 
Quicksound database by automatically logging changes to the specified directories. 
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Available Folders 
This browser lets you search for and select the directories that Quicksound will monitor for additions or 
deletions to the existing database. It is used in conjunction with the Selected folders window. 
 
To add a folder to the database’s “watch list”: 
 
1. Under Available folders, navigate to the desired folder. Ctrl-click to select more than one folder. 
2. Click on the > button that points to the Selected folders pane. 
3. The folders you selected in Step 1 will now show up in the Selected folders window, and will be included 

when the database is rebuilt and optionally monitored for changes. 
 

 
 
To give a folder priority in a search (i.e., determine the order in which folders will be searched): 
 
1. Click on a folder in the Selected Folder window. 
2. Click on the Up Arrow button to the right of the window to move its priority up, or click on the Down 

Arrow button to move its priority down. 
 

 
 



GigaStudio 4 Reference Manual  52 

To remove a folder from the list of selected folders so that it is no longer monitored: 
 
1. Under Selected Folders, click on the folder you want to remove to highlight it. 
2. Click on the < button that points away from the Selected folders pane. 
3. The folder you selected in Step 1 will no longer be monitored after the database is rebuilt. 
 

 
 
File Types. You can choose whether certain file types are ignored or included in a search. Check the box 
corresponding to the file types you want included in a search. Available file types are: 
 
• WAV – Audio files 
• GIG – GigaStudio Content Files 
• GSP – GigaStudio Performances 
• GSI – GigaStudio Performance Instruments 
• PRF – GigaSampler Performance files 
• ART – GigaEditor Articulation files 
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QuickSound File Monitoring 
File monitoring is a background task that allows the QuickSound database to remain current as files are added 
to and removed from the system. Whenever File Monitoring is enabled, the creation, deletion, update, and 
movement of Giga file types is tracked and reported to QuickSound.  QuickSound ensures these file types are 
actually Giga files before processing them.  If a new Giga file type is created or updated on the system, the file 
is parsed for keyword, instrument, and other attributes which are stored in the QuickSound database for user 
queries, faster loading, and missing file resolution. While convenient, this does require some hard disk 
activity and CPU power. QuickSound Explorer allows you to turn this function off if it interferes with 
extremely CPU-intensive tasks. 
 
Many improvements to the QuickSound database engine have been implemented to speed up searches. Also, 
fixes were implemented in GS4 to address apparent system hangs when using search delimiters such as 
“NOT”.  
 
The File Monitoring section shows whether file monitoring is On or Off. If file monitoring is on and you want 
to stop this process, click on Stop File Monitoring. If it is off and you want to start the process, click on Start 
File Monitoring. 
 

 
 
If you want file monitoring to start automatically when Windows starts, check the box that says 
“Automatically start file monitoring when Windows starts.” 
 
When File Monitoring is enabled you will notice a ‘QS’ icon in the the System Tray. 
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Akai Converter 
GigaStudio includes a utility that can convert Akai S1000 and S3000 format samples into a format suitable for 
GigaStudio. There are several customization options for this conversion process. 

 

 
 

 
Conversion Options 
Akai format files are often dual mono. When the Akai Converter converts Akai Programs, it can detect if 
mono samples are intended to be used together as a stereo pair. To create a merged stereo file, select the Merge 
L/R Samples option. 
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To have the Akai Converter attempt to emulate the imported file’s filter settings, check Use Akai Filter Info. 
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Scope of Operation 
Select one option from the list of pre-defined conversion operations. You may set the double-click operations 
mentioned later under “Short Cut Operations” independently for Partitions and Volumes (NonPrograms), 
Programs, and Items in the Batch List. Or, you may set them all to the same operation. Here are the options: 
 
• All converts all non-programs, programs, and batch conversion items in the same operation. 
• Non-programs converts Akai disk partitions or volumes to the .gig format. 
• Programs converts only the Akai file’s program data to the .gig format. 
• Batch items converts only instruments and programs in the batch list. 
 

 
 
Temporary Disk Usage  
When you drag/drop Akai objects to MIDI channels or the Virtual Keyboard, the Akai Converter converts the 
S1000/S3000 CD/Partitions/Volumes/Programs on the fly into .gig or .wav files. These files are considered 
transient and go into a temporary directory. To specify a drive and folder to hold this temporary directory, 
use the “Browse” button to bring up a folder browser dialog where you can specify or change this directory. 
 
Note: Akai Converter will automatically append a ‘Temp’ directory onto the end of the path shown. This 
‘Temp’ directory is subject to deletion. 
 

 
 
As these temporary files accumulate, you may want to delete them to regain hard drive space. There are two 
ways to do this: 
 
• To empty the temp directory automatically after a conversion operation, select the Empty Temp 

Directory When Disk is Ejected or Program Exits option. 
• To retain the contents of the temp directory until you want to delete it, choose the Empty Temp 

Directory Manually (using Akai Converter Context Menu) option. Empty the directory by right-
clicking the converted files and selecting the appropriate context menu option. 
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Note: To prevent specific files in this directory from being removed, right-click on them and set their 
properties to “Read Only.” When you invoke a deletion option, the Read Only files will not be affected. 
 
Short Cut Operations 
You can define the Akai Converter double-click operation to one of a list of pre-defined operations for a 
shortcut. The default setting is for a double-click to act as if you had performed a single click. 
 

 
 
An example of a time-saving shortcut for an operation would be “Combine to Gig > GSEdit.” In this example, 
double-clicking on a multi-selection would combine the selected instruments to a .gig file, then automatically 
open them in the GigaStudio Instrument Editor for further design and custom parameter adjustment. 
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Rebuild the Database 
If File Monitoring is on, then the database is constantly being updated. However, if you prefer to turn off 
automatic monitoring, you can also rebuild the database manually at any time by choosing Database > Rebuild 
from the main Quicksound menu. Note that this may take some time, particularly if you have a lot of files 
spread over many drives. 
 
If you choose to turn off File Monitoring, it is recommended  that you rebuild the database whenever any 
significant changes are made to any of the specified Quicksound Folders. 
 

 
 

 
Check Database Statistics 
Choose Database > View Status to see statistics on the QuickSound database as well as a file count of WAV, 
GIG, GSP, GSI, PRF, and ART files. 
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Check Database Log 
Choose Database > View Log File to see a log of database-related stats—when created, when modified, 
number of files added, file path records, and more… 
 

 
 
Run Diagnostics 
As a troubleshooting option, choose Database > Run Diagnostics. This displays file statistics as the database 
is being built, thus letting you monitor any possible corrupt files that interfere with the database building 
process. 
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QuickSound ToolBar Buttons 
 
Audition Sounds within the QuickSound Application 
Once the QuickSound database has been built, you can listen to the files via QuickSound’s audition button. 
Simple highlight the desired Instrument/Audio file and click the Audition Button in the main Quicksound 
Toolbar (speaker with play button).  
 

 
 
This is separate from GigaStudio and plays back sounds through the Windows sound system. As a result, you 
first need to make sure that Windows is set to play back through your desired monitoring system. 
 
Configuring the Windows XP Sound System 
• Choose Start > Settings > Control Panel, then double-click on Sounds and Audio Devices. 
• Click on the Sounds tab and for Sound Scheme, select No Sounds. This is recommended so that system 

sounds don’t blast your ears while you’re auditioning sounds via QuickSound. 
• Click on the Audio tab and under Sound Playback, Default Device, use the drop-down menu to select the 

desired sound card you want to use for monitoring. You can adjust volume by clicking on the Volume 
button.  

• Click on Apply if it’s not grayed-out, then click on OK. 
 
 
Auditioning Instruments using GigaStudio 
When the Audition Mode button is enabled (highlighted yellow) in the main Quicksound toolbar, double-
clicking on an instrument will default to loading on the same selected GigaStudio channel every time. This 
allows you to rapidly load instrument variations onto a single MIDI channel to audition with your keyboard. 
When the Audition Instruments button is disabled, double-clicking on an instrument will instead load that 
instrument into the next empty MIDI channel in GigaStudio. 
 
Stacking with Stack Mode 
When the Stack Mode Button in the main Quicksound Toolbar is enabled, double clicking on an instrument 
in QuickSound will stack that instrument on the currently selected channel in GigaStudio. 
It is also possible to Stack multiple instruments simultaneously by first selecting multiple instruments, then 
holding the Ctrl key while dragging and dropping them onto the desired MIDI channel in Giga. 
 
Commands to: feature 
With both GigaStudio and GVI installed on your system, it is necessary to specify which application you are 
currently using. This is to make sure that double-clicking on an instrument loads that instrument into the 
desired platform. Use the drop-down menu to choose between compatible installed applications. 
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Convert Instruments to Giga4 
When you right-click on an instrument or database folder in QuickSound you are given the option to convert 
an instrument or group of instruments to the Giga4 format. While this conversion can increase performance 
of older instrument formats when used in GigaStudio4, it is not backwards compatible. So, older instruments 
converted to Giga4 format will no longer playback on older versions of GigaStudio.
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CHAPTER 5: LOADED INSTRUMENTS VIEW 
 

 
When you load an instrument into GigaStudio 4’s MIDI Mixer, a small portion of each sample contained 
in that instrument (less than 1 second of each sample’s attack) is loaded into the computer’s memory (hard 
drive and/or RAM). Detaching an instrument from within the MIDI Mixer removes it from the MIDI 
Mixer, but does not remove (unload) it from memory. This is important if you want to use program change 
commands to change instruments within a channel slot, as the instrument will already be waiting in 
memory and recalled instantly, as opposed to having to loading the instrument from scratch. 
 
To simplify instrument management, GigaStudio 4 includes a Loaded Instruments view that shows all 
instruments currently loaded into memory, whether active or detached. The Loaded Instruments view can 
either dock with the main UI or float. 
 

 
 
 

Showing and Hiding the Loaded Instruments View 
 
The hide/show Loaded Instruments button on the main toolbar toggles between hiding the Loaded Instruments 
view and recalling it to its previous location. Going View > Loaded Instruments, or typing Ctrl-L performs 
the same function. 
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Loaded Instruments View Information 
The Loaded Instruments view arranges information about instruments that are loaded into memory in 
several columns. 
 
FX: Indicates whether GigaPulse Convolution is programmed into the instrument. 
Instrument Name: Shows the identifying name of the instrument. This is the name that shows up in the 
MIDI Mixer slot when an instrument is attached to a MIDI channel. 

Bank #: The first 128 (0-127) banks are reserved for normal non-stacked instrument assignments. An 
instrument’s bank number is determined within the Giga Editor. Stacked instruments can also be managed 
using MIDI bank select. When a stacked instrument is created it defaults to bank 8192. 
Instrument #: This represents the program change number that will call up this instrument. Program 
changes are numbered 0-127.4 
Port X: Channels: There’s a column for each MIDI port that shows the channel(s) over which an instrument 
will receive MIDI data. Example: If an instrument called “Guitar” shows 1 under Port 1: Channels and 3 under 
Port 2: Channels, then sending MIDI data over channel 1 via Port 1, and/or over channel 3 via Port 2, with 
trigger the Guitar instrument. 
 
Loading Instruments into the MIDI Mixer Via Drag-and-Drop 
 
A loaded instrument can also be attached to a MIDI Mixer channel via drag-and-drop. 
 
• Dragging the instrument from the Loaded Instrument view into a MIDI Mixer channel, or sub-channel in 

the case of a Stacked instrument, replaces what was previously loaded on that channel. 
• Ctrl-dragging the instrument into a MIDI Mixer channel that already contains an existing instrument 

stacks the new instrument with the old. 
 

Loaded Instruments View Context Menu 
Right-clicking on an instrument in the Loaded Instrument view brings up a context-sensitive menu with 
several options. 
 

 
 
 
Edit: Loads the selected Instrument into the GigaStudio Instrument Editor. 
QuickEdit: Calls up the QuickEdit view for the selected instrument. 
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Rename: Allows renaming the Instrument. New names show up immediately in the MIDI Mixer window. 
Set Self-Mask on All Regions: With Self Masking enabled, playing louder velocities will shut off any 
sustaining softer velocities of the same note region that are still decaying. Enabling self-masking in this 
fashion (as opposed to using Quickedit or the GigaEditor) will affect ALL regions within the instrument. 
Enabling this setting on an instrument that already had some regions set to self-mask while some were not 
will force all regions to the new setting. 
Help: Brings up help information on the Loaded Instruments view. 
Unload Selected: Unloads the instruments currently highlighted in the Loaded Instruments view. 
Unload All: Unloads all instruments from GigaStudio 4 memory. These unloaded instruments will no 
longer be selectable by program changes. 
Unload Unmapped: Unloads all instruments from memory that are not assigned to a MIDI channel.  
Bank/Patch Manager: Brings up the Band/Patch Manager window, where you can edit bank and 
instrument numbers. See the subsequent section for more information. 
iMIDI Rule Manager: Brings up the iMIDI Rule Manager window which allows the adding, removing 
and editing of iMIDI rules for that particular instrument. See the iMIDI Rule Manager chapter for more 
information on the Intelligent MIDI tools. 
 

Bank/Patch Assignment Window 
 
This window allows changing Bank and Patch (Program Change) assignments for all instruments currently 
loaded into GigaStudio 4. 
 

 
 

Changing Bank and Patch Assignment for a Single Instrument 
1. Click on the Instrument whose Bank and Patch assignment you want to change. 
2. Under Bank/Patch Assignment, choose the new Bank and Patch number by highlighting the existing 
number in the field and typing over it, or using the increment/decrement buttons toward the right. 
3. Click on ‘Apply to Selected Patches’ to make the assignment “stick.” 
 

Changing Bank and Patch Assignments for Multiple Instruments 
1. Ctrl-click on the Instruments whose Bank and Patch assignment you want to change. 
2. Under Bank/Patch Assignment, choose the new Bank and Patch number by highlighting the existing 
number in the field and typing over it, or using the increment/decrement buttons toward the right. 
3. Click on ‘Apply to Selected Patches’ to make the assignment “stick.”  
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Note that all selected patches will have the same Bank number, but for program changes, the patch numbers 
go sequentially from the highest patch in the list to the lowest, up to one below the patch number. 
Example: If there are 10 instruments loaded and you Ctrl-click on the first three and select Patch #34, the 
first three patch numbers will be 31, 32, and 33, going from the highest position on the list to the lowest. 
 

Patch Conflict Rules 
If you create a patch assignment that conflicts with a previous patch assignment, you have two options: 
 
Move old instrument to next available patch, on bank: Enter the new Bank number in the Bank field 
by highlighting the existing number in the field and typing over it, or using the increment/decrement 
buttons toward the right. The old patch with the conflicting assignment will be moved to the new Bank. 
Move new instrument to next available bank/patch: GigaStudio 4 looks for the next unassigned patch 
number (or if all patches in a Bank are assigned, to the next Bank that contains unassigned patches) and 
moves the assignment for the conflicting instrument to the new patch and/or bank. 
 

Export Patches to File 
Click to create a Notepad document, similar to the one shown here, that contains the Bank/Patch 
assignments for all the currently loaded instruments in your performance. 
 

 
 
If you also want this document to include Port and Channel data, check the Port/Channel Detail box. 
 

Commit Changes 
After reviewing the Bank and Patch assignment data, if you are satisfied with the results, click on Commit 
Changes to close the window and proceed. If you do not want to make the changes, click on Cancel. 
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CHAPTER 6: THE VIRTUAL KEYBOARD 
 

 
There are several Virtual Keyboards in GigaSampler 4: including the QuickEdit Keyboard, which is 
optimized for editing instrument parameters within the QuickEdit view, and the Virtual Keyboard view 
(this view either docks or floats within GigaStudio 4), which is optimized for the following functions: 
 

 
 
• Playing the keyboard with a mouse to audition sounds rapidly, allowing you to test and edit sounds 

even if a hardware keyboard isn’t connected. 
• Seeing the playable range of each instrument. 
• Seeing any keyswitched articulations (within Dimensions and/or Stacks) that may be programmed into 

the instrument. 
 

Applying the Virtual Keyboard 
 

• The Virtual Keyboard plays over one MIDI channel. If the selected MIDI port channel instrument is 
linked and/or stacked with other instruments, then those instruments will be triggered as well. 

• The Virtual Keyboard monitors MIDI note on activity on all port channels. 
• You can use the Virtual Keyboard display in conjunction with the QuickEdit Keyboard, as well as the two 

Distributed Wave Keyboards. With multiple instances of QuickEdit and Distributed Wave, it is possible 
to show as many different keyboard displays at one time as you (or your screen space) can handle.  
 

Showing and Hiding the Virtual Keyboard 
 
The hide/show keyboard button on the main tool bar toggles between hiding the Virtual Keyboard view and 
recalling it to its previous location. Going View > Keyboard or typing Ctrl-K performs the same function. 
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Color Coding 
To indicate the function of each active keyboard region, the corresponding keys are color-coded. 
 

 
 

Black/White: Indicate an instrument’s playable range. 
Gray: Shows unused keys. 
Green: Indicates a Dimension keyswitch (a black dot shows the currently active key) 
Blue: Indicates a Stacked Instrument keyswitch (a black dot shows the currently active key) 
 
Virtual Keyboard Range and Size Buttons 
The four buttons toward the left of the Virtual Keyboard control the visible keyboard range and overall 
keyboard size. 
 

 
 
 
(+) : Increases the size of the keys, in eight increments total. Increasing the size of the keys decreases the 
number of keys you can see at one time. 
(-) : Decreases the size of the keys, in eight increments total. Decreasing the size of the keys allows seeing 
more keys at a time. 
(<) : Scrolls the Virtual Keyboard to the left, so that lower notes are visible as opposed to higher notes. 
(>) : Scrolls the Virtual Keyboard to the right, so that higher notes are visible as opposed to lower notes. 
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Resizing the Virtual Keyboard When Floating 
As mentioned previously, you can float the Virtual Keyboard anywhere you want on the screen, such as 
onto a second monitor. The range and size buttons work as described above, but additionally, you can 
resize the keyboard by placing the cursor over any corner/edge of the Virtual Keyboard window, then 
clicking and dragging. 
 

 
 

Velocity Sensitivity Controls 
The Virtual Keyboard is also velocity-sensitive. With Auto option enabled (highlighted green), clicking 
toward the bottom of a key produces a higher velocity while clicking towards the top of a key produces a 
lower velocity. 
 

 
 
With Auto disabled (gray), the slider sets a fixed velocity level, as shown in the field to the slider’s left. 
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Master Tuning Control 
The Master Tuning fader located on the right edge of the Virtual Keyboard view can be used to perform an 
offset tuning for all instruments on all port/channels at the same time. The Master Tuning offset is limited to a 
positive/negative value of 50 cents (one half of one semitone). This feature is new to GS4 and can be useful 
when using Giga to add instrumentation to an already existing project, with it’s own unique tuning reference. 
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CHAPTER 7: QUICKEDIT 
 

 
The QuickEdit interface lets you view, select, and edit various parameters of loaded instruments. Any edits 
made with QuickEdit can be saved at the performance level in either a .GSI or .GSP file; the original .GIG file 
instrument is not changed. There are three ways to save your edits to an instrument: 
 
• The recommended method is to use QuickEdit and save your edits with a custom instrument level 

performance (.GSI). This creates a performance that can be loaded as an instrument to any port/channel 
while retaining the existing session environment. 

 
• Use QuickEdit and save your edits with the session performance (.GSP). This will save the entire 

GigaStudio environment along with the edits you performed to any instrument(s) with QuickEdit. You 
might use this to create a session template. 

 
• Use the GigaStudio Instrument Editor to make permanent edits to an instrument. You can make edits to 

Instruments using the Giga Editor by selecting “Edit” after right-clicking on an Instrument in the Loaded 
Instruments window. Please see the GigaStudio Editor manual for additional details. 

 

Opening QuickEdit 
 
There are two ways to call up QuickEdit. 
 
• Click the green ‘Q’ button on the associated MIDI Mixer channel slot. 
 

 
 
• Right-click on an instrument in the Loaded Instruments list and select QuickEdit. 
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QuickEdit Architecture 
 
QuickEdit groups parameters into multiple function tabs to streamline the editing process. 
 

 
 
 
1. The Waveform display shows the waveform being edited and a timeline of a sample’s duration, but also 
superimposes envelope and LFO characteristics so you can see how they affect the waveform. 
2. The five QuickEdit page selector tabs choose which function to edit. 
3. Each QuickEdit page groups editing controls related to a particular tabbed function (Filter, Loop, etc.). 
4. The Dimension display shows how dimensions are arranged across the keyboard, and allows for a number 
of different dimension editing modes. 
5. As with the MIDI mixer, the virtual keyboard remains onscreen, so you can trigger notes and test your 
edits. 
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Undo and Redo 
The Undo and Redo buttons are essential editing tools.  
 

 
 
Undo returns to the previous edit. Redo restores an edit. Note: GigaStudio 4 has multiple levels of undo, so 
you can trace your way back through multiple edits.  
 
Compare function: Use Undo/Redo to compare a particular edit by going back and forth between Undo and 
Redo. 
 
The Keyboard Section 
The keyboard at the bottom of the QuickEdit window allows you to pick particular regions, notes, splits, etc. 
for editing. If you can’t see the keyboard, click on the small arrow to the left of the Keyboard label. 
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Edit Modes and Selections 
The are several dimension select options you can choose from when editing an Instrument, as selected in the 
fields just above the virtual keyboard. These are generally intended to specify which portions of the 
instrument you want to edit—the entire instrument, just some regions, just some dimensions, etc. 
   

 
 
MIDI Select 
Enable MIDI Select (the button turns green) to use MIDI note messages (from the virtual keyboard, an external 
keyboard, or sequencer track) to select a region(s) or split(s) for editing. 
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Keyboard Select Drop-Down Menu 
Before performing edits, you should specify whether they will affect All Regions of an Instrument (i.e., all 
notes over the full range of the instrument) or Individual Regions (i.e., notes that cover a particular range of 
the Instrument). If you select Individual Regions you will then need to choose the regions to be edited. For 
example, you might want to reduce the high frequency response for the entire Instrument, or only for an 
individual region that seems excessively bright. 
 

 
 
All Regions: Edits all regions within an Instrument’s complete note range. 
Individual Regions: Edits selected regions. 
 
With Individual Regions selected, a graphic appears above the keyboard that shows each region as a white 
“box” directly above the keys making up the region. Remember that an alternative to selection by clicking (as 
mentioned below) is to enable MIDI Select and send MIDI note messages to GigaStudio 4. 
 

 
 
Click on region: Selects region. The selected region “box” turns from white to yellow. 
Click on region and Shift-click on another region: Selects all regions in between the clicked regions. 
Ctrl-click on region: Adds a region to the regions to be edited. This region need not be contiguous with other 
regions. 
 
You can also combine Shift-click and Ctrl-click operations to select a range of regions along with individual, 
non-contiguous regions. 
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Keyboard Color-Coding 
• (A) Bright yellow keys indicate the region with the focus, i.e., the region whose parameters are being 

displayed in the articulation section above the keyboard. 
• (B) Dim yellow keys indicate selected regions other than the focus to which edits nonetheless will be 

applied. 
• (C)White keys are active parts of an instrument’s range, but not part of a selection. 
• (D) Gray keys are unassigned. 
 

 
 
Dimension Select Drop-Down Menu 
Each note region of an instruments is divided into a number of dimension splits, such as L/R for stereo files, 
multiple velocities, Round Robin, etc. Edits applied to an instrument’s dimension splits can either apply to all 
region splits simultaneously or on an individual, split-by-split basis. To make a choice, click the Dimension 
select option and choose among All splits, Stereo pairs, or Individual splits.  
 

 
 
 
All splits: Selects all dimension splits associated with specified regions 
Stereo pairs: Groups L/R stereo dimension splits while allowing other individual dimension selections 
Individual splits: Allows for individual selection of all dimensions, including L/R stereo dimensions 
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Edit Mode Drop-Down Menu 
These options determine how turning a knob affects the parameter being edited. 
 
Absolute: In absolute mode, the parameter is set to exactly the value you specify, in both the focus region and 
in any other selected regions. 
 
Relative: In relative mode, the parameter is increased or decreased by the same amount in all selected regions.  
For instance, if you change the focus region from 3 to 5, you may be changing other selected regions from 6 to 
8, or from 9 to 11.  
 
Proportional: In proportional mode, the parameter is increased or decreased by the same ratio in all selected 
regions.  For instance, if you change the focus region from 3 to 5, you may be changing other selected regions 
from 6 to 10 or from 9 to 15, in a multiplicative manner. 
 

 
 
 
 

Dimensions Overview 
Between the Articulation section and the Keyboard section is the Dimensions View section. If it is not visible, 
click on the arrow to the left of the Dimensions label. 
 

 
 
This displays all the available pre-programmed Dimension controllers contained in the loaded instrument, 
and lets you correlate keyboard notes to particular Dimensions.  It is important to understand the dimension 
architecture of an Instrument when performing QuickEdits. 
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About Dimensions 
Dimensions are one of the most important concepts in GigaStudio 4, as they allow real-time MIDI control 
over which samples are triggered.  Dimensions are basically control sources such as MIDI controllers, 
velocity splits, release triggers, layers, Smart MIDI dimensions, and stereo splits. 
 
The number of available splits depends on the instrument’s complexity. An instrument can have a maximum 
of 256 dimension splits per region (128 for stereo samples). Stereo is considered a dimension. 
 
It’s up to the instrument designer to decide how to allocate these resources. This can be done on a note-by-note 
basis, or a global dimension can affect the instrument’s entire range and depth. Example: Some note regions 
may be mono with 32 velocities, while others are stereo with two velocity splits and mod wheel on four splits 
with eight keyswitched dimensions. Furthermore, regions can simply be mono or stereo, with no other 
dimensions applied.  
 
Seeing Which Dimensions Affect Which Notes 
With most dimensions, a small line with a number appears over a yellow dimension strip. This number 
represents a MIDI keyboard note number. As you drag it left and right, when the note reaches a different split, 
the Articulation section changes to show the articulation parameter values for that particular split. 
 
There are also two numeric fields to the right of each dimension strip. The first digit of the left field shows the 
Dimension on which the key number indicator sits, and the digit to the right, the total number of splits in the 
Dimension. The right-most field shows the same number as the note number indicator. Example: If the second 
split out of five (going from left to right) ranges from note 30 to note 60, and the key number indicator is on 
note 42, then the two fields will show 2/5 and 42. 
 

 
 
 
Dimension Types 
Dimension types are shown in the gray strips toward the left of the Dimensions section. 
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Stereo Split 
This is the first and most basic Dimension. There is no MIDI control of this dimension; it’s either mono or 
stereo. 
 
Velocity Splits 
With a velocity split, the dynamics with which you hit the keyboard determines which sample is triggered. 
This is most often used for samples of instruments with dynamics that vary from soft to loud. Acoustic 
instruments tend to get brighter and more “aggressive” as they get louder, so recording samples that range 
from loud to soft, and triggering them based on velocity, makes for a much more convincing instrument 
emulation. 
 
Sustain Pedal 
The MIDI Sustain Pedal switches back and forth between samples. This is commonly used for piano libraries 
that have separate pedal up and down samples, or drum libraries with open and closed hi-hats. 
 
MIDI Controllers 
This allows a continuous controller (such as Mod Wheel) to switch between various samples. A good example 
would be using the Mod Wheel to switch from a guitar string sound to a guitar harmonic. 
 
Layers 
You can have several samples layered on top of each other, playing together at once. You can even have 
individual MIDI control of each layer’s volume, or have a MIDI controller sweep between the layers (crossfade 
layering). 
 
Key-Switch 
This original Giga invention lets you use MIDI keyboard notes to switch instantly between various samples. 
This is often used for orchestral instruments that have several articulations. You can instantly switch from 
Long Sustain to Staccato to Legato to Trills to Tremolo, and so on, all on one MIDI channel.  
 
“Round Robin” and Random 
These dimensions switch the samples automatically each time you play a note. Round Robin plays a pre-
determined sample order while Random triggers the samples randomly. This is useful when hitting a note 
repeatedly, such as a snare drum, and you want each note to be slightly different. 
 
Smart MIDI 
This Dimension is used for MIDI tools such as the Pattern Alternator, the Repetition Tool, and the Legato 
Mode Tool. For more information, see the section on Smart MIDI tools. 
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Wave Display 
The Wave display at the top of the QuickEdit window allows for drag-and-drop editing of envelope, filter, and 
LFO parameters. Click on a parameter control knob, or anywhere within one of the control sections (e.g., 
Amplitude LFO), and the Wave view will show its displayed nodes and graphic envelope. You can also click on 
one of the labels toward the right of the Wave (A-ENV, F-ENV, etc.) to show and edit the corresponding 
envelope. 
 

 
 
Each control type has a corresponding color and line style for editing purposes. These lines exist on top of the 
wave view, with node points for dragging to adjust their values. The color and style for the different control 
types are: 
 
Amplitude Envelope (A-ENV): Yellow lines connect the envelope nodes. 
Filter Envelope (F-ENV): Purple lines connect the envelope nodes. 
Pitch Envelope (P-ENV): Blue lines connect the envelope nodes. 
Amplitude LFO  (A-LFO): Yellow sine wave with a single adjustment node. 
Filter LFO (F-LFO): Purple sine wave with a single adjustment node. 
Pitch LFO (P-LFO): Blue sine wave with a single adjustment node. 
 

 
 
To adjust the envelopes and LFOs, select a control type and drag the node(s) in the wave view to adjust 
individual parameters. The edits are immediate, and saved with the performance. These are non-destructive 
edits (i.e., the original .GIG instrument is not affected by the QuickEdit functions). To make a permanent edit 
to a .GIG instrument, load it into the GigaStudio 4 Instrument Editor. 
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You can zoom in and out on the waveform (from seeing a single sample to seeing the entire waveform), as well 
as scroll forward and backward through it. This is essential on the Loop Page, but is also very useful for fine-
tuning envelope parameter settings. There are two ways to navigate; the first method uses the navigation 
buttons. 
 
<  Scrolls toward the beginning of the waveform 
+  Zooms in on the waveform (greater magnification) 
-   Zooms out on the waveform (less magnification) 
>  Scrolls toward the end of the waveform 
 

 
 
The second method is to use the “elastic overview” strip located to the left of the navigation buttons. The strip 
represents the length of the sample. The section shown in the waveform display is represented by a purple 
block. When you move your cursor over this block, the cursor turns into a double-ended arrow. You can now 
navigate in three ways. 
 

 
 
• Click in the block and drag left or right to see a different part of the waveform. 
• Click on the block’s left edge. Dragging right zooms in, with the right side of the block (and therefore the 

right side of the waveform) remaining stationary. Dragging left zooms out, all the way to the beginning if 
desired. 

• Click on the block’s right edge. Dragging left zooms in, with the left side of the block (and therefore the 
left side of the waveform) remaining stationary. Dragging right zooms out, all the way to the end if 
desired. 

• Double click on the purple portion of the “elastic overview” strip to zoom out to the full waveform. 
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Articulation Section: General Tab 
 

 
 
Volume (0 to -Infinity dB) 
This sets the entire Instrument’s output level by using attenuation, measured in dB. A value of 0 provides no 
attenuation. The more negative the number (turn the control counter-clockwise), the greater the degree of 
attenuation. -Inf, the maximum amount of attenuation, equals no output signal. 
 
Pan (-64 to 63) 
Adjusts the Instrument’s location in the stereo field. -64 is full left, 0 is center, and 63 is full right.  
 

Global Tune (-49 to 50 cents) 
Set the overall fine pitch adjustment in cents. 100 cents equals one semi-tone (a single half-step), so the fine 
tuning range can be set anywhere from a quarter-tone flat to a quarter-tone sharp. Tip: If one note in a region is 
slightly out of tune, select only that region and adjust its tuning. 
 

Self-Mask (on/off) 
With Self Masking enabled, playing louder velocities will shut off any sustaining softer  
velocities of the same note region that are still decaying. This is highly effective in reducing Giga’s voice 
count, especially for sustaining instruments like ride cymbals that are triggered repeatedly. 
 

Sustain Defeat (on/off) 
Defeats whatever effect is caused by pressing the sustain pedal for the selected regions. 
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Volume Modulation Section 
Being able to modulate volume creates more realistic dynamics. 
 

 
 

Controller Drop-Down Menu 

 

 
 

Choose a MIDI controller, channel aftertouch, or velocity to modulate volume (or choose none if no controller 
is desired). 
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Invert Switch (on/off) 
This inverts the action of the selected controller. Example: When inverted, higher velocity values lower the 
volume rather than raise it.  
 

Threshold (0 to 127) 
Sets a level below which the controller has no effect, e.g., a minimum volume level. 
 
Velocity Response Section 
 

 
 

This determines how the controller selected under Volume Modulation affects the output level. For example, 
you can adjust velocity response to match your playing style (soft, heavy, whatever) and keyboard controller 
response. If your controller already has a custom response, you can set GigaStudio 4 to add no response 
changes of its own. 
 
Velocity Curve Drop-Down Menu 
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Choose one of three velocity curves from this drop-down menu. 
 

 

 
0 - Nonlinear: Velocity is weighted so that medium to high input velocities cover most of the output velocity 
range. The five curves show the five options offered by the Velocity Range slider (described in the next 
section). 

 

 
1 - Linear: The velocity corresponds directly to your playing; a linear increase in how hard you play leads to a 
linear output velocity increase. Choose this if your controller has a custom response you already like. The five 
lines show the five options offered by the Velocity Range slider (described in the next section). The top line is 
the Low curve, where all input velocities are converted to a constant velocity value of 127. The lowest line is 
for the High curve, where the output velocity equals the input velocity. The other options offset velocity to 
various extents. Use the curve that provides the best “feel” for your keyboard and playing style. 
 

 

 
2 - Special: This as a more exaggerated version of the nonlinear response. Moderate playing produces mostly 
low velocities, then velocity output increases rapidly as you play harder. The five lines show the five options 
offered by the Velocity Range slider (described in the next section). 
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Velocity Range 
This is somewhat like a “compressor” for dynamic range. Just as audio compression appears to bring up low-
level audio, at the low Velocity Range setting, low incoming velocity values are boosted somewhat. This boost 
becomes progressively less at higher settings. At the High setting, the dynamic range follows the full range of 
your keyboard’s dynamics. 
 
Scale 
This value is used to scale the currently selected velocity curve in order to further customize the filter’s 
response to incoming velocity.  The filter response can be scaled to open more quickly by entering values 
higher than 20; this results in higher filter cutoff frequencies at lower velocities and yields on overall brighter 
response. Values lower than 20 will cause the filter to open more slowly over the velocity range, yielding an 
overall darker filter response. The scaling range is 0-127 with a default value of 20. This parameter is only 
available when the Cutoff Controller is set to “None”.  
 
Release Curve Drop-Down Menu 
GigaStudio 4 can respond to release velocity MIDI messages, which are transmitted when you release a key or 
keys. 
 

 
 
0 - Nonlinear: Velocity is weighted so that medium to high input release velocities cover most of the output 
release velocity range. You need to have progressively faster release times to reach higher velocities.  
 

 
 
1 - Linear: The velocity corresponds directly to your playing; a linear increase in release time results in a 
linear increase in release velocity. Choose this if your controller has a custom response you already like. 
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2 - Special: This is a more exaggerated version of the nonlinear response. Moderate release times produce 
mostly low release velocities, then the release velocity output increases rapidly with faster release times. 
 
Choose the one that feels the most natural to your playing style. 
 

Release Range 
As with Velocity Range, this is somewhat like a “compressor” for release velocity. At the low Velocity Range 
setting, the effect of low release velocity values are boosted somewhat. This boost becomes progressively less 
at higher settings. At the High setting, the release velocity value follows the full range of your keyboard’s 
dynamics. 
 

Release Trigger Decay 
When release time is tied to the envelope release time, Trigger Decay influences the speed of the release time, 
from 0 (fastest) to 8 (slowest). 
 
 
Instrument Global Section 

 

 
 

Pitch Bend Range (0 to 12 Semitones) 
This sets the how much pitch will be bent when the pitch bend wheel is set to either extreme of its rotation. 
Example: With 2, the maximum pitch bend range is 2 semitones. With 12, the maximum pitch bend range is 
12 semitones (one octave). 
 
This control affects all regions. You cannot have separate bend ranges for individual regions. 
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Piano Release Mode 
This option is intended for Piano samples. On a real piano, you can step on the sustain pedal very quickly after 
releasing the notes and you will still get some strings resonance.  This checkbox allows GigaStudio to emulate 
that when used in conjunction with pedal down samples.   
 
(Note that this mode is for use only with piano libraries that use actual pedal down samples.  It’s not needed 
when the ambience is supplied by GigaPulse.) 
 
 
Articulation Section: Amplitude/Pitch Tab 

 

 
 

Amplitude Envelope Parameters 
An envelope represents how a sound’s dynamic properties change over time: How the sound begins, what 
occurs during the sustain characteristics, and how it returns to silence. All acoustic sounds have associated 
envelopes. The three primary aspects of any given sound affected by envelopes are amplitude (volume), 
frequency (pitch), and harmonic content (timbre or filter). In QuickEdit, these are controlled by the Amplitude 
Envelope, Pitch Envelope, and Filter Envelope respectively. 

 

 



GigaStudio 4 Reference Manual  88 

General Envelope Information 
The Envelope and LFO shapes are superimposed over the waveform graphic. You choose what to display with 
the Envelope/LFO selection buttons to the right of the waveform. 
 
There are two ways to alter the envelope shape: 
 
• Rotate the envelope control knobs 
• Click on and drag nodes (the large dots) on the envelope graphic. 
 

 
 

Note that you can display any envelope in any tabbed view. Example: While on the Amplitude/Pitch page, you 
can display the Filter envelope. This is helpful as sometimes you want to adjust one envelope while seeing 
another envelope’s shape. 
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Amplitude Envelope Section 

 
The following graphic indicates the portions of an envelope that relate to the following parameters. 

 

 
 

Pre-Attack (0 to 100%)  
(A) The sets the level from which the attack time begins, thus allowing the sound to start at any level from 
silent to full volume. The value expresses a percentage of the maximum level. Example: 50.00 sets the 
beginning of the attack envelope to half of the sample level. 
 
Attack (0 to 10 seconds)  
(B) This parameter sets the duration for the envelope to go from the Pre-Attack level to the maximum 
possible level. Longer attacks are characteristic of wind instruments; plucked instruments have virtually no 
attack. 
 
Decay 1 (0 to 60 seconds)  
(C) Decay is the amount of time it takes for the envelope to fall from the maximum level to the level set by the 
Sustain parameter (described next). 
 
Sustain (0 to 100%)  
(D) Sets the level the envelope attains after the decay phase is complete. 
 
Hold (on/off) 
(E) If a sample has a loop point, the Hold function will prevent the first decay (Decay 1) from happening until 
the sample has played through its entire loop one time. 
 
This is handy for natural decaying instruments like Piano or Guitar that have small looped samples. When 
Hold is set to “Yes” the sample will hold its volume until it plays through the loop. Once it has played through 
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the loop, it will then start the first decay down to the sustain level. This can make for a more realistic envelope 
for short looped samples. It gives them a little more of a natural personality despite the artificial looping. 
 
Note: Hold is available on the Amplitude Envelope but not the Filter Envelope. 
 
Decay 2 (0 to 60 seconds, or infinite) 
(F) This determines how long the envelope remains at the sustain level. If set to Infinite, the sustain phase will 
last as long as the associated key is held down. Note that once the Decay 2 time has elapsed, the Release phase 
(described next) will begin, regardless of whether you’re holding down the associated key or not. 
 
Release (0 to 60 seconds)  
(G) Release specifies how long it will take for the envelope to fall back to 0 from the current sustain level. 
 
• If Decay 2 is set to “Infinite,” the release phase will begin when the note is released. 
• If Decay 2 is set between 0 and 60 seconds, then the release phase will start after that amount of time has 

elapsed. 
• If you release the note before the Decay time has elapsed, then the release will begin upon releasing the 

key. 
 

Pitch Envelope Section 
 

 
 

The Pitch envelope has only two parameters. 
Attack (0 to 60 seconds) 
This parameter sets the time for the pitch envelope to attack up to the original pitch or decay down to it, with 
the amount of pitch change set by the Depth control. 
 
Depth (-1200 to 1200 cents) 
When centered, the Pitch Envelope has no effect. Turning further counter-clockwise (negative values) sets a 
lower initial pitch, which glides up to standard pitch for the duration of the Attack time. Turning further 
clockwise (positive values) sets a higher initial pitch, which glides down to standard pitch over the duration 
set by the Attack time. The maximum amount of initial pitch deviation is 1200 cents (one octave). 
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Amp Envelope Modulation Section 
The Modulation controls allow real-time MIDI control of the Attack, Decay and Release of the Amplitude 
envelope.  

 
 

Controller 
Choose a MIDI controller, channel aftertouch, or velocity to provide a modulation source for the Amp 
Envelope parameters. There are 25 possibilities, including none. 
 
Invert 
This inverts the action of the selected controller. Example: Normally, higher velocity values lengthen the 
Decay time. When inverted, higher velocity values shorten the Decay time. 
 
Attack, Decay, Release 
The Attack, Decay, and Release parameters have four different modulation levels. Each parameter is 
independent of the others. 
 
Off : The parameter ignores the MIDI Controller. 
Low: Very light response to the MIDI Controller. Example: With Invert off and Attack being modulated, high 
velocity notes will extend the attack time a little bit.  
Med: Moderate response to the MIDI Controller. In the example above, high velocity notes will extend the 
attack time by considerably more.  
High: Provides the maximum parameter variation based on the MIDI Controller value. Example: With Invert 
off and Release being modulated, higher velocities will give much longer release times. With Invert on, higher 
velocities will give much shorter release times. 
 
Note that the effect of modulation depends on the envelope settings. Example: If the envelope Attack time is 
zero, the Mod controller won’t affect it, as you can’t make zero longer or shorter. Once you enter a parameter 
higher than zero, this controller will then have an effect. Shorter Attack times result in very light changes with 
the Mod controller, while longer times result in more drastic changes with the Mod controller.  The Decay 
and Release settings work similarly.  
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Amplitude LFO (Low Frequency Oscillator) Section 
LFOs control various parameters cyclically, thus automating continuously repeating changes over time. The 
Amplitude LFO provides tremolo effects (periodic variations in level). 

 

 
 
Frequency (0.1 To 10Hz) 
This sets the LFO frequency. The amplitude LFO frequency is superimposed on the waveform when A-LFO is 
selected with the Envelope/LFO buttons toward the right of the waveform display. Also note that a node is 
located toward the left side of the waveform. You can adjust frequency by dragging this node. 
 

 
 
Control Source 

 
 

This allows controlling the LFO depth from several possible sources, as selected from a drop-down menu. 



GigaStudio 4 Reference Manual  93 

0 – Internal: The LFO depth is controlled solely by the Internal Depth control. 
1 – Mod Wheel: An external mod wheel controller determines the LFO depth, with its maximum limit set by 
the External Depth control. 
2 – Breath Control: An external breath controller determines the LFO depth, with its maximum limit set by 
the External Depth control. 
3 – Int+Mod Wheel: This allows for a constant amount of LFO depth supplied by the Internal LFO function, 
with additional modulation provided by an external mod wheel. These work as described above under 0 - 
Internal and 1 - Mod Wheel. 
4 – Int+Breath Ctrl: This allows for a constant amount of LFO depth supplied by the Internal LFO function, 
with additional modulation provided by an external breath controller. These work as described above under 0 
- Internal and 2 – Breath Control. 
 
Internal Depth (-4800 to 4800) 
This determines the amount of LFO modulation when Internal is the control source (described above). 
Negative values and positive values give the same audible effect, but with multiple layers or instruments, you 
might want to have one sound increasing in level while another sound decreases in level, in a complementary 
way. 
 
External Depth (-4800 to 4800) 
This determines the amount of LFO modulation when Mod Wheel or Breath Control is selected as a control 
source, as described previously. Negative values and positive values work as described for Internal Depth. 
 
Invert (on/off) 
Turning this on is the equivalent to changing the Depth parameters from a positive value to the equivalent 
negative value, or vice-versa. 
 
Synch (on/off) 
When on, all LFOs start from the same starting point. When off, all LFOs are free-running. 
 

Pitch LFO Section 

 
The Pitch LFO provides vibrato effects (periodic variations in pitch). 
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Frequency (0.1 to 10Hz) 
This sets the LFO frequency. The Pitch LFO frequency is superimposed on the waveform when P-LFO is 
selected with the Envelope/LFO buttons toward the right of the waveform display. Also note that a node is 
located toward the left side of the waveform. You can adjust frequency by dragging this node. 
 

 
 
Control Source 
This allows controlling the LFO depth from several possible sources, as selected from a drop-down menu. 
 

 
 
0 – Internal: The LFO depth is controlled solely by the Internal Depth control. 
1 – Mod Wheel: An external mod wheel controller determines the LFO depth, with its maximum limit set by 
the External Depth control. 
2 – Breath Control: An external breath controller determines the LFO depth, with its maximum limit set by 
the External Depth control. 
3 – Int+Mod Wheel: This allows for a constant amount of LFO depth supplied by the Internal LFO function, 
with additional modulation provided by an external mod wheel. These work as described above under 0 - 
Internal and 1 - Mod Wheel. 
4 – Int+Breath Ctrl: This allows for a constant amount of LFO depth supplied by the Internal LFO function, 
with additional modulation provided by an external breath controller. These work as described above under 0 
- Internal and 2 – Breath Control. 
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Internal Depth (-1200 to 1200) 
This determines the amount of LFO modulation when Internal is selected as a control source. The maximum 
amount of pitch change is plus and minus 1200 cents, or one octave above and below the initial pitch. Negative 
values and positive values give the same audible effect, but with multiple layers or instruments, you might 
want to have one sound increasing in pitch while another sound decreases in pitch, in a complementary way. 
 

External Depth (-1200 to 1200) 
This determines the amount of LFO modulation that’s applied when Mod Wheel or Breath Control is selected 
as a control source. Negative values and positive values work as described previously. 
 

Invert (on/off) 
Turning this on is the equivalent to changing the Depth parameters from a positive value to the equivalent 
negative value, or vice-versa. 
 

Synch (on/off) 
When on, all LFOs start from the same starting point. When off, all LFOs are free-running. 
 

 

Articulation Section: Filter Tab 
 

 
 
Filters shape a sound’s timbre by reducing and/or boosting the amplitude of specific frequency ranges. An 
instrument can sound duller, brighter, thinner, fatter, etc. through the use of filtering. 
 
For sound design and creative effects, filter parameters can be modulated by various control sources such as 
velocity, aftertouch, continuous controllers, envelopes, and more. 
 

Filter Section 
This section determines the static filter characteristics to which modulation can be added. 
 
Type 
GigaStudio 4 offers four filter types. The graph toward the right provides a graphic representation of the filter 
frequency response. 
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0 – None: The filter is bypassed and has no effect on the sound. 
1 – Lowpass: The response attenuates high frequencies above a user-settable cutoff frequency, but lets low 
frequencies pass through. 
2 – Highpass: The response attenuates low frequencies below a user-settable cutoff frequency, but lets high 
frequencies pass through. 
3 – Bandpass: The response peaks at the cutoff frequency; frequencies above and below that frequency are 
attenuated. 
4 – Bandreject: The response is reduced at the cutoff frequency; frequencies above and below that frequency 
are not affected. 
 

Cutoff (0 to 127) 
This sets the initial filter cutoff frequency to which modulation can be applied. 0 is the minimum possible 
frequency, 127 the maximum.  
 

Min Cutoff (0 to 127) 
Minimum cutoff sets a lower frequency limit. Example: With a lowpass filter response, bringing the filter 
cutoff down below the signal’s lowest frequency will mute the sound. Setting a minimum cutoff frequency can 
prevent this from happening. 
 

Res (0 to 127)  
Resonance creates an amplitude peak at the cutoff frequency (except in Bandreject mode), where it creates an 
amplitude dip). The maximum resonance is set close to the point of self-oscillation, and will resonate 
according to the frequency content of the waveform that is being filtered. 
 

Dyn (on or off) 
Enabling the ‘Dyn’amic option increases the overall resonance by dynamically scaling the Q (in addition to the 
cutoff frequency of the filter) in accordance with changes of envelope and/or external control. 
 

MIDI Control Section 
 

Cutoff Controller 
This parameter assigns a MIDI controller to provide real-time continuous control over the filter cutoff 
frequency. 
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There are 10 modulation options. Assigning a MIDI controller overrides the Cutoff setting in the Filter 
section. 
 
Invert 
This inverts the action of the selected controller. Example: When inverted, raising the controller value will 
lower the filter cutoff rather than raise it. 
 
Resonance Controller 
This parameter assigns a MIDI controller to provide real-time continuous control over the filter resonance. 
 

 
 
There are four modulation options. Assigning a MIDI controller overrides the Resonance setting in the Filter 
section. 
 
Key Response Section 
This is where you can tie the filter cutoff to velocity and pitch.  

 

 
Vel Curve 
This works in conjunction with the Velocity Dynamic Range (described next). Three different velocity curves 
are available. 
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0 – Nonlinear: Velocity is weighted so that medium to high input velocities cover most of the output velocity 
range. 
 

 
 
1 – Linear: The output velocity is directly proportional to the input velocity. 
 

 
 
2 – Special: This exaggerates the nonlinear response even further. Moderate playing  produces mostly low 
velocities, then the velocity output increases rapidly as you play harder. 
 
Choose the response that works best with your playing. Players with a light touch will probably choose the 
linear response, while players with a heavy touch will likely prefer the nonlinear or special response. 
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Vel Dyn Range 
This alters the velocity curve’s dynamic range. There are five response options. 
 

 
 

 1 – High  
 2 – Medium high  
 3 – Medium  
 4 – Medium low  
 5 – Low  
 
The High setting has no effect on the velocity curve, and attains the widest dynamic range. As the dynamic 
range gets lower, the velocity curve is “compressed” so that lower input velocities produce higher output 
velocities. In practical terms, this means lower dynamic ranges are more sensitive to lower input velocities. 
For example, with the Linear curve selected in conjunction with the lowest velocity dynamic range, any input 
velocity produces an output velocity value of 127. 
 
Key Tracking (on/off) 
When enabled, the filter cutoff frequency tracks note pitch. Therefore, every note will have similar-sounding 
timbres. When disabled, the cutoff frequency remains constant, regardless of pitch. 
 
Break Pt (0 to 127) 
Break point sets the MIDI note value at which filter keyboard tracking begins (the default is 60, or middle C). 
Example: The filter cutoff could be constant below a certain note, then track keyboard pitch above that note. 
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Filter Envelope Section 
 
The following graphic indicates the portions of an envelope that relate to the following parameters. 
 

 
 

Pre-Attack (0 to 100%)  
(A) This sets the cutoff frequency at which the attack time begins, thus allowing the cutoff to start at any 
frequency, from minimum to maximum. The value expresses a percentage of the available cutoff frequency 
range. 
 

Attack (0 to 10 seconds)  
(B) This parameter sets the duration for the envelope to go from the Pre-Attack cutoff frequency to the 
maximum possible cutoff frequency. 
 

Decay 1 (0 to 60 seconds)  
(C) Decay is the amount of time it takes for the envelope to fall from the maximum cutoff frequency to the 
cutoff frequency set by the Sustain parameter (described next). 
 

Sustain (0 to 100%)  
(D) Sets the cutoff frequency the envelope attains after the decay phase is complete. 
 

Decay 2 (0 to 60 seconds, or infinite) 
(E) This determines how long the envelope remains at the sustain level. If set to Infinite, the sustain phase will 
last as long as the associated key is held down. Note that once the Decay 2 time has elapsed, the Release phase 
(described next) will begin, regardless of whether you’re holding down the associated key or not. 
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Release (0 to 60 seconds)  
(F) Release specifies how long it will take for the envelope to fall back to the minimum filter cutoff frequency 
from the current sustain level. 
 
• If Decay 2 is set to “Infinite,” the release phase will begin when the note is released. 
• If Decay 2 is set between 0 and 60 seconds, then the release phase will start after that amount of time has 

elapsed. 
• If you release the note before the Decay time has elapsed, then the release will begin upon releasing the 

key. 
 

 

Filter Envelope Modulation 
The Filter Envelope Modulation controls allow real-time MIDI control over the Filter Envelope Attack, 
Decay and Release parameters. 
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Controller Drop-Down Menu 
 

 
 

Choose a MIDI controller, channel aftertouch, or velocity to provide a modulation source for the Amp 
Envelope parameters. 
 

Invert Switch (on/off) 
This inverts the action of the selected controller. Example: Normally, higher velocity values lengthen the 
Attack time. When inverted, higher velocity values shorten the Attack time.  
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Filter Attack, Decay, and Release Modulation Amounts 
The Attack, Decay, and Release parameters have four different modulation levels. Each parameter is 
independent of the others. 
 
Off : The parameter ignores the MIDI Controller. 
Low: Very light response to the MIDI Controller. Example: With Invert off and Attack being modulated, high 
velocity notes will extend the attack time a little bit.  
Med: Moderate response to the MIDI Controller. In the example above, high velocity notes will extend the 
attack time by considerably more.  
High: Provides the maximum parameter variation based on the MIDI Controller value. Example: With Invert 
off and Release being modulated, higher velocities will give much longer release times. With Invert on, higher 
velocities will give much shorter release times. 
 
Note that the effect of modulation depends on the envelope settings. Example: If the envelope Attack time is 
zero, the Mod controller won’t affect it, as you can’t make zero longer or shorter. Once you enter a parameter 
higher than zero, this controller will then have an effect. Shorter Attack time settings result in very light 
changes with the Mod controller, while longer settings result in more drastic changes with the Mod 
controller.  The Decay and Release settings work similarly.  
 

Filter LFO Section 

 
The Filter LFO provides periodic variations in the filter cutoff frequency. 
 

 
 

Frequency (0.1 to 10Hz) 
This sets the LFO frequency. The Filter LFO frequency is superimposed on the waveform when F-LFO is 
selected with the Envelope/LFO buttons toward the right of the waveform display. Also note that a node is 
located toward the left side of the waveform. You can adjust frequency by dragging this node. 
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Control Source 
This allows controlling the LFO depth from several possible sources, as selected from a drop-down menu. 
 

 
 
0 – Internal: The LFO depth is controlled solely by the Internal Depth control. 
1 – Mod Wheel: An external mod wheel controller determines the LFO depth, with its maximum limit set by 
the External Depth control. 
2 – Foot Control: An external foot pedal controller determines the LFO depth, with its maximum limit set by 
the External Depth control. 
3 – Int+Mod Wheel: This allows for a constant amount of LFO depth supplied by the Internal LFO function, 
with additional modulation provided by an external mod wheel. These work as described above under 0 - 
Internal and 1 - Mod Wheel. 
4 – Int+Foot Ctrl: This allows for a constant amount of LFO depth supplied by the Internal LFO function, 
with additional modulation provided by an external foot pedal controller. These work as described above 
under 0 - Internal and 2 – Breath Control. 
 

Internal Depth (-4800 to 4800) 
This determines the amount of LFO modulation when Internal is selected as a control source (described later). 
Negative values and positive values give the same audible effect, but with multiple layers or instruments, you 
might want to use a positive LFO on one instrument and a negative LFO on the other so that their cutoffs vary 
in a complementary way. 
 

External Depth (-4800 to 4800) 
This determines the amount of LFO modulation when Mod Wheel or Breath Control is selected as a control 
source. Negative values and positive values work as described above. 
 

Invert (on/off) 
Turning this on is the equivalent to changing the Depth parameters from a positive value to the equivalent 
negative value, or vice-versa. 
 

Synch (on/off) 
When on, all LFOs start from the same starting point. When off, all LFOs are free-running. 
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Articulation Section: Dyn Expression Tab 
 

 
 

The Dynamic Expression Filter (DEF) provides a phase corrected, 7th order, morphing filter for adding 
expressiveness before and after sustaining note-on events. This filter can accurately and continuously morph 
frequency responses of velocity dynamics even after note-on events have occurred. In other words, the DEF 
can make a sample sound as if it were played at different intensities, allowing for real-time crescendos and 
diminuendos of a sustaining note. Note: The DEF function works only with 24-bit samples. 
 
The filter’s response curve can be unique for each of an instrument’s regions and sub-regions, making it 
possible to create extremely detailed filter profiles. DEF gives users the ability to create a more lyrical and 
“live” sounding instruments with expanded depth of control over musical phrasing and dynamic range. 
 
Instrument Global Settings 
 

 
 
Enable DEF Filter 
Click on this to enable the DEF filter. 
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Modulator 
 

 
 
The filter is driven by either a standard MIDI continuous controller, velocity, a filter envelope, or a 
combination of all three. This parameter lets you choose among Continuous Controller only, Velocity only, 
and Velocity + Continuous Controller. By enabling both velocity and CC modulation control, the velocity 
response can be biased (e.g., brighter or darker) by the specified continuous controller. With velocity in play 
(“Spectral Interpolate Velocity” mode), the DEF filter’s curve is controlled by note-on velocity, creating a 
continuously variable velocity response. This mode can increase the dynamic range of a sample set or 
instrument dramatically, greatly improving, and in some cases eliminating, the typical “stair-step” sound of 
multi-sampled instruments. 
 
Modulator CC 
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If you’ve selected MIDI CC as a modulator, this parameter allows choosing a particular MIDI continuous 
controller from a drop-down menu. 
 
Aftertouch Offset 
 

 
 
With Aftertouch chosen as the DEF Modulator source, it is possible to offset the filter curve by a value 
between 0 and 64. With the minimum Aftertouch Offset value of 0, the incoming aftertouch values utilize the 
full dynamic range of the DEF filter curves. With the maximum Aftertouch Offset value of 64, the incoming 
aftertouch values are scaled to morph between only the moderate (mf) and loud (ff) filter curves. 
 
Also Track Filter Envelope 
 

 
 
When enabled, modulation will also track the existing filter envelope (specified under the Filter tab). Filter 
envelope values below 50% are subtracted from the running CC value, and envelope values above 50% are 
added to the running CC value. The result of adding the envelope and CC values is subject to saturation, so the 
effective value always stays within the standard range of the Continuous Controller. Example: If the filter 
envelope is at its peak (100%) value, there is no upward CC modulation possible; if the CC value is increased 
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it will not do anything under this “saturated” situation. However, decreasing the CC Value in this situation 
will bring the saturated value back down. 
 
Note: The normal multimode filters (Lowpass, Highpass, Bandpass, Bandreject) do not have to be running for 
the filter envelope to modulate DEF. 
 
Import From File 
 

 
 
This option allows importing a preset DEF configuration from a file. Several factory preset profiles are 
installed with GS4 and can be found in the following directory: 
 

C:\Program Files\Common Files\TASCAM\Giga\profiles\Dynamic Expression 
 
Coefficients Section 
  

 
 
The DEF filters were designed to address and emulate the characteristics of samples whose pitch and dynamics 
have been transposed. For this reason, this musically adapted filter does not behave like a traditional EQ; the 
settings of one parameter affect the next. Experimentation is encouraged. It might also be helpful to use a 
Frequency Analysis Plug-in at first to get a feel for each filter parameter. 
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Giga’s morphing filters are composed of four independent parameters that affect the overall shape and volume 
of the filter: cutoff frequency, Q, Q0H, and V0. Each parameter has a range of 0 to 127. The first three 
parameters affect the timbre of the filter (frequency and Q) while the fourth parameter (V0) provides volume 
compensation. These parameters are available for three different dynamics settings: 
 
PP Coeffs: Affect quiet or pianissimo dynamics (minimum filter setting) 
MF Coeffs: Affects moderate or mezzo forte dynamics (median filter setting) 
FF Coeffs: Affects loud or forte dynamics (maximum filter setting) 
 
When the filter modulator is at zero, the PP parameters are used. The MF and FF parameters are used when the 
modulator is at its midpoint (64) and maximum (127) respectively. For all other positions of the modulation 
source, the parameter values are continuously interpolated or “morphed” between. By morphing between 
filter coefficients, the DEF filter creates phase accurate real-time crescendos and decrescendos using a single 
sustaining note, effectively replacing the need for layered crossfade instruments that increase polyphony and 
introduce phase problems. 
 
Following are the parameters for each of the Coefficients. 
 
Cutoff : Determines the initial center frequency for the Q0 Quality factor.  
Q: Simultaneously determines gain, Quality (filter width), and a center frequency offset relative to the initial 
Fc setting. 
Q0H: This high frequency quality factor has a fixed center frequency near 7.5kHz and is especially helpful in 
de-emphasizing the harsh overtones of upwardly transposed samples.  
V0: While designed to compensate for any gain attenuation imposed by the filter, you can also use V0 to 
increase the dynamic range of an instrument, achieving softer pianissimos and bolder fortes. 
 
 
Articulation Section: Loop Tab 

 

 
 
Looping is the process of defining a section of the sample to repeat over and over, thus providing a sustained 
sound. A loop start and loop end define this section. Being able to zoom in and out on the waveform, and 
navigate through it, is crucial to the process of looping. 
 
Note: Enabling and disabling loop points can be done only using the GS4 Editor application.  
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Sample Start Section 
 

 
Offset (0 to 2000) 
Offset, calibrated in samples, allows starting sample playback at a point later than the beginning (up to 2000 
samples into the file). This is especially useful for eliminating “air” or silence at the beginning of a file, but can 
also add effects (e.g., soften a sound’s attack by cutting off its attack transient). 
 
Also note that when zoomed out sufficiently on the waveform to see the beginning, a small rightward-
pointing blue arrow indicates the sample start time. You can drag this as an alternate way to set the sample 
start time. 
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Loop Section 
The Loop section has controls for loop start and loop end. 
 

 
 
As with sample start, there are also small arrow markers superimposed on the waveform that show loop 
points. The loop start marker is a green arrow that points to the right, while the loop end marker is a red 
arrow that points to the left. You can drag these markers to set loop start and end points. 
 
Note: Enabling and disabling of loop points can only be done using the GS4 Editor application.  
 

 
 

Loop Start (0 to end of file, in samples) 
This sets the loop start point. However, note the following fine points: 
• Remember that holding down the Shift key while varying this knob allows fine-tuning. 
• When using the loop start control to set the loop start, it will “jump” to an appropriate place that will 

increase the odds of creating a seamless loop. If you need finer control, drag the marker. 
• If a loop is established with a start and end point, moving the Loop Start control will cause the Loop End 

control to move in tandem so that the loop length is always preserved. Moving the Loop Start marker will 
not cause the Loop End marker to move. 
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Loop End (1 to end of file, in samples) 
This sets the loop end point. The above comments about Loop Start also pertain to Loop End, with one 
exception: If a loop is established with a start and end point, moving the Loop End control will not cause the 
Loop Start to change. If you want to preserve a loop’s duration but move it, you must do this with the Loop 
Start control. 
 
Comments on Looping 
Looping is both an art and a science. The loop start and end should be at the same level, otherwise you’ll hear a 
“pop” as the signal transitions abruptly from one level to another. For this reason, GigaStudio 4 will select 
waveform “zero crossings.” These are places in the waveform where the signal has no amplitude. Although 
setting loop start and end on zero crossings doesn’t guarantee a clean loop, it helps. 
 
After establishing what seems like a decent loop, vary the Loop Start control and experiment whether moving 
the loop elsewhere in the file improves the loop quality. Remember, you can always click on Undo if the 
original loop position was better. 
 
Prepare to be frustrated at first, but the more you loop, the better you’ll get at the process. 
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CHAPTER 8: DSP STATION 
 

 
Once the MIDI Mixer contains instruments, the DSP Station comes into play. The DSP Station serves the same 
function in GigaStudio 4 that a mixer does in a traditional studio or DAW: Route, process, mix, and group 
audio. Furthermore, a GSIF 2 compatible audio interface allows routing external audio into the sound card 
inputs and from there, into GigaStudio 4's DSP Station. In fact, with this type of setup, the DSP Station can 
serve as a stand-alone digital mixer. 
 

 
 

DSP Station Tabs 
The DSP Station has four main signal routing sections: Inputs, Groups, Aux Returns, and Output Masters. 
Select these views via the tabs at the bottom of the DSP Station window. 
 

 
 
Input Tab 
The DSP Station can have from 2-128 inputs (which you can also consider as 1-64 stereo inputs). You can also 
add or remove DSP inputs by selecting Configuration > Mixer or by opening the Giga Configuration 
Manager from the Start menu. The default is 32 DSP inputs (16 stereo). 
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Each DSP Station channel strip has an assigned number pair at the top that identifies the channel strip’s input. 
Each DSP channel represents a stereo pair of inputs However, DSP channels can be "unlinked" for independent 
mixing control over the left and right signals. The DSP channel numerical labels are fixed, and cannot be 
changed. 
 

 
 
Inputs 
By default, the 16 MIDI Mixer channels of each port patch to the first 32 DSP Station inputs. The right-most 
side of each MIDI Mixer channel strip shows the DSP Station channel strip to which it is assigned. 
 

 
 
Example: A MIDI Mixer instrument output that says MX 1:2 means it’s a stereo signal and goes to the DSP 
Station channels labeled '1,2.' MX 13:14 would also indicate a stereo signal, and this would go to the DSP 
Station channels labeled '13,14.' The assignments for the MIDI Mixer channel outputs are not fixed, and can be 
changed to feed any DSP Station input. In fact, more than one MIDI Mixer channel can feed the same DSP 
Station input. 
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The field directly under the DSP Station channel number defaults to read “Giga,” which is an abbreviation for 
“GigaStudio Sampler” and indicates that that particular DSP channel is being fed by one or more MIDI Mixer 
channels. 
 

 
 
If you have a GSIF 2 compatible audio interface with one or more inputs enabled in the Giga Configuration 
Manager, then this field lets you select an audio interface input as the signal input to the DSP channel. This 
feature allows you to use the DSP Station as a stand-alone digital mixer, applying EQ, Dynamics, VST Effects 
or the rich room models of GigaPulse to any live input!  
 
Outputs 
The bottom of each DSP Station channel strip has a field for assigning that channel’s output. The options are 
either the Output Master channels that connect directly to your hardware outputs, or the inputs to Group 
channels (described later). These assignments can be changed at any time. For example, if a channel output 
assignment says H1:2, then it’s routed to the first available channel pair of your audio interface; if a channel 
output assignment says H3:4, then it’s routed to the second available channel pair of your audio interface. The 
maximum number of hardware outputs available in the DSP Station is limited by the number of physical 
outputs your hardware has. However, you can change the number of available hardware outputs in the 
‘Hardware’ tab of the Configuration Manager or by selecting Configuration > Hardware from within 
GigaStudio (the number of output channels in the Hardware Adapter section). 
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Note: In ReWire mode, the outputs go to either ReWire or Group inputs rather than hardware outputs. See the 
ReWire chapter for more details. 
 
Naming a Channel Strip 
Click on the field directly above the output field. The background turns yellow, and the name acquires a blue 
highlight. Type in a name, and hit your keyboard’s Enter or Return key. The input channel name will be saved 
with the performance (.GSP) environment. 
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Wide and Narrow Views 
Each DSP Station mixer input channel strip can toggle between a maximized (wide) or minimized (narrow) 
view by clicking on the arrow to the right of the channel strip number. The wide view provides easy access to 
all the mixing features contained within each channel strip including effect inserts and sends, dynamic 
processing and EQ. The narrow view takes up much less space, but still allows accessing several important 
channel strip functions like routing, panning and volume. 
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Fader 
The fader controls the channel strip’s audio level. It is visible in both wide and narrow mode. To “fine-tune” 
the level you can hold down the shift key while moving the fader. 
 
• The meter (A) to the right of the fader indicates signal level. If the top red clip indicators light, reduce the 

fader level. 
• The numeric fields directly below the fader and above the Link/Unlink buttons (B) show the amount of 

fader attenuation. 
• The fader can control the left and right channel levels simultaneously (link mode), or control the left and 

right channel levels independently (unlink mode). Select the mode using the Link/Unlink button toward 
the bottom of the fader. Note that you cannot Unlink, set a level offset, then Re-link and retain the level 
offset. If there is an offset, upon Re-linking the fader will jump to the higher of the two channel values.  

 
 

 
 
 

Position/Pan Controls 
GigaStudio 4 offers more flexible panning options than most mixers—hardware or software. These are set by 
the two knobs located above the channel strip fader, visible in both wide and narrow mode. The numeric field 
below each control indicates the direction of the panning (R = right, L = left) and the amount of panning (from 
L100 to R100, C if centered). 
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Fader Unlinked 
If the main level fader is unlinked, the upper knob pans the left channel anywhere in the stereo field from L100 
to R100, while the lower knob pans the right channel. 
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Fader Linked 
When a channel fader is linked, the following three options appear in a menu just above the fader: 
 

 
 

 
Mono: The upper knob pans the left channel anywhere in the stereo field, while the lower knob pans the right 
channel anywhere in the stereo field. 
 
Reverse: The two controls work oppositely. Example: As you turn the upper control clockwise (panning 
toward the right), the lower control automatically moves counter-clockwise until it produces an equal and 
opposite value. Example: If the upper control says R44, in reverse mode the lower control will show L44. 
 
Position/Width: The upper control sets the position of the signal in the stereo field, while the lower control 
sets the width. Positive width values “open up” the signal as the width goes from 0 to 100%. Negative values 
provide the same function, but with the channels reversed. As an example of how you might use this, suppose 
there is a guitar and piano playing rhythm parts on separate stereo channels. You could use the Position 
control to place the guitar at L50, and the piano at R50. They are now opposite each other in the stereo field. 
Use the Width control so that the guitar covers from the center to full left, and the piano covers from center to 
full right. 
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Mute and Solo Switches 
The Mute and Solo buttons are located directly above the top panning-related control. They are visible in both 
wide and narrow mode. Click on M for mute and S for solo. Ctrl-click to enable multiple Mute or Solo 
buttons. 
 

 
 
Selecting Solo on a channel automatically enables Mute on all other channels (unless you ctrl-click on one or 
more to Solo them as well). If a Mute button is bright yellow, that channel will be muted regardless of the 
status of other channel Solo buttons. A dark yellow Mute button indicates the channel is muted only because 
another channel is currently Soloed.   
 
 
Effect Inserts 
Each DSP Station channel can have up to four insert effects for processing the signal going through the 
channel. 
 
Insert an effect: Click on an insert field and choose NFX (Native GigaStudio 4 effects) or VST effects, then 
choose the desired effect from either sub-menu. Upon inserting the effect, the plug-in name appears in the 
Insert effect field, and its GUI appears. Note: Effects must be inserted sequentially, from the top field to the 
bottom field. 
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Remove an effect: Click in the field with the name of the effect you want to remove, and select Remove. 
 

 
 

Bypass an effect: Click on the BYP button below the effect name field. When bypassed, the button turns from 
gray to bright green. Note that this setting can be overridden by the channel bypass button described later. 
Also note that in some cases you can use the effect’s native bypass button as well.  
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Edit an effect: Click on the EDIT button below the effect name field. The effect’s GUI will appear. Note: The 
EDIT button is not a toggle. To close the GUI, you must click on the GUI’s close button. 
 

 
 
Bypass all channel insert effects: Click on the channel bypass button (INS) toward the upper left. This button 
is visible in both wide and narrow views. It toggles between bright green (effects loaded and active) to a dim 
green (effects loaded but inactive). If this button is gray, it means no effects are inserted in the channel. Note: 
The channel INS button overrides the state of individual effects. If the loaded effects are not bypassed, but the 
INS button indicates that all effects are bypassed (dim green), then the inserted effects will not affect the signal 
going through the channel. 
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Insert effects counter: The readout below the channel bypass button shows how many effects are inserted. 
Example: L2 R2 indicates that two stereo effects are inserted. 
 

 
 
 

Aux Send Controls 
 
Using Aux Sends 
The Aux Send controls work in conjunction with Aux Return channels. The basic routing is as follows: you 
insert an effect or multiple effects in an Aux Return channel insert, which is routed to a hardware output. The 
Aux Send knobs are then usd to feed signal from the various DSP Station input channels to the Aux Returns. 
These signals are processed by the effects in the Aux Return channel inserts and then appear on the assigned 
hardware output. There’s more information on routing in the Aux Returns tab section. 
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Note: A channel must be in wide view mode to assign its Aux Sends. There are eight available aux send 
controls that send signals to the eight available Aux Return channels. Each Aux Send control section has the 
following controls and parameters. 
 

 
 
Aux Send knob: This varies the amount of signal sent from the DSP Station channel to the equivalent Aux 
Return channel (i.e., Aux Send knob 1 sends signal to Aux Return channel 1). 
 
Pre button: When enabled (bright green), the Aux Send level is unaffected by the channel fader. Thus, the 
amount of signal going to the aux bus doesn’t change based on the channel fader level. When disabled (gray), 
the amount of signal going to the aux bus increases and decreases based on the channel fader setting. 
 
On: When enabled (bright green), the Aux Send is routed to the Aux Return bus. When disabled (gray), no 
signal goes to the Aux Return bus, regardless of the Aux Send knob level. Turn off sends that aren’t in use to 
save CPU power. 
 
Attenuation numeric readout: The numeric field below the Aux Send knob shows the amount of attenuation 
the control provides, from –inf to 0. 
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Linking and Unlinking 
GigaStudio 4’s send controls are unusually flexible. Normally, each Aux Send sets the level for a signal going 
to both channels of a stereo pair simultaneously. However, in Giga it is possible to adjust send levels for each 
channel of a stereo pair separately. This can be particularly useful with dual mono plug-ins (i.e., there are 
different mono effects for each channel of a stereo pair) or when positioning an instrument within a stereo 
reverb. 
 

 
 
Link: When enabled (bright green), each Aux Send knob sets the send level for both channels of a stereo pair 
simultaneously. When disabled (gray), levels for the left and right channels are set individually, based on 
whether the Left or Right button is enabled. 
 
Left: When enabled (bright green, available only when Link is disabled), the Aux Send knob sets the send level 
for the left channel of a stereo pair discretely. When Left is disabled (gray), the Aux Send knob either affects 
both channels of the stereo pair simultaneously or only the level going to the Right channel, depending on 
whether the Link or Right buttons are active respectively.  
 
Right: When enabled (bright green, available only when Link is disabled), the Aux send knob sets the send 
level for the right channel of a stereo discretely. When disabled (gray), the Aux Send knob either affects both 
channels of the stereo pair simultaneously or only the level going to the Left channel, depending on whether 
the Link or Left buttons are active respectively. 
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Dynamics Processor 
Each DSP Station channel has a high-quality, built-in dynamics processor that can provide compression and 
limiting, thus restricting the dynamic range of any signal going through the channel 
 
Preset Management 
The drop-down menu to the upper right of the Dynamics section’s graph provides preset management 
functions. 
 

 
 
Rename preset: Choose Rename Preset from the drop-down menu. A dialog box appears where you can type 
in a new name. After doing so, click on OK. 
 
Load preset: Choose Load Preset from the drop-down menu. A box appears where you can navigate to where 
the dynamics presets are stored. Navigate to a preset (.fxp suffix), click on it, then click on Open. The preset 
will be loaded into the Dynamics processor. 
 
Save preset: Choose Save Preset from the drop-down menu. A box appears where you can navigate to where 
the dynamics presets are stored. Type in a name, then click on Save. The preset will be saved in the location 
you selected. 
 
Load bank: Choose Load Bank (a collection of 10 presets) from the drop-down menu. A box appears where 
you can navigate to where the dynamics preset banks are stored. Navigate to a bank (.fxb suffix), click on it, 
then click on Open. The bank will be loaded into the Dynamics processor. 
 
Save bank: Choose Save Bank from the drop-down menu. A box appears where you can navigate to where the 
dynamics preset banks are stored. Type in a name, then click on Save. The current bank of 10 presets will be 
saved in the location you selected. 
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Bypass (DYN button)  
Click the DYN button to enable or bypass Dynamics for the current channel. This button is duplicated when 
the channel is in narrow view, and can be used to enable or bypass the Dynamics processor. Note: When 
bypassed, the graphic display will dim as well. 
 

 
 
Gain dB Slider 
Compression inherently reduces a signal’s level, which requires adding gain to make up the difference (this is 
often called “makeup gain”). Use the Gain slider to adjust levels so that the peak output level is roughly the 
same regardless of whether Dynamics is active or bypassed. 
 

 
 
A numeric display below the slider indicates the gain level setting (in deciBels) within a range of -20dB to 
+20dB, in 1dB steps. This is generally set to equal the amount of gain reduction shown in the vertical meter to 
the right of the Graphic Display (described later). 
 
 



GigaStudio 4 Reference Manual  129 

Auto Button 
Click on the Auto button (it turns bright green when enabled), and the Dynamics processor calculates the 
make-up gain required so that the output is roughly the same volume as the input, whether dynamics is active 
or bypassed. You can still use the output Gain dB control to further fine-tune the output level. 
 

 
 
Dynamics Controls 

 

 
 
Threshold: This sets the level above which compression starts to take effect. Lower settings create more 
compression. A numeric display below the slider indicates the threshold setting (in deciBels) within a range of 
-60dB to 0dB, in 1dB steps. 
 
Ratio: Determines the ratio of the change in output signal versus a change in input signal. Example: With a 
ratio of 2:1, and assuming the input signal is about the threshold, a 2dB increase at the input is compressed to a 
1dB increase at the output. A numeric display below the slider indicates the ratio, from 1:1 (no compression) 
to INF:1 (limiter). 
 
Attack: Use this to set an amount of time the signal remains uncompressed before compression kicks in. A 
numeric display below the slider indicates the attack time (in milliseconds) within a range of 0 to 100mS, in 
1mS steps. Example: Set an attack time of 10ms with a drum sound to let through the first 10 milliseconds of 
the drum’s attack, thus maintaining some degree of  “punch” before the compression takes effect. 
 
Release: This sets how long it takes for compression to stop affecting the signal after it falls below the 
threshold. A numeric display below the slider indicates the release time (in milliseconds) within a range of 5 
to 5000mS (or 5 seconds), in 1mS steps. 
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Graphic Display 
 

 
 
This shows the relationship between the level of the input (horizontal axis) and output (vertical axis) that 
results from changes in the Threshold, Ratio, and Gain sliders. Example: With the ratio at maximum, you can 
see that the output does not vary once the input reaches a certain point. The level at which this occurs depends 
on the Threshold setting. You can use the Gain control to bring up the overall level.  
 
Gain Reduction Meter 
As mentioned earlier, compression inherently lowers a signal’s level because it lowers the level of amplitude 
peaks. This meter shows the amount of gain reduction (from 0 to -18dB. linearly from top to bottom) being 
applied at any given moment, and helps in adjusting the Gain control. Example: If the meter shows a 
maximum amount of –3dB of gain reduction, then turning the gain up by +3dB will compensate for this level 
drop. 
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Equalizer 
An equalizer changes the tonal quality of a signal. The one included with GigaStudio 4 is very comprehensive, 
and offers four tone-shaping stages. 
 
Graphic Display 
The display shows a graphic representation of the frequency response that results from manipulating the 
various stages of equalization. The vertical axis represents boost and cut (up to 15dB). The horizontal axis 
shows the frequency range from 16Hz to 21kHz. 
 

 
 
EQ Controls 
Each stage of EQ has identical controls. 
 
Gain: This boosts or cuts the signal level at a particular frequency, or over a particular frequency range, 
depending on the type of EQ response selected (described later). 
 
Freq: Determines the (center) frequency or frequency range.  
 
Q: Sets the range of frequencies around the frequency selected with the frequency control. Lower settings 
boost a narrow range of frequencies. Higher settings boost a wider range. 
 
EQ Type: Click in the field just above the On button for each EQ band; a drop-down menu appears with six 
EQ types. 
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• Parametric (PA) boosts response around a particular frequency. The Gain, Frequency, and Q controls are 

active. 
 

 
 
• Notch (NO) cuts response around a particular frequency. The depth of this notch is fixed; Frequency and 

Q are active, but Gain is not. 
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• Low Pass (LP) progressively reduces response above a particular frequency. Only the Frequency control 
is functional. 

 

 
 
• High Pass (HP) progressively reduces response below a particular frequency. Only the Frequency 

control is functional. 
 

 
 
• Low Shelf (LS) reduces or boosts response below a particular frequency, with the response eventually 

flattening out. Only the Gain and Frequency controls are functional. 
 

 



GigaStudio 4 Reference Manual  134 

• High Shelf (HS) reduces or boosts response above a particular frequency, with the response eventually 
flattening out. Only the Gain and Frequency controls are functional. 

 

 
 
EQ Enable/Disable 
There is a separate On button for each of the four bands of EQ; these work in conjunction with the channel 
master EQ enable button  (below the master DYN button) as follows. 
 
• Master EQ button enabled, individual EQ stage button(s) enabled: Associated buttons are lit bright 

green. 
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• Individual EQ stage button(s) enabled, master EQ button bypassed: All associated buttons are dark 
green. The Graphic Display dims as well. 

 

 
 
• All individual EQ stage buttons bypassed: All EQ stage buttons and the Master EQ button are gray. The 

Graphic Display shows nothing. 
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Therefore, in narrow view, you can tell the EQ status at a glance. 
 
• Master EQ button gray: no stages are enabled. 
• Master EQ button bright green: at least one stage is enabled. 
• Master EQ button dark green: at least one stage is enabled but the master EQ switch is bypassed.  
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Summary of Narrow View Controls 
Although you’ll want to use the wide view for detailed editing, note that narrow view still provides a lot of 
functionality. You can: 
 
 
  

 

(A)  Select the channel input source from a 
loaded instrument in the sampler or an 
allocated GSIF 2 audio hardware input 

(B) Toggle the audio signal of all Insert 
assignments routed to a group’s output 
masters. Off is muted, on is active 

(C )  See how many effects are inserted in the 
channel strip 

(D)  Bypass or enable the channel’s Dynamics 
effect 

(E)  Bypass or enable all applied bands of EQ 
for the channel 

(F)  Mute and un-mute an individual channel. 
(G)  Toggle a channel strip’s solo mode 
(H)  Adjust panning controls 
(I)  Select panning mode 
(J)  Adjust channel level 
(K)  See level as numeric readout 
(L)  Check signal levels with the meters 
(M)  Link or unlink fader 
(N)  Name channel 
(O)  Choose output 
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Aux Returns Tab 
In addition to insert effects, GigaStudio 4 offers aux (send) effects. Each time you insert an effect, it requires a 
certain amount of CPU power. Aux effects allow inserting a single effect to process signals from multiple 
channels simultaneously, thus conserving CPU power. Example: Suppose you want to apply a reverb effect to 
three DSP Station channels. Although you could use a reverb as an insert effect in all three channels, a more 
efficient option is to insert the reverb in an Aux bus, then send some signal from each DSP Station channel to 
this bus. The reverb would process this mix of signals, then return it to the DSP station via an Aux Return 
channel. 
 
We’ve already covered how to send signals to Aux Effects in the section Aux Send Controls. Now we’ll 
describe what to do with those signals.  
 
Clicking on the Aux Returns tab shows the eight Aux Bus channel strip pairs. 
 

 
 
These are similar to, but simpler than, the main DSP Station channels. The narrow/wide view, fader, output, 
INS button, insert effects counter, and insert functions work similarly to those in the main DSP Station 
channels. 
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You insert up to four Aux effects into the effect insert slots of an Aux Return, select the output where you want 
to send the processed signal using the Aux Return’s Output field drop-down menu, then regulate the level 
going to the output with the Aux Return fader. The output is typically the same output being fed by various 
channel outputs (i.e., the Output Master channels, which connect to your audio interface).  
 
Note: In ReWire mode, the outputs go to ReWire inputs rather than hardware outputs. See the ReWire chapter 
for more details. 
 
Gain-Staging with Aux Sends and Returns 
Note that there are two places to adjust levels. Turning up an Aux Send control sends more signal to the Aux 
Return effect(s), and the Aux Return fader sets the level coming out of the effect(s). As an example of how these 
work together, consider a situation where you want lots of reverb on a percussion part, but little on a piano 
part. You would turn up the percussion channel’s Aux Send control a fair amount, and the piano channel’s Aux 
Send a lesser amount. Once you have the ideal balance, you can then use the Aux Returns level control as a 
“master” reverb level, where you can add more or less reverb without upsetting the balance set by the Aux 
Send controls. 
 
Also, use the Aux Send controls to avoid overloading effect inputs. You can always add more level in the Aux 
Return section. 
 
Groups Tab 
Group channels are almost identical to Input channels, except that multiple channel pair outputs from Input 
channels can feed the same Group channel pair. 
 

 
 
Groups provide a “master”-like function. Here’s a typical example of how to use Grouping. 
 
You’ve loaded four instruments (trumpet, two saxes, and trombone) to create a brass section. You have a 
perfect balance of the four instruments, but now you want to increase or decrease the level of the entire section. 
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Rather than tinker with the balance you worked so hard to achieve, you can send these four channels to a Group 
channel, and use the Group channel’s level control as a master volume control. 
 
The same concept would apply to a drum set where individual drums are on different channels, or backup 
vocals are being mixed together. 
 
Differences Between Input and Group Channels 
Input and Group channel types are the same in all respects—insert effects, aux sends, Dynamics and EQ 
processor, etc.—except for the following two differences: 
 
• The output of an Input channel can go to an Output Master channel, or a Group channel. A Group channel 

output can go only to an Output Master channel, which connects to your hardware interface; a Group 
channel cannot go to another Group channel. 

• With a  GSIF 2 audio interface, an Input channel can accept one of its inputs. A Group channel can only 
accept the output from one or more Input channels. 

 
Note: In ReWire mode, the outputs go to Rewire inputs rather than hardware outputs. See the ReWire chapter 
for more details. 
 
Output Masters Tab 
The Output Master channels are the simplest of all channels; they are the channels that tie directly into the 
audio interface outputs. There will be as many Output Master channels as there are hardware interface outputs 
activated under Configuration > Hardware (Output Channels). 
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Note: In ReWire mode, the outputs go to ReWire inputs rather than hardware outputs. See the ReWire chapter 
for more details. 
 
Narrow and Wide View 
Although the Output Master channels offer narrow and wide views, the only reason to choose wide is to 
expand the channel label at the top to see the full name of the hardware interface channel instead of, for 
example, H 1:2.  
 
Fader 
The fader controls the Output Master strip’s level. It is visible in wide or narrow mode. To “fine-tune” the 
level, hold down the shift key while moving the fader. 
 
• The meter (A) to the right of the fader (B) indicates signal level. If the top red clip indicators light, reduce 

the fader level. 
• The numeric fields (C) directly below the fader and above the Link/Unlink button show the amount of 

fader attenuation. 
• The fader can control the left and right channels of the Output Master strip simultaneously (link mode), 

or control the left and right channel levels independently (unlink mode). Select the mode by the 
Link/Unlink button (D) toward the bottom of the channel. Note that you cannot Unlink, set a level offset, 
then Link and retain the offset. If there is an offset, upon linking the fader will jump to the higher of the 
two channel values.  
 

Rec Button 
This enables a track for recording using the Capture function. The Rec button has three possible states. 
 
• A gray button (default state) indicates the current Output Master channel is not armed for recording. 
• A dim red button indicates that the respective Output Master channel is armed and ready to record to 

disk.  
• A bright red button indicates that the respective Output Master channel is actively recording. 
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CHAPTER 9: NFX PLUG-INS 
 

 
The NFX series of plug-ins were designed specifically for GigaStudio. The roster includes the NFX-1 Reverb, 
NFX-2 Chorus, NFX-3 Multi Tap Delay, and NFX-4 EQ Contour. These plug-ins are not only processor-
efficient, but their parameters can be automated via MIDI control. 
 
NFX Common Attributes 
All NFX processors have certain common characteristics. 
 
Title and Description Bar 
 

 
 
The top of the plug-in provides several functions. 
 
1  Input: This shows the input to which the plug-in is attached or assigned to.  
2  Name: Indicates the plug-in’s name and function. 
3  Close button: Closes the effect GUI. 
4 Bypass button: Toggles the effect in and out, allowing for instant comparison between the dry and 
processed signal. When bypass is on, you won’t hear the effect. 
5 Patch Dropdown list: Click on the drop-down menu to see the list of available patches (presets) for the 
effect. Selecting a patch from this list loads it into the plug-in. Default presets cannot be overwritten, but you 
can save custom presets. 
6  File menu: Allows saving/recalling individual presets and banks of presets to/from your hard disk. 
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Preset Management 
· To select a patch, select it from the drop-down menu. 
 

 
 
· To add a preset you’ve created to the collection, go further down the preset dropdown list and select “Add 
current preset to collection…” 
 

 
 
· A dialog appears where you can name the preset. After naming it, click on OK. Your preset now shows up as 
part of the list. 
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File Management 
Once you have created custom presets or banks of presets, you can save those to the hard disk for later recall, 
or for transferring to other GigaStudio systems.  
 
· Click on the File button to bring up the Load and Save dropdown list. 
 

 
 
· Once the list appears, you can choose to load a bank file, save the current bank of presets, load an individual 
preset, or save the current preset. When saving, you will be prompted to enter a bank or preset name. 
 
Adjusting Levels 
Input Level 
The Input Level setting adjusts the amount of dry signal fed to the plug-in. If you set the input level is too high, 
the Clip light will illuminate. If that happens, lower the input level control. 
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Input Mute 
You can mute the individual left and right input signals by clicking on the L or R buttons. When turned off, 
they are dark green. 
 

 
 

Effect and Dry Levels 
You can adjust the individual levels of both the effected and dry signals to alter their balance. To mute one or 
both channels of the effected and/or dry signals, click on the L and R buttons to mute or enable the left and 
right channels respectively.  
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EQ Contour Controls 
Each plug-in has a three-band EQ section, called EQ Contour.  
 
Setting band levels: The three bands are represented graphically on the right, and adjusted by the Low-Me-
dium-High knobs on the left. Each slider adjusts its band’s level from -18dB to +18dB. 
 

 
 
Setting band ranges: You can edit the frequency range covered by the low and middle bands in a 
complementary way; in other words, if the low band covers a wider frequency range, the middle band will 
cover a narrower frequency range. To adjust the frequency where the low band ends and the middle band 
begins, edit the Low/Mid knob position until the split between low and mid bands occurs at the desired 
frequency. Note that the high band always has its low frequency set to 2kHz. 

 

 
 
MIDI Control 
Every plug-in slider is automatable via an assigned MIDI controller. To begin the assignment process, click 
on a parameter’s drop-down arrow, or right-click on a slider, to bring up the MIDI Control menu. From this 
menu, you can choose to configure the MIDI controller, or display the MIDI control settings. 
 
Display MIDI Control Settings 
This window displays all MIDI Controllers that have been assigned to the plug-in. To reset them all and erase 
all MIDI controllers settings, click on the Reset All button. To close the window, click on OK. 
 
MIDI Control Configuration 
This is where you select a MIDI Port, MIDI Channel and Controller for each parameter you want to automate. 
Click on Set Automation to assign the various MIDI controllers you want to use to automate the plug-in 
settings. 
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NFX-1 Reverb Parameters 
The NFX-1 provides reverberation, the effect created in a space as sound bounces off walls and creates myriad 
reflections. The NFX-1 offers several parameters for customizing the sound. 
 

 
 
Room Size: This determines the volume of the virtual reverberant space. A larger size has a longer decay, and 
gives a more spacious effect. A smaller room size gives a “tighter” sound that decays more rapidly. 
 
Pre Delay: This sets the amount of time between the initial signal and the start of the reverb, thus letting you 
hear a few milliseconds of dry signal before the reverberated signal begins. This can enhance the realism of 
instruments supposedly playing in a hall; just like in a real hall, you will first hear the direct sound followed 
by the room ambience. 
 
Damping: Air absorbs high frequencies more readily than low frequencies, and delays the high frequencies a 
little bit as well. Sounds that are further away have less perceived high frequency content. The Damping 
control creates the effect of pushing the sound further away or bringing it closer by shortening the high 
frequency decay time compared to the overall decay time. This also imitates the way various materials in a real 
room (curtains, rugs, people, acoustical treatment) absorb the sound.  
 
Decay: This sets the length of the reverb’s decay time. Combining this with the room size allows for many 
possible ambience characteristics. For example, you could have a large room size, but give it a smaller decay 
time to minimize “muddying” or “blurring” the mix. 
 
Diffusion: Diffusion controls the amount of space between the reverb reflections. Higher diffusion settings 
give a “smoother” ambience because the reflections are closer to each other, and are recommended for drums 
and other percussive sounds. Lower settings sound more “grainy” with percussive instruments, but are 
appropriate for vocals and sustained sounds, as the sustaining nature of these sounds tends to fill in the spaces 
between reflections. 
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NFX-2 Chorus Parameters 
The NFX-2 chorus multiplies the sound of a single instrument to sound like it’s playing en ensemble with 
itself. This can produce a richer, thicker, more animated sound. The effect is created by slightly delaying the 
original sound, detuning its pitch very slightly, then combining this delayed/detuned signal with the original. 
 

 
 
Speed: This controls the rate of the detuning effect provided by the Chorus LFO (low frequency oscillator). 
Slower speeds tend to produce a more subtle, “rolling” effect. 
 
Depth: Sets the amount of detuning that occurs during chorusing. Excessive settings will produce an “out of 
tune” effect. 
 
Feedback: Determines how much of the chorus signal output returns back to the input. More feedback creates 
a thicker sound, as the chorused sound is re-circulated and “re-chorused.” 
 
Delay: Alters the time difference between the start of the original and doubled signal. Longer delays create 
more of an echo effect, whereas shorter delays produce a sound more like “flanging.” In between these 
extremes is a “sweet spot” that gives the ensemble effect. 
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NFX-3 Delay Parameters 
The NFX-3 is a sophisticated delay that produces echo effects. It includes four separate delay lines within the 
effect, each of which is adjustable to produce delay effects.  
 

 
 
Tap: Click on any of the four Tap buttons to highlight it and edit the parameters of that particular tap.   
 
Auto Pan: Clicking on these buttons enables a “ping-pong” auto pan effect for tap 1 and/or 2, where each echo 
automatically pans back and forth between the left and right channels. There are associated Speed and Depth 
controls to control the panning rate and panning width, respectively. 
 
Delay: This control sets the amount of time between the start of the original sound, and the onset of the first 
delay. Note that when it is also possible to sync delay time to the host sequencer when GigaStudio 4 is in 
ReWire mode, as indicated by the note values on top of the delay time line. 
 
Feedback: Without feedback, the delay line produces only a single echo. Feedback re-circulates the delay’s 
output back to the input, thus producing a series of delay as the echoed sound becomes re-echoed. Each echo 
diminishes in intensity until the sound decays. 
 

Damping: This control reduces the high frequency response of the re-circulated signal, so each repeat has a 
slightly duller sound. This emulates the way that echoes sound in the real world, as well as the sound 
associated with vintage tape echo machines. 
 
Pan: This sets a tap’s position in the stereo field. 
 
Volume: Edits the level of the initial delayed sound. 
 
Speed: This varies the amount of delay over time to create a more animated, modulated sound. Slower speed 
settings tend to create a more subtle effect. 
 
Depth: Sets the modulation depth. More depth causes a greater difference between the minimum and 
maximum delay times, thus creating a stronger modulation effect. 
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NFX-4 EQ Contour Parameters 
This plug-in is essentially the same as the EQ Contour section included in the other NFX plug-ins, but 
available separately. For information on the parameters, refer to the section EQ Contour Controls under NFX 
Common Attributes.  
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CHAPTER 10: GIGAPULSE 
 

 

 
 

GigaPulse employs convolution processing to create incredibly realistic reverb, mic modeling and 
instrument resonance simulation. Convolution uses an actual recording as the basis for signal processing, 
essentially sampling the sound of a room. For example, the sound of a concert hall is recorded with a set of 
unique tones. This “impulse” recording can then be imported into GigaPulse Pro for processing.  
 
An impulse can also be included/encoded into a sampled instrument or .gig file. When this instrument is 
loaded into GigaStudio, the FX light will illuminate on the MIDI Mixer channel, and you can bypass the effect 
by clicking on this button. The pulldown menu will open the GigaPulse SP interface for parameter editing. 
The result sounds like you’re playing in that hall. GigaPulse Pro can also be used as a stand-alone NFX plug-
in on your own sample libraries. Use the new piano resonance model included with GigaPiano II on your 
favorite piano library, or use GigaPulse’s surround reverb on your GigaStudio instruments. 
 
All the elements of the GigaPulse interface are described in detail in this section. 
 
Title Bar  

 

 
 
The title bar of the GigaPulse window shows the channel pair of the insert or aux buss assignment and the 
instance of the interface that is being used. It is possible to have as many instances of GigaPulse as your system 
resources will allow. 
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Dismiss the interface window by clicking on the X in the upper right hand corner. GigaPulse will remain 
active while it is hidden from view. To remove the GigaPulse completely, and free up your system resources 
for other tasks, select “Remove” from the insert drop-down list in the Input, Group, or Aux Buss in the DSP 
Station. 
 
You can listen to the dry, unaffected signal, by clicking the Bypass button. When the button is active 

GigaPulse is bypassed. 
 

Top drop-down list 
Click the bank/preset select button for a list of available banks and presets within the current active bank. 
There is also a shortcut for adding the current active preset to the bank. 
 

 
 

Click the File button to open a list of options for loading and saving banks and presets. 
 

Acoustic Space 
 

 
 

The Acoustic Space section contains a graphic, such as a photograph of the current active placement as well as 
information regarding the names of the bank, preset, impulse, and instrument. 
 
Alternate View button 
An alternate graphic, when available, can be shown with the V button next to the Acoustic Space graphic. This 
may be a credit for the recording engineer or information about the impulse library developer. 
 
Bank 
A file name for the Bank (.FXB) loaded. A drop-down list of all available banks in the defined search paths is 
displayed in the list. 
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Impulse Set 
There is a one-to-one correspondence of bank names to impulse sets. A bank (.FXB) contains the impulse set 
as well as the presets that are defined for that impulse set. 
 
Preset: 
A preset will have a defined musically useful context for the bank (.FXB) and its impulse set. 
 
Instrument: 
Displays the active instrument utilizing the GigaPulse instance. A full list of all the currently loaded 
instruments is available in the drop-down list. 
 
File Menu: 
The File Menu consist of a list of options for creating, opening, saving banks and presets as well as building 
your own impulse sets.  Please check the release notes and electronic documentation for the latest updates on 
the GigaPulse file menu options. It is also possible to load your own impulse wave files and encode your own 
musical context settings as instrument impulse sets or encode the impulses to a Gig instrument. 
 
New… 
Create a new blank preset. Define your own parameters and save with options described herein. You will be 
prompted to save the current active preset before proceeding. You will then be able to create an Instrument 
Impulse Set (.iis) using the IIS Builder. Using the builder, you will then be able to save these instances as preset 
bank (.fxb) files. 
 
Open Preset… 
Open an existing preset (.fxp). You will be prompted to save the current active preset before proceeding. 
 
Open Bank… 
Open an available bank (.fxb). A bank will contain from one to any number of defined presets. 
 
Save Preset Within Current Bank (as new)… 
This is a shortcut operation. It enables you to quickly perform a save operation without a prompt for a 
location and filename. Save the current active preset as new within the current bank. This will add the preset to 
the bank and not overwrite the current preset’s last saved state. 
 
Save Preset Within Current Bank (overwrite)… 
Overwrite the current active preset within the current bank. This will replace the preset from its last saved 
state to its current active state. The old preset will be gone forever. 
 
Save Preset… 
Save a preset (.FXP) to a specified location within a standard file browser window. 
 
Save Bank… 
Save a bank (.FXB) to a specified location within a standard file browser window. 
 
Edit Current IIS 
Opens the IIS builder for defining parameters for the current impulse set. 
 
Rescan Bank/Preset Directories 
Depending on the search paths defined in the Configuration dialog, GigaPulse will scan to refresh its 
awareness of newly added banks and presets. 
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Set Current Bank/Preset as Default 
This will define the current active preset as the default setting when the bank impulse is loaded. 
 
Configuration… 
Define search paths and options for the banks and mic models and their associated file types. Recommended 
file types are: 
 

• .IIS (instrument impulse set) 
• .FXB (bank) 
• .FXP (preset) 

 
TurboMode ->PureMode (not recommended) 
Pure Mode is a 100% mathematically perfect convolution. This is very CPU intensive. It is useful for some 
special applications, but most often the Turbo Mode, utilizing TASCAM’s patent-pending efficient 
convolution algorithm, is recommended. 
 
Turbo Mode is the default mode for GigaPulse and employs a computationally optimized technology for the 
convolved signal. When TurboMode is enabled, the tail model is employed. It provides extremely high-
quality convolution with significant CPU computational savings. Tail Model is designed for use with very 
long impulses. GigaPulse convolution gives you roughly 3 seconds of 32-bit floating point processing at 
48kHz. The included bank 0026-Ten Second Smooth Algorithmic Hall (2 channels, 1 position).fxb, for 
example, gives you ten seconds of processing utilizing both the Turbo algorithm and the tail model. 
 

Please note that Pure Mode has an effective limit of 3 seconds (at 48kHz). This is presently the limitation 
placed on the convolution engine for maximum computational efficiency.  
 
 
Cascade button: 
It is possible to gain the benefit of two different convolved impulse responses, for instance a violin body as 
well as a room, without having multiple instances of GigaPulse. To do this you would first make all the violin 
body resonance settings and then select the Cascade mode. Next, select a room and make its settings. Now you 
have a violin body resonance cascaded through a room all within the same instance of GigaPulse. The same 
result can be accomplished by using two separate instances in series, but at a greater cost of computational 
resources. 
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Placement Selection 
 

 
 

Placement Selection Grid 
The placement selection grid is a re-configurable display that is closely matched to the particular impulse 
responses (IRs) that have been taken. In the example shown, seven microphones were used – indicated by the 
round buttons. The labels indicate the mic positions: 
 

L  Left 
C  Center 
R  Right 
Lw   Left wide 
Rw  Right wide 
Ls   Left surround 
Rs   Right surround 

 
In this example there are 18 different locations in the room, and the 7 microphones all recorded each of the 18 
different locations. These are the actual IRs used to derive all other virtual placements, after the fact, through 
the GigaPulse convolution engine. 
 
NOTE: Location placement works best on instruments that have a localized sound radiation pattern – like a 
single clarinet, oboe, or trumpet – since the sound is coming from a single point in space. Placement of these 
types of instruments is very simple. Just click on a placement (numbered square button) and you have located 
that instrument within the room. 
 
For most stereo instruments, Multi-Placement mode is recommended. This provides a huge benefit using the 
convolution technology: it preserves the spatial cues that are already in the stereo image and even creates a 
surround version on top of that. 
 

Multi-Placement Mode 
In multi-placement mode, there is a color association between the microphone and its selected placement. In 
the above example the left close mic (L) is linked to placement 2 and the right close mic (R) is linked to 
placement 8. The left wide mic (Lw) is linked to placement 1 and the right wide mic (Rw) is linked to 
placement 9. 
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To enable multi-placement mode, control-click a microphone (round button) then click on a room placement 
(square button). The color of the microphone and room placement will match. If all of the microphones and 
room placements are the same color, then you are in single-placement mode.  
 
You will notice that the spatial presentation remains intact. With a sting section sample, the violins will still 
be localized in the left channel and the basses to the right, but we have gained the benefit of convolution reverb, 
and hear the radiation of the sources in the room relative to their placement within the room. To hear the 
difference, click the BYPASS button. 
 
For example, to create a surround reverb: 
 

• [ctrl]-click on the left mic (L) and a close left placement (2) 
• [ctrl]-click on the right mic (R) and a close right placement (8) 
• [ctrl]-click on the left wide or surround (Lw or Ls) and a distant left placement (12) 
• [ctrl]-click on the right wide or surround (Rw or Rs) and a distant right placement (17) 

 
Room placement can be particularly effective on orchestral samples that were not recorded with their historic 
seating locations, such as those from Vienna Symphonic Library®. For example, VSL violin samples are 
typically recorded with a wide left-right spread. Try routing them through GigaPulse and setting a multi-
room placement of 1 and 4, or 10 and 13 for a more live sound.  
 
Bank Select Using Room Placement 
With many gear emulation impulse response banks and presets, such as the included presets from Larry Seyer 
Digital®, the round “mic” buttons indicate available outputs in five channel surround and square “placement” 
buttons indicate variations which can be multi-selected to the various output channels. For example: 
 
• [ctrl]-click on the left front output (Lf) and any variation (F) 
• [ctrl]-click on the right front output (Rf) and any variation (B) 
• [ctrl]-click on the left surround output (Ls) and any variation (L) 
• [ctrl]-click on the right surround output (Rs) and any variation (J) 
• [ctrl]-click on the center output (C) and any variation (H) 
 
In multi-select mode, notice that there is a same-color association between the emulated reverb output and its 
selected variation. A mono input or stereo input can then produce a five channel surround output using the 
output channels of the reverb unit. 
 
Help button 
Open a specific help file, if available, for the loaded impulse set. 
 
Grid button 
Click the Grid button to toggle the view of the grid lines in the Placement Selection display. 
 
Mult button 
When a multi-selection is active, the Mult button will be on. 
 
Description field 
This field, at the bottom of the grid window, has two displays. One field displays title information regarding 
the preset while the other displays useful information on how to best apply the preset in a musical context. 
Toggle between the two by clicking on the field. 
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Input Levels 
 

 
Bypass button 
When this is a bright green color, the Input levels are bypassed and will not pass any signal through the 
GigaPulse engine. When the button is grey, the input signal will be processed. 
 
Master 
This the volume control for the impulse response sample. When this is increased the impulse overall volume 
is increased, this control does not affect the incoming audio volume. The Master Level control affects the 
processed (convolved) portion of the signal including all the Mic Groups only if you are using a wet/dry mix 
of other than 100% wet. This is not an input level control. On a channel insert in DSP Station this provides a 
100% wet/dry ratio. 
 
When using a GigaPulse on an Aux Buss, be sure the Input or Group channel fader is all the way down (off) 
and the Aux send is set to PRE fader. This will eliminate any dry signal from being routed to the mix, which 
would introduce an artificial or “incorrect” signal in addition to the convolved signal. 
 
Left 
The Left Level control affects the left channel signal balance. Its overall level is set by the Master level. 
 
Right 
The Right Level control affects the right channel signal. Its overall level is set by the Master level. 
 
Mic Masters 

 

 
 
The Mic Masters section is a set of controls that act as an overall control for any enabled Mic Groups. The 
default control of all the Mic Group settings is matched by the master settings. If the individual Mic Group 
settings are adjusted individually, the masters control them keeping their settings relative to one another. 
Mute button 
Mute all the Mic Groups. 
 
Mic Level 
Adjust the overall level of all the active Mic Groups. 
 
Perspective 
Adjust the relative perspective of all the Mic Groups. The nominal setting (zero) is the exact point where the 
impulse response was sampled. By moving the slider, you are applying an envelope to the IR and changing it 
in real time as you move the slider control. 
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Another way to describe perspective is that it is like getting closer (tighter) to the sound source or further 
away (looser) except for the timing aspect of mic placement. You get the net effect of more direct signal and 
less reverberation, or just the opposite, depending on the positive or negative setting. 
 
Using the perspective, you can control the closeness of the mic placement without affecting the timing (phase 
alignment) of the source the signal. It's generally better to adjust Perspective instead of changing your wet/dry 
mix to change the sound of the room.  
 

Wet/Dry Mix 
Adjust the ratio (balance) of wet versus dry signal for all the Mic Groups. Most often, a convolved room 
should be used with a 100% wet mix and Perspective should be used to change the room tone. Most signal 
processor equipment emulations should be set to 50/50% mix. 
 
Pre-Delay 
This setting delays the impulse up to 64 samples, in order to compensate for latency introduced in the IR. It 
may be used to align multiple mic positions for phase discrepancies. 
 
If you need more room placements than the one provided in the preset bank,, or there is a need to place a source 
either in-between, beyond, or in front of the available IR placements, then the Perspective and Pre-Delay 
controls can help to achieve the desired virtual placement within the selected environment. 
  
Mic Master On button 
Enable a Mic Group channel by clicking On button so that it is active. When you select a mic button in the 
Placement Selection grid the corresponding Mic Group On button will follow the selection. 
 
Front, Wide, and Surround Mic Groups 

 

 
 

Controls for the individual Mic Group channels. 
 
MSDEC button 
This can be used for decoding an Mid-Side-encoded sampled instrument or impulse response. MS recording 
uses a Cardoid and Figure-8 microphone placed at right angles to create a stereo image.  
 
There are some interesting possible applications using stereo source material and convolving it with an MS-
encoded impulse response, using the MSDEC, and get some interesting spatial variations. Keep in mind that 
just as with any other MS type recording, you do not have individual left and right channel volume, but more 
of a single volume (point source) along with a width control. 
 
A good application of a Mid-Side IR would be for mono sampled instruments gaining the ability to adjust for 
the amount of ambience, or width, in real time. In terms of system streaming and efficiency, you are only 
pulling one stream of samples off the hard drive yet output up to seven channels of audio from that one stream 
using the GigaPulse Pro interface. You can always MS decode any normal signal. It won’t be a correct signal, 
but you may find a use for that anyway. 
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Mute buttons: 
Mute individual Mic Group channels. See the Mic Masters section for more details. 
 
Mic Level: 
Adjust the individual Mic channel levels. See the Mic Masters section for more details. 
 
Perspective: 
Adjust the individual Mic channel perspectives. See the Mic Masters section for more details. 
 
Wet/Dry Mix: 
Adjust the individual Mic channel Wet/Dry mixes. See the Mic Masters section for more details. 
 
Pre-Delay: 
Sample accurate adjustment for time alignment. See the Mic Masters section for more details. 
 
Mic Channel On button: 
Enable a Mic Group channel by clicking On button so that it is active. When you select a mic button in the 
Placement Selection grid the corresponding Mic Group On button will follow the selection. 
 
Microphone Replacement 
Each of the mic groups has its own mic replacement selection menus for the original mic as well as the 
replacement mic. Each default setting is normally in the none-flat setting (no mic models being used at all). 
Application: If you have a sampled instrument library that used a particular microphone, you would select that 
mic from the “Original Mic” list, for instance the U47.  
 
Of course, every microphone is different due to variations in manufacturing, age, and wear and will have a 
slightly different impulse response. If a given microphone is kept in mint condition, it should be close to the 
ones used for the GigaPulse mic models. All the GigaPulse mic models have the following qualities: 
 

• original factory condition 
• representative of shipping models, no custom modifications 

 
With this in mind, the end result is not going to be perfect, given the physical variables that are possible, but 
there will be a significant result, nonetheless. 
 
Original Mic  
In the “Original Mic” drop-down list the “inv” represents an “inverse” impulse response. This essentially 
removes the character of the selected microphone from the original sampled instrument library. 
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Replacement Mic 

 
 

Click on the “Replacement Mic” drop-down menu and select a different microphone model such as the C12. 
The result would be as if you recorded the samples with the C12 rather than the U47. 
 

Some of the microphones have choices for patterns and roll-off settings. The C414EB Emulated, for example, 
has three different patterns: omni, cardioid, and figure of eight. 
 

 
 

Many mics have only a flat roll-off setting. The MD421 has only one available polar pattern, yet it has five 
different roll-off settings. The SM57 has a flat setting as well as 2 different proximity settings, taking 
advantage of the favorable proximity effect for certain applications, such as snare drums and guitar amps.In 
addition to replacement mics there are some exciter models, "de-boxinator" processing, guitar pickups and 
more.  
 



GigaStudio 4 Reference Manual  161 

Mic Model Performance 
Selecting inverse and emulated mic models function in a “cascade” sense, in that there is no additional 
processing required of the GigaPulse NFX plug-in. So if you select a room and a microphone, you will not be 
increasing the computation. The GigaPulse will do all the necessary pre-processing of the affected signal in 
order to minimize the amount of computation. It is all self-contained within each instance of the plug-in. 
 
For example, use an instrument body resonance placed in a room with a selected replacement mic model, all at 
the computational cost of only one GigaPulse plug-in. The computation needed is governed by the size of the 
longest impulse, usually the room. Mic model and instrument body resonances tend to be very short in 
duration.  
 
Center Mic Group 
The Center Mic Group channel is identical in functionality to the other Mic Groups except that only one 
channel is available in this group. No Mid-Side decoding is available for the Center Mic Group. 
 
Tail Model 

 

 
 

GigaPulse runs in one of two modes: Turbo Mode or Pure Mode. Pure Mode is a 100% mathematically 
perfect convolution and is very CPU intensive. Most of the convolution processing is happening in the –80dB 
(and down) end of the dynamic range. This results in spending a great deal of computational resources on 
portions of source material that, even in a solo context, would be for all practical purposes inaudible. 
 
GigaPulse uses pure convolution for the first 3 seconds of the affected signal. Most common impulse 
responses would adequately fit into the 3 seconds available for most musically useful spaces. After 3 seconds, 
the Tail Model takes over with a recursive-type algorithm that analyzes the convolved signal and its decay and 
matches it tonally continuing with the decay of the signal. Tail model won't gain much in CPU savings for 
shorter IRs. 
 
Enable  
The default state for Tail Model is on and this is highly recommended. 
 
Overlap 
The overlap control is a 0-127 min-max setting. Generally the better results are in the higher numbers. It is a 
timing offset and crossfade parameter for the original impulse response convolved with the source material to 
the tail model portion of the processed signal. 
 
Level 
Adjust this to match the levels of the original signal to the tail model signal. 
 
Cutoff 
The Cutoff control is essentially a low pass filter. Adjust this to match the tonal quality of the original signal 
to the tail model signal.  
 
Note: Using Tail Model on impulses with an artificial envelope to emulate a decay is not recommended. The 
tail model is designed to work well on impulses that are cut off at the end of their sampled duration. Applying 
a tail model to an impulse response with an artificial decay envelope will not give satisfactory results. 
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Mic to Mixer Routing 
 

 
 
This matrix allows for assigning mic groups to the DSP Station. For example, when you instantiate a 
GigaPulse NFX plug-in as an insert on Input channels 15:16, the mics span across channels 15, 16, 17, 18, 19, 
20, and 21.  Notice that the Mic to Mixer Routing assignments begin on the assigned channel number and span 
out over the next seven channels. 
 
In some cases, such as an instrument body model impulse response, the mic selections would all necessarily be 
set to one stereo pair of Inputs in the DSP Station. Then you would go about selecting the preferred 
combinations of mics and placements as in a normal stereo tracking session. 

 

Mode drop down list 

 
 
The Mic to Mixer Routing matrix has a list of options for stereo or surround modes. 
 
The 7-channel mode (shown above) provides for routing up to seven microphones to seven discrete mixer 
channel assignments. 
 

 
 

True Stereo Mode provides for routing up to seven microphones to two discrete mixer channels in a left and 
right (stereo pair) alternating fashion. 
 
Simulated Stereo Mode routes all seven microphones to both channels. The simulated stereo is adjusted with 
a width control (0-127) and an image control (0-127). 
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Mixer Matrix: 
Assign mics to a mixer channels by clicking on the buttons in a corresponding row (mic) and column (mixer 
channel). 
 
Front L:   The front left mic as displayed by the round L button in the Placement Selection grid. 
Front R:   The front right mic as displayed by the round R button in the Placementgrid. 
Wide L:   The wide left mic as displayed by the round Lw button in the Placement grid. 
Wide R:   The wide right mic as displayed by the round Rw button in the Placement grid. 
Surr L:   The surround left mic as displayed by the round Ls button in the Placement grid. 
Surr R:   The surround right mic as displayed by the round Rs button in the Placement grid. 
Center:   The center mic as displayed by the round C button in the Placement grid 
 
 
Importing Stereo WAVE Files into GigaPulse 
 
You can create your own GigaPulse preset bank using WAVE files. Below are the steps to create a GigaPulse 
bank and preset from a stereo .wav file. 
 
First, insert GigaPulse on an input channel strip on the DSP station. Then from the File drop down menu 
above the CASCADE button, choose New.  
 

 
 
 

In the GigaPulse Impulse Set Creator window fill in the following fields: 
 

• The Name of your Impulse Set 
• An Overall Description of the Impulse Set 
• Image Path for this Impulse Set (Overall Image) – this is the secondary image that can be viewed in 

the Acoustic Space window when it is clicked on or the V button is pressed at the bottom right corner 
just outside of the graphic. This graphic needs to be either a .png or .bmp file formatted to 224 W X 
126 H pixels. 

• Help File Path for this Impulse Set (Optional) – if you wanted to include documentation about your 
impulse you could attach it to this impulse set as a any of the following file formats: .hlp, .html, .chm, 
.txt, .doc. 

• Specify Microphone Placements Used 
• Check the box next to the (greyed out) LFront and RFront buttons. 
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Click on the Advanced Plaement Cfg button at the bottom of the GigaPulse Impulse Set Creator Screen. 
 

• Check the box for the Background Image for Source and Mic Placement Window. 
• Browse, via the […] button, to the image you want to display in the Placement Selection window, the 

larger picture on the right side of the GigaPulse GUI. This graphic needs to be either a .png or .bmp 
file formatted to 368 W X 207 H pixels. 

• In the Grid Image for Source and Mic Placement Window area select, click next to, “Don’t Display 
Default Grid at Startup”. This will prevent the graph or grid lines from displaying on your selected 
graphic. 

• Click OK to exit this screen  
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Once back on the Source and Mic Placement Advanced Options screen. Click on the Add button at the top 
right of the Specify Source Signal Placements Used section. This will take you to the placement window. 

 

 
 

• Click on the Next Source button until the greyed out number in the Label field says 5. Don’t worry 
that this is greyed out. 

• Now check the Enable this Source Placement box. 
• Click on the Guess Fill button at the bottom of this window in the Update Local Source Placement 

section. This will auto fill in a few of the text fields for us.  
• Now change the number in the Source Placement Cfg Name field from 5 to 1. 
• Do the same for the Source Placement Cfg Description 
• And change 5 to 1 for the Label field in the Source Placement Location/Orientation section 

 

 
 

 

 

• In the Source Placement Cfg Image Path click on the browse button at the far right […] and select 
your default Acoustic Space image. This graphic is the default image for the Acoustic Space area 
shown when your bank or preset is selected and should be either a .png or .bmp file formatted to 224 
W X 126 H pixels. 

• In the Microphone Recorded Data for this Source Placement area click on the […] button for the LF 
row. 
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• Browse to your stereo impulse wave file and click Open. 
• On the Warning screen choose the option “Use Left Data on this audio channel. Use Right Data on 

next audio channel” and click OK. 
 

 
 

Click Done on the placement window, then click Done on the GigaPulse Impulse Creator window.  
 

• If you do not have a help file selected for the Impulse set, just say Yes to the “Problem” Proceed 
Anyway window. 

• Give the Imstrument Impulse Set (.iis) file a name and save it to a logical directory. 
• When asked give the bank file a similar name 
• And agree or say yes when asked to create a new preset file. 

 

Whether your new impulse set shows up for GigaPulse depends on where you have saved your .iis, .fxb & .fxp 
files. If you have saved them to the default GigaPulse directory on your sample drive, 
"E:Tascam\GPulse\Common" then they will automatically show up. If you have saved these files off to another 
directory you can either copy and past them to the default directory or you can add a new directory to the 
search path for GigaPulse. To do this go to the configuration manager:  
 
Start/Programs/Tascam/GigaStudio4/Configuration Manager.  
 
On the GigaPulse/Convolution Tab click on the Add button in the Bank File Search Path and browse to the 
new directory with your newly created .iis, .fxb and .fxp files. 
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CHAPTER 11: MIDI CONTROL 
 

 
Many of the mix, editing, effects, and instrument parameters in GigaStudio can be controlled and 
automated through MIDI.  
 

• MIDI Mixer Port Channels have  3 assignable sliders which default to volume, fine tune, and pan. 
• DSP Station channel strips have  level faders, pan knobs, aux send knobs, dynamics & EQ sliders 
• NFX plug-ins have MIDI  control over all knobs and sliders 
• GigaStudio (.Gig) Instruments can have controllers for attenuation, envelope modulation, filter 

parameters, Dimension controllers, crossfades and more  
 

About MIDI Control 
 

First of all, a few words about terminology when discussing the elements of MIDI Control in GigaStudio 3.0:  
 

• A “control” refers to widgets in GigaStudio, whether it is a horizontal slider, a vertical fader, or  
a knob. 

• A “controller” refers to the MIDI data source used to affect the widgets in GigaStudio. 
• “MIDI Control Source” refers to the external control such as the Mod or Pitch Wheel on your 

keyboard., sequencer, DAW, or GigaStudio MIDI Mixer port channel slider whose data originates 
the “controller”. 

 

MIDI Mixer: Both Control & Controller 
 

The MIDI Mixer is unique in its MIDI Control functionality. In each MIDI Mixer port channel are three 
sliders that can be assigned a MIDI controller. Each of the port channels is by nature port and channel 
dependent. A controller assigned to a slider in port 6, channel 13 will always be associated for that specified 
port and channel only. The other unique property of a port channel slider is that not only can these be 
manipulated from a MIDI Control Source, such as a DAW, they can also manipulate any of the assignable 
widgets in the GigaStudio environment, provided those control widgets are configured to receive the defined 
controller on the correct port and channel. 
 
GigaStudio does not send MIDI out or “thru”, so there are no controllers transmitted to other system MIDI 
devices. On each port channel slot are three assignable sliders: 
 

 
 

The default controllers (and control sources) are Volume (MIDI Controller 7), Pan (MIDI Controller 10), and 
Fine Tune (cents). There are also default data values associated with these controllers at load time. 
 
To assign a different controller, simply click on the arrow button next to the name field for any data slider. 
 

 
 

In this pop-up list is every available MIDI controller (0-127). Also available are Program Change, Fine Tune 
(in cents) and Course Tune (in octaves). To switch to a new setting simply click on the one you want and the 
name field of the data slider will change to reflect the assigned controller. 
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Any or all of the three sliders on each port channel can be set to any MIDI controller available in the list. 
The assigned controller can now be manipulated by a MIDI control source or directly with the mouse and its 
data value will be passed to any widget or instrument parameter set to receive on the same port and channel. 
 
DSP Station 
 
In the DSP Station any of the faders, knobs, and sliders can have an assigned MIDI control source. These 
widgets can only receive a MIDI control data source. They do not pass the data received anywhere else. A MIDI 
control source is assigned to a DSP Station widget a bit differently than in the MIDI Mixer. Choose a widget, 
such as the level fader, and right-click it. 
 
This will open a MIDI Control dialog with user-definable configuration settings for control sources as well as 
defining the behavior of the control and how its control data is handled. 
 

 
 
Upon opening a MIDI Control dialog, it will automatically begin “listening” for a controller source. Simply 
wiggle a knob or fader on a control source or draw some data into a controller track in a DAW and GigaStudio 
will assign it. The default port and channel settings may be changed to any available port or channel as long as 
the control source is set to the same port and channel. 
 
You can over-ride the automatic “listening” state by clicking on the radio button to disable it, so that you can 
select a controller manually. Click the button again to enable the automatic “listening” mode. 
 
A GigaStudio DSP Station widget can have one of two kinds of control: 
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•  Primary MIDI Control (coarse resolution of 0-127) 
• Secondary MIDI Control (fine resolution of 0-16383) 
 

Some widgets have only a primary control while others have a secondary control as well. In the MIDI Control 
dialog, it will be obvious if there is a secondary controller available or not. Secondary controls are provided 
for parameters you may want finer control over, such as volume.  

 

On a control with primary control only, the secondary control will be greyed out (disabled). On a control 

with a secondary control available, the control fields will be active. Click the Cancel button to close the 
window without making changes.  
 

NFX Plug-Ins 
NFX Plug-ins have the same user interface as the DSP station. Keep in mind that changing effect plug-in 
parameters while audio is playing may result in clicks in the audio.  
 
 
MIDI Control Parameters 
 
This section explains the parameters found in the MIDI Control window opened when you right-click a 
control in the DSP Station or an NFX plug-in.  
 

 

Primary Automation 
This set of parameters allows you to specify a controller for MIDI automation. You may select a controller in 
two ways. 
 

1) By selecting the desired controller from the Controller Drop Down list, or 
2) By ‘wiggling’ the desired physical controller (on the specified MIDI Port & MIDI Channel), while the 

‘listening’ text is flashing. 
 
NOTE: You can force ‘Listening’ for the Primary Automation controller by clicking on the 
‘Listening’/’Not Listening’ radio button such that it is in the ‘ON’ state (listening).  This will force the 
secondary automation controller listening mode to the ‘OFF’ state (not listening) if it was ‘ON’. You 
can disable ‘Listening’ for the Primary Automation by clicking on the ‘Listening’/’Not Listening’ 
radio button such that it is in the ‘OFF’ state (not listening).  This has no effect on the secondary 
automation controller listening. 
 
NOTE: If ‘Listening’ mode was ‘ON’ when a controller has been selected (either by wiggling the 
desired controller or selecting the control via the drop down list), Listening mode will move to the 
secondary automation control (for 14-bit controls) or remain listening on the primary automation 
control (for 7-bit controls).  If listening mode was ‘OFF’ when a controller has been selected, 
listening mode will remain off (for both automation controller selections) 

 
Once a 7-bit control’s Primary Automation controller is specified, you will have 7 bits of automation 
resolution provided by the controller (0-127). 
 
Once a 14-bit control’s Primary Automation controller is specified, you will have 7 bits of course automation 
control provided by the controller.  Each of the 128 possible controller settings will step the control value by 
increments of 128. 
 
Secondary Automation 
This block allows you to specify another controller for high resolution MIDI automation. You may select a 
controller in two ways. 
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1) By selecting the desired controller from the Controller Drop Down list, or 
2) By ‘wiggling’ the desired physical controller (on the specified MIDI Port & MIDI Channel), while the 

‘listening’ text is flashing. 
 
NOTE: You can force ‘Listening’ for the Secondary Automation controller by clicking on the ‘Listening’/’Not 
Listening’ radio button such that it is in the ‘ON’ state (listening).  This will force the primary automation 
controller listening mode to the ‘OFF’ state (not listening) if it was ‘ON’. You can disable ‘Listening’ for the 
Secondary Automation by clicking on the ‘Listening’/’Not Listening’ radio button such that it is in the ‘OFF’ 
state (not listening).  This has no effect on the primary automation controller listening. 
 
NOTE: If ‘Listening’ mode was ‘ON’ when a controller has been selected (either by wiggling the desired 
controller or selecting the control via the drop down list), Listening mode will move to the primary 
automation.  If listening mode was ‘OFF’ when a controller has been selected, listening mode will remain off 
(for both automation controller selections) 
 
Once a Secondary Automation controller is specified, you will have 14bits of automation resolution provided 
by the controller (0-63838).  The course resolution (high order 7bits) are provided by the Primary 
Controller.  The fine resolution (low order 7bits) are provided by the Secondary Controller. 
 
NOTE: This block will be greyed out for 7-bit controls. 
 
Reverse Polarity 
 
                   0              127 
 
 
 
 
 
 
 
 
          

   127                0 
                                      
 
When you select ‘Reverse Polarity’ under ‘Controller Value Polarity’, you are remapping the associated 
controller’s values in reverse order. 
 
In the above diagram, the Original Controller Values between [0 and 127], will be remapped to [127 and 0] 
(respectively). 
 
NOTE: If you are using two controllers to achieve 14bits of automation resolution, the above-mentioned ‘127’ 
maximum controller value will be ‘16383’. 
 
 

Controller Value Range After Reversing Polarity 

Original Controller Value Range 
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Controller Value Clipping 
 
                   0              127 
 
 
 
 
 
 
 
 
                                MinClippingValue              MaxClippingValue 
 
 
When you have selected ‘Clip To Range’ under ‘Controller Value Range Modification’, you are remapping the 
associated controller’s values outside the specified range to the limits of the range. 
 
In the above diagram, the Original Controller Values between [0 and MinClippingValue], will be remapped to 
MinClippingValue.  Likewise, the Original Controller Values between [MaxClippingValue and 127] will be 
remapped to MaxClippingValue.  Values between [MinClippingValue and MaxClippingValue] are not 
remapped and the values get passed on ‘as-is’. 
 
NOTE: If you are using two controllers to achieve 14bits of automation resolution, the above-mentioned ‘127’ 
maximum controller value will be ‘16383’. 
 
Controller Value Scaling  
 
                   0              127 
 
 
 
 
 
 
 
 
                                MinClippingValue              MaxClippingValue 
 
 
When you have selected ‘Scale To Range’ under ‘Controller Value Range Modification’, you are remapping the 
associated controller’s values entire range to the limits of the range. 
 
In the above diagram, the Original Controller Values between [0 and 127], will be proportionally scaled to fit 
within the range of [MinClippingValue and MaxClippingValue].   
 
NOTE: If you are using two controllers to achieve 14bits of automation resolution, the above-mentioned ‘127’ 
maximum controller value will be ‘16383’. 
 
 

Controller Value Range After Clipping 

Original             Controller             Value             Range 

Controller Value Range After Scaling 

Original             Controller             Value             Range 
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Reverse Polarity with Clipping  
 
                   0              127 
 
 
 
 
 
 
             127                 0 
  
 
 
 
 
 
 
                                MaxClippingValue              MinClippingValue 
 
 
When you have selected both ‘Reverse Polarity’ under ‘Controller Value Polarity’ and ‘Clip To Range’ under 
‘Controller Value Range Modification’, you are remapping the associated controller’s values as shown above. 
 
First, the Original Controller Values between [0 and 127], will be remapped to [127 and 0] (respectively). 
 
Then, the Values between [0 and MinClippingValue], will be remapped to MinClippingValue.  Likewise, the 
Values between [MaxClippingValue and 127] will be remapped to MaxClippingValue.  Values between 
[MinClippingValue and MaxClippingValue] are not remapped and the values get passed on ‘as-is’. 
 
NOTE: If you are using two controllers to achieve 14bits of automation resolution, the above mentioned ‘127’ 
maximum controller value will be ‘16383’. 
 
USAGE NOTE:  When using reverse polarity and range limiting, set the range limits to the limits you desire 
for the Giga Control (don’t try to reverse or shift the values to account for the reverse polarity). 
 
 
 
Saving Your Changes 
 
Be sure a controller has been specified on the desired port/channel and that any other desired attributes are set, 
then close the window. The next time you enter the automation dialog for the same control, the settings will be 
the same. You may reset the automation by again entering this dialog and setting the controller(s) to ‘No MIDI 
Control’ using the dropdown. 
 
To clear out any automation you have set, be sure NO controller has been specified [“No MIDI Control” in the 
dropdown], then close the window.  This will remove the automation from the control. The next time you 
enter the automation dialog for the same control, the settings will be at their default values. 
 

Original Controller Value Range 

Controller Value Range After Clipping 

Controller Value Range After Reversing Polarity 
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CHAPTER 12: REWIRE 
 

 

GigaStudio can run in either of two modes, standalone or ReWire. 
 
• In standalone mode, the MIDI messages originate from an external source such as a sequencer or MIDI 

controller keyboard, and the MIDI source connects directly to the GigaStudio MIDI In ports. 
• ReWire mode involves using two applications—in this case, GigaStudio 4 and a host DAW such as Pro 

Tools, Sonar, Cubase, Live, Nuendo, Audition, etc.  The ReWire protocol provides “software patching” 
between these applications so that GigaStudio 4’s audio outputs feed directly into the host’s mixer, and 
GigaStudio 4’s MIDI input comes from a software connection from the ReWire host/DAW application.  

 
GigaStudio 4 works as a ReWire synth application, also called slave mode or synth mode, meaning that it must 
work in conjunction with a host program. Both applications have to run on the same computer. When run in 
ReWire mode, it is not necessary for your audio interface to have GSIF drivers because GigaStudio 
communicates directly with the host DAW, not the audio interface. 
 
There is a misconception that ReWire requires considerable computer power. This is not true; ReWire itself 
uses very few computer resources. However, running two powerful programs at the same time definitely 
requires more resources than running just one program. 
 
We’ll cover configuring GigaStudio and setting up a ReWire mixer application in general, then cover 
examples using specific software applications. 
 
Configuring GigaStudio 4 for ReWire 

 
Important: Configure GigaStudio for ReWire first before opening the host application and starting a ReWire 
session. The number of audio channels available depends on how many are configured in both the DAW 
(ReWire master) and GigaStudio (ReWire slave). Up to 64 audio channels (32 stereo) are available from 
GigaStudio 4 for rewiring into the host DAW. 
 
There are two ways to access the ReWire settings for GigaStudio: 
 
• While GigaStudio is open, go Configuration > Rewire/Plugins. 
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• Before opening GigaStudio, go Start > Programs > TASCAM > GigaStudio 4 > Giga Configuration 
Manager and choose the Rewire/Plugins Tab. 

 

 
 
There are three ReWire-related parameters. 
 

 
 
• Number of ReWire channels: This can vary from a minimum of 2 to a maximum of 64. The two-channel 

configuration is ideal if you want to do all your mixing and processing in GigaStudio 4, then simply send 
a stereo mix to the host program. If you would prefer to have individual outputs from GigaStudio 4 
appear in your host (e.g., for additional, host-specific signal processing or to use the host automation), 
then specify the number of ReWire channels and click on Apply. 

• Number of MIDI ports: If your host supports multiple ports, specify the number here. Note that in many 
cases, one port is all you really need as that lets you access at least 16 instruments within GigaStudio 4. 

• Disable ReWire functionality: Make sure this is unchecked to use GigaStudio 4 in ReWire mode. 
 
After configuring these parameters: 
 
1. Click “Apply” or “OK.” 
2. Close the Giga Configuration Manager. 
3. Close GigaStudio if it is running. 
 
Upon opening the host application, it will be aware that GigaStudio can serve as a ReWire slave program, and 
the host will “see” the specified number of ReWire channels. 
 
Open the host application (audio sequencer) and verify that a) GigaStudio 4 is receiving MIDI data from 
whatever input source you are using (e.g., MIDI controller keyboard) and that GigaStudio 4 outs are showing 
up in the host mixer. The following sections regarding individual programs give details on how to make sure 
these conditions are met. 
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Configuring the Host Program for ReWiring with GigaStudio 4: Overview 
Open the host application, and insert at least one ReWire track. The method for doing this varies among hosts, 
as described in subsequent, host-specific sections of this chapter. In most cases, a menu will list all available 
ReWire channels, allowing you to assign these to a sequencer track or effect send/return. GigaStudio will be 
listed as “Giga4” in any ReWire device menu. GigaStudio 4 can send up to 64 ReWire channels (32 stereo) to 
your host’s application audio mixer. 
 
When you insert a ReWire device, some applications launch the ReWire slave application (GigaStudio 4) 
automatically, or at least give the option to do so. If not, then you need to launch GigaStudio 4 manually. When 
GigaStudio 4 opens, note that the status bar along the bottom of the screen shows that it is running in ReWire 
mode. 
 
Changing Memory Buffers for Rewired Applications 
For best performance when using GigaStudio4 in ReWire, you must save your session and close 
GigaStudio4  before making changes to your hardware’s memory buffer settings via your REWIRE host 
application. This will insure that both REWIRE host and slave remain in sync. 
  
 
GigaStudio 4 in ReWire Mode 
When ReWired, GigaStudio will detect that ReWire is activated instead of using its standard audio hardware 
settings, and the number of audio channels specified will instead be routed to the host DAW application. 
 
Each of the channels activated in the host application correspond to the instruments you have routed to the 
output masters in the GigaStudio 4 DSP Station. Do all instrument loading and signal routing in GigaStudio. 
Example: If you load an instrument into port 1, channel 1 and leave the routing as is, the default output 
channels will be R1:2 (the “R” stands for ReWire) in the DSP Station. 
 

 
 
In ReWire mode, instruments in a GigaStudio performance are routed to the DSP Station Output Master 
channel strips. These outputs are designated as ReWire outputs instead of sound hardware outputs, and feed 
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the Output Masters that correspond directly to the number of available ReWire channels in the host. Output 
Master assignments have an “R” prefix to indicate that these are being ReWired. 
 

 
 
Example: Several DSP Station channels could have their outputs set to R1:2. These patch to Output Master 
R1:2, which serves as a “master volume control” prior to going into the ReWire host. If GigaStudio 4 
overloads your ReWire host, reduce the level going to the host using the Output Master level controls. 
 
In the DSP Station, make sure the ReWire channels from each channel strip’s output selection menu are 
assigned to the correct ReWire host application inputs. It is also possible to route one or more DSP Station 
channels to a Group, then assign that Group to the corresponding ReWire channel(s) in the host application. 
 
With a basic ReWire setup, you will be able to play and record MIDI tracks in your host that trigger 
GigaStudio 4 (see the next section), and have its outputs play along with your host’s audio tracks. You can mix 
and process the GigaStudio 4 tracks within the host DAW application environment. It is possible to configure 
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as many ReWire channels as you have available—up to 64 if so designated in the Giga Configuration 
Manager/ Rewire/Plugins tab. 
 
Note: In your host, activate only as many ReWire audio channels as needed for your project. This will lower 
the CPU demands, leaving more computational power for effects such as the GigaPulse convolution engine. 
 
MIDI Host Configuration 
In your host, upon selecting a MIDI track to receive input, route its output to the desired “Giga4” channel. 
Record your playing in this MIDI track, and on playback, GigaStudio 4 will play back the audio triggered by 
the corresponding MIDI data via the host mixer. 
 
To trigger more instruments, create or select another MIDI track, assign it to the next instrument you want to 
record, and start recording. On playback, GigaStudio 4 will play back the audio triggered by the 
corresponding MIDI data via the host mixer. 
 
File Management with ReWired Applications 
ReWire connects the two programs, but has nothing to do with file management. So, save your sequencer 
project and GigaStudio performance (.GSP) as separate files. A good rule when saving files for projects using 
ReWire is to give them the same name, date, version, or any other identifiable characteristic that will help you 
keep your projects organized—one for the host and one for GigaStudio 4 (performance file .GSP). Then you’ll 
have two files with the same names, but different file extensions. 
 
Rendering ReWire Tracks to Audio Files 
With ReWire, it is not necessary to record the output from GigaStudio to audio files. The host application can 
render the GigaStudio ReWired tracks the same way it would any audio track, e.g., by bouncing or exporting 
then importing 
 
By routing GigaStudio tracks individually, you can render or “bounce to disk” one instrument at a time. It 
may be necessary to do this with complex projects that tax your computer’s CPU. To do this, solo a returning 
GigaStudio 4 ReWired audio track, use the host’s render or “bounce to disk” option, then record your 
GigaStudio 4 ReWired track. Repeat this procedure for each track you want to render, and eventually, you’re 
replace all your ReWired tracks with audio tracks. You can then close GigaStudio 4, de-activate the ReWire 
channels, and mix/process your project within your host application. 
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ReWiring GigaStudio 4 with Ableton Live 7 
This procedure is based on Live version 7 for Windows XP, and assumes that you have already set up Live to 
accept MIDI input, and output audio. Numbers in the diagram refer to the steps below. 
 

 
 
1. If you have not used Live yet, run it at least once before proceeding so that Live can install its ReWire 

engine in your system.  
2. With Live open, in either Live’s Session View or Arrangement View, make sure the I/O section is visible 

(click on the small I-O button if the I/O section is hidden). 
3. In an audio channel’s Audio From field, select Giga4. 
4. Set the audio track’s Monitor function to In so that you will hear the ReWire output regardless of Live’s 

record or playback mode. 
5. Launch GigaStudio 4. 
6. In the Input Channel field below the Audio From Field, choose the desired GigaStudio ReWire output if 

you have devices in GigStudio routed to specific channels other than the DSP Station Output Master 
channels R1:2. 

7. In a Live MIDI track, set MIDI From to All Ins and All Channels just to keep things simple. Later on, if 
you need to route MIDI to different channels, select the appropriate channel instead of All Channels. 

8. Also in the MIDI track, set Monitor to In. 
9. Also in the MIDI track, set MIDI To to Giga4, and select the Giga instrument that should receive MIDI 

data in the field immediately below the MIDI To field. 
10. If you play your MIDI keyboard, you’ll hear GigaStudio’s audio coming out of Live’s audio track. 
 
GigaStudio 4 is now ready to run in ReWire Slave mode, while Live is the ReWire Master. You can record the 
GigaStudio ReWire input in Live as you would with any other input in Live. (For more application-specific 
information on ReWiring, see the r Live manual.) 
 
To disconnect the ReWire connection from Live, quit GigaStudio 4 first. 
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ReWiring GigaStudio 4 with Sony Acid Pro 6 
Acid has supported ReWire since version 4.0. We’ll assume you have already set up Acid to accept MIDI 
input, and output audio. 
 
1. If you have not used Acid yet, run it at least once before proceeding so that Acid can install its ReWire 

engine in your system.  
2. Open Acid, then go to Acid’s Insert menu and select Soft Synth. Go to the ReWire Devices tab and select 

an available GigaStudio 4 ReWire device. Click on OK. If a windows says “Giga4 has no MIDI Ports 
Available,” no problem—Acid has taken over control of the ports. Just close the window. 

 

 
 
3. Scroll the Acid mixer window to find the new stereo bus for the Giga4 ReWire device. 
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4. Launch GigaStudio 4. 
5. Repeat steps 2 and 3 if needed to send more outputs from GigaStudio 4 to Acid Pro. 
6. Go Insert > MIDI Track. 
 

 
 
7. A MIDI track appears in Acid. In the MIDI track’s output port field, choose the appropriate GigaStudio 4 

instrument. 
 

 
 
8. Play your MIDI keyboard, and you’ll hear GigaStudio’s audio coming out of Acid Pro’s mixer. 
 
Gigastudio 4 is now ready to run in ReWire Slave mode, while Acid is the ReWire Master. You can record the 
GigaStudio 4 ReWire input in Acid as you would with any other input in Acid. (For more application-specific 
information on ReWiring, see the Acid Pro manual.) 
 
To disconnect the ReWire connection from Acid Pro, quit GigaStudio first. 
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ReWiring GigaStudio 4 with Steinberg Cubase 4 and Nuendo 
This procedure is based on Cubase 4 for Windows XP, and assumes that you have already set up Cubase to 
accept MIDI input, and output audio. The procedure for Nuendo is virtually identical. 
 
1. If you have not used Cubase 4 yet, run it at least once before proceeding so that Cubase 4 can install its 

ReWire engine in your system.  
2. Open Cubase, create a project or open an existing project, then go to the Devices menu and select Giga4 

Rewire. 
 

 
  
3. Activate the appropriate ReWire channels in the “Giga4” window that appears, and which shows the 

available ReWire channels. To activate, click on the small “international power on/off” symbol buttons. 
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4. The activated ReWire channels will become available as channel strips in the Mixer. The channel strips 
show up to the right of the audio and MIDI channel strips, and function like any other Mixer audio 
channels. 

 

 
 
5. Launch GigaStudio 4. 
6. Create a MIDI track in Cubase 4, and assign its output to the appropriate GigaStudio 4 instrument. 
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7. Play your MIDI keyboard, and you’ll hear GigaStudio’s audio coming out of Acid Pro’s mixer. 
 
Gigastudio 4 is now in ReWire Slave mode, and Cubase 4 is the ReWire Master. You can render the 
GigaStudio ReWire input in Cubase 4 as you would with other tracks. (For more application-specific 
information on ReWiring, see the Cubase or Nuendo manual.) 
 
To disconnect the ReWire connection from Cubase 4, quit GigaStudio 4 first. 
 
ReWiring GigaStudio with Pro Tools LE 7.4 
 
This procedure is based on Pro Tools version 7.4 for Windows XP. 
 
1. If you have not used Pro Tools yet, run it at least once before proceeding so that Pro Tools can install its 

ReWire engine in your system. 
2. In Pro Tools, go Track > New. In the Create field, choose the number of outputs specified in GigaStudio 4, 

divided by 2. (e.g., if you’ve configured 8 ReWire outs in GigaStudio, create 4 tracks). Specify a Stereo 
Instrument Track, with the timing option of your choice (typically Ticks). 

 

 
 
3. In Pro Tools’ Mix window, click a track’s Insert selector and go Multi-Channel Plug-In > Instrument > 

Giga4 (stereo). GigaStudio 4 will launch automatically. 
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4. Pro Tools’ ReWire dialog box opens. Click in the Giga4 field, and choose the desired ReWire outputs. 
 

 
  
5. Repeat steps 4 and 5 until all desired GigaStudio outs have been assigned to Pro Tools tracks. 
6. In the Mix window, select the desired MIDI output for a channel that’s ReWired to GigaStudio 4. Pro 

Tools will display the name of the instrument(s) loaded into GigaStudio 4, making it easy to select the 
right instrument. 

 

 
 
7. Make sure that on the MIDI Mixer page, each instrument goes to the desired DSP Station input, that each 

DSP Station output goes to the correct Output Master, and that each Output Master is set for the correct 
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ReWire bus. Example: If you want the second DSP Station channel to go to ReWire outputs 3+4, make 
sure the lower output field of the channel says R3:4, or the output goes to an Output Master that is routed 
to R3:4. 

8. In GigaStudio, load instruments, performances, FX and convolution as you normally would. Save any 
new performances or changes to performances. 

 
Note: In Step 3, you can select Multi-Mono Plug-In > Instrument >Giga4 if you would prefer to use 
individual mono signals from Giga4 instead of stereo. 
  
To disconnect GigaStudio 4 from Pro Tools, select No Insert instead of Giga4 in the Insert Selector. Note that 
this does not unload GigaStudio 4; to do that you must close the GigaStudio application itself, or alternately, it 
will be unloaded when quitting Pro Tools. 
 
 
Pro Tools System Performance Optimization Tips 
• In Pro Tools’ Setup > Playback Engine menu, set the CPU Usage Limit to 65% or higher. You may need to 
increase the DAE Playback Buffer before raising the CPU Usage Limit over 65%. On some Pro Tools LE 
systems, it may be necessary to raise the CPU Usage Limit to 80% or higher. 
 

 
 

• For Pro Tools LE systems, in addition to the normal Pro Tools LE hardware system requirements, a 
3GHz or faster computer with at least 1GB of memory is recommended for use with GigaStudio 4. 
There may also be a reduction in the overall number of concurrent RTAS plug-ins possible while 
running concurrently with GigaStudio 4. 
 

• If you’re using an Mbox USB/Pro Tools LE system, lowering the H/W Buffer Size (in the Setup > 
Playback Engine menu) may lower latency and improve real-time performance, but reduce the 
amount of achievable polyphony. Due to the somewhat higher inherent latency with a USB interface, 
an MBox USB system may not be suitable for live MIDI playing with  GigaStudio 4. 
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ReWiring GigaStudio 4 with Cakewalk Sonar 7 
This procedure is based on Sonar version 7 for Windows XP, and assumes that you have already set up Sonar 
to accept MIDI input, and output audio. 
 
1. If you have not used Sonar yet, run it at least once before proceeding so that Sonar can install its ReWire 

engine in your system.  
2. Go Insert > ReWire Devices > Giga4. You can set the following options in the Insert Soft Synth Options 

dialog. 
 

 
 

• Create MIDI Source Track – If checked, this will create a new MIDI track designed for driving 
GigaStudio and named “Giga4.” 

• Synth Track Folder – If checked, this creates a track folder and places the GigaStudio audio and 
MIDI tracks within it. This is recommended, as it makes for a neater track view. 

• First Synth Output – If checked, this option creates a new audio track that receives the first Giga4 
audio output. This would receive the GigaStudio 4’s DSP Station Output Master channels for R1:2. 

• All Synth Outputs Stereo – This option automatically creates stereo audio tracks for each ReWire 
channel available in GigaStudio 4, and sets the input for each track to the corresponding channel. 

• All Synth Outputs Mono – This option automatically creates mono audio tracks for each ReWire 
channel available in GigaStudio 4, and sets the input for each track to the corresponding channel. 

• Synth Property Page – If selected, Sonar will open the GigaStudio 4 GUI automatically when you 
insert the soft synth. 

 
3. If you did not select the “Synth Property Page” option noted above, launch GigaStudio 4 manually. 
4. Open the “In” pop-up for a Sonar audio track and the Giga4 ReWire application will now be available on 

the menu, with GigaStudio’s ReWire channels listed on the sub-menu. Selecting a channel will direct the 
output from GigaStudio to the selected track. Repeat this step for all the ReWire channels you want to use 
in Sonar. 
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5. If you selected Create MIDI Source Track, make sure its output is assigned to Giga4. Then click on the 

track to select it. 
 

 
 
6. Play your MIDI keyboard, and you’ll hear GigaStudio’s audio coming out of Sonar’s mixer. 
 
Gigastudio 4 is now in ReWire Slave mode, while Sonar is the ReWire Master. You can render the GigaStudio 
ReWire input in Sonar as you would with other tracks, using the “Bounce to Track(s)” option in the Sonar Edit 
menu. (For more application-specific information on ReWiring, see the Sonar manual.) 
 
To disconnect the ReWire connection from Sonar, quit GigaStudio 4 first. 
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ReWiring GigaStudio 4 with Cakewalk Project5 
This procedure is based on Project5 version 2.5 for Windows XP, and assumes that you have already set up 
Project5 to accept MIDI input, and output audio. 
 
1. If you have not used Project5 yet, run it at least once before proceeding so that Project5 can install its 

ReWire engine in your system.  
2. Right-click in the Track area, then select Insert Instrument > ReWire Devices > Giga4. 
 

 
 
3. Click on the track’s Show Instrument button, or launch GigaStudio 4 manually. 
 

 
 
4. With the track still selected in Project5, play your MIDI keyboard. You’ll hear GigaStudio’s audio 

coming out of Project5’s mixer. If not, click on the Show Track Inspector button, and make sure that the 
MIDI input is set correctly. 
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Gigastudio 4 is now in ReWire Slave mode, Project5 is the ReWire Master. (For more application-specific 
information on ReWiring, see the Project5 manual.) 
 
To disconnect the ReWire connection from Project5, quit GigaStudio 4 first. 
 
 
 
ReWiring GigaStudio 4 with Adobe Audition 3 
This procedure is based on Audition version 3 for Windows XP, and assumes that you have already set up 
Audition to accept MIDI input, and output audio. 
 
1. If you have not used Audition yet, run it at least once before proceeding so that Audition can install its 

ReWire engine in your system.  
2. Choose Multitrack View. 
 

 



GigaStudio 4 Reference Manual  190 

3. Go Edit > ReWire Setup, and click the ReWire tab.  
 

 
  
4. Click Enable. The dialog box automatically lists all installed ReWire slave applications.  
5. Check the Giga4 box.  
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6. Choose one of the following track assignment options:  
 

 
 
• Insert Summed Stereo Output Into First Available Track: All ReWire devices are summed to a stereo 

output, which is routed into the first unoccupied track in the current session.  
• Insert All Outputs To Individual Tracks: This option routes each available ReWire output to its own 

track, starting with the first unoccupied track and following contiguously until all tracks are assigned.  
• Insert Outputs Manually Using Track Device Input Dialogs: Choose this option if you want to assign 

outputs manually by using track Input menus. 
 
7. Click Launch to launch GigaStudio 4 and establish the ReWire connection. Adobe Audition assigns 

outputs from GigaStudio 4 to one or more tracks, as specified by the previously-selected track 
assignment. 

 

 
 
Gigastudio 4 is now in ReWire Slave mode, and Audition 3 is the ReWire Master. (For more application-
specific information on ReWiring, see the Audition manual.) 
 
To disconnect the ReWire connection from Audition, quit GigaStudio 4 first. 
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CHAPTER 13: CONFIGURATION AND TROUBLESHOOTING 
 

 
This section of the manual will explain the settings in the GigaStudio Settings and Giga Configuration 
Manager windows. It will also suggest some possible troubleshooting tips if you have problems getting your 
GigaStudio system up and running. See the GigaStudio 4 Quick Start Guide for a step-by-step walkthrough 
on getting GigaStudio up and running in the Giga Configuration Manager.  
 
 
Giga Configuration Manager 
 
You can open the GigaStudio Configuration Manager directly from the Windows Start Menu.  
 

 
 
This will enable you to configure MIDI and audio hardware and software settings and will help to minimize 
any potential conflicts with other demands already placed upon your system resources.  If you're starting 
GigaStudio for the first time, it will prompt you to open this window by default.  
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Synthesizer Settings 
 
Select the Synthesizer tab. Here are settings for polyphony, capture as well as other settings in GigaStudio. 
 

 
 

Polyphony Settings 
Maximum polyphony is determined by the performance and hardware capabilities of your computer system. 
This section of the Synthesizer tab has a polyphony slider and slightly to the right is a setting for maximum 
polyphony. 
 

 
 

The Maximum Polyphony field can be changed to any number from 1 to well over a thousand voices. 
Depending on the system performance, this setting will need to be fine tuned for the optimum setting. Click 
on the up and down buttons to increment by one, or click in the center handle and drag the mouse cursor up or 
down to rapidly increment this setting. Click the Apply button to save your changes. 
 
As more polyphony is requested, more system resources must be allocated for handling the voice streams. 
Some of the system memory will be allocated to these polyphonic streams and will no longer be available for 
loading instruments. In order to help you to gauge this allotment of memory, there is a graphic display just 
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below the polyphony slider that dynamically tracks these memory requirements based on the amount of 
memory installed in the system. 
 

 
 

As you move the polyphony slider up towards the top of its travel, you'll notice the memory requirements 
will change. More voices of polyphony requires more RAM to buffer the note attacks, so less RAM will be 
available for loading instruments.  
 
The "Alter Transition Voices to steal notes for block chords" slider allows you to adjust the  group of voices 
called ‘Transition’ voices. Transition voices ramp down at an accelerated rate when the sampler is in a stressful 
situation. Using the transition voices the sampler can provide the user with transparent dynamic voice 
allocation even during a stressful passage. Transition voices do come at a cost and should not be set arbitrarily 
high. In most cases, this setting should be left at the default setting. 
 
 

Bounce To Disk 
This is essentially an enhanced “capture to wave” function allowing for multi-track recording of the master 
channel outputs of the GigaStudio DSP Station.  
 
Capture bit depth is set to “Track Hardware Bit Depth” by default. This option will set the capture bit depth to 
the same as that of the audio hardware bit depth setting in the Giga Configuration Manager > Hardware tab 
discussed later. 
 

 
 
You can select any bit depth that your audio hardware driver is capable of supporting. In this case, we can 
select from 16, 24, or 32 bits per sample. You should consider the proper setting to match the other audio files 
in your project, as well as that of your target delivery format. 
 
Audio capture is buffered by the system to record as many as 64 audio tracks simultaneously. Some systems 
may benefit from additional buffering than the default 0.5 MB.  This is dependant on your audio card’s total 
audio output stream capability. 
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An 8-channel audio card will be capable of 8-channel capture to wave. The buffer size setting can be increased 
to compensate for dropouts in the audio files captured, if you find it is necessary. 
 
Synthesizer Engine Settings 
Adjust master attenuation and dither (if necessary). 
 

 
 

Master Attenuation sets attenuation on the overall output of the output master channels of the GigaStudio DSP 
Station. With extreme amounts of polyphony, the levels of a mix can become saturated at the outputs. You may 
find it necessary to apply a judicious amount of attenuation to the master outputs. You should monitor your 
sound card hardware mixer utility to see if you are overloading at the outputs. 
 
Dither should only be enabled if you reducing the bit rate output to 16. Most modern professional sound cards 
are 24-bit and will require no dithering. If you do have dither enabled on a 24-bit sound card, the sound 
quality can be degraded by the unnecessary dither. 
 
Stacked Instruments 

 

 
 

Stacked instruments are managed by MIDI bank select. With this setting, banks can be defined as long as they 
are assigned a number that is greater than 127. The first 128 (0-127) banks are reserved for normal instrument 
assignments. 
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Mixer Engine 
 
Define the number of mixer input and group channels. You can have 32-128 mixer input channels (up to 64 
stereo pairs) and 2-32 group channels (up to 16 stereo groups). 
 

 
 

 

Hardware 
 

 
 

You should have configured the Hardware settings the first time you ran GigaStudio, using the instructions 
covered in the Quick Start Guide. This section will explain the various parameters in this window.  
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Hardware Adapter settings 
Select your GSIF-compatible  audio interface from the pull-down menu. GigaStudio will tell you what version 
of GSIF the interface is to the right of the interface selection:  
 

• GSIF 1 = 16-bit 
• GSIF 2 = low-latency, 24-bit 
• GSIF 2.1 = 24-bit, XP/Vista 64-bit compatible 

 

 
 

You must have a GSIF supported driver for your audio hardware adapter to work with GigaStudio. Most 
professional sound card manufacturers have GSIF driver support for their products. If you do not have a 
GSIF-supported sound card, you can still run GigaStudio in ReWire mode. You can only use it as an integrated 
sampler in your ReWire host DAW application if you are running in ReWire mode.  
 
Sample rate and bit depth can also be configured in this section. It is very important that these settings remain 
consistent throughout all of your integrated audio programs (sequencers, audio editors, multi-track audio 
DAWs) and sound card settings to keep sync, tuning, and timing consistent with other aspects of your project, 
such as video and other time-specific cues. 
 
To the right of these settings are the input and output enable channels.  
 

 
 
Place a checkmark next to the physical inputs and outputs that you want to use on your interface. In the 
example above, I have only selected the analog outputs of my interface. Click the channels to select or 
deselect them.  
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Select MIDI Hardware 
 

 
 

This section of the interface allows you to match physical MIDI ports connected to your system. It is not 
necessary to enable all eight MIDI ports, but you must have at least one port enabled for external MIDI input.  
 
Low Latency MIDI 
If you're using a GSIF 2 interface with audio and MIDI connections, you'll see your MIDI ports displayed a 
second time followed by "[GSIF - low latency]." GSIF 2 allows the sound card to lock the MIDI and audio 
clocks together for even lower latency performance. However, the MIDI jacks must be in the same physical 
interface as the audio I/O.  
 

 
 
ReWire/Plugins 

 

ReWire 
Configure the number of channels, up to 64, you would like to make available to your ReWire host 
application. You can also set the number of MIDI input ports available to ReWire. For more on these settings, 
see the chapter, GigaStudio and ReWire.  
 

 
 
 

Audio/Virtual Instrument Plug-ins 
In this section, you can set up VST-compatible plug-ins for use with GigaStudio. You can use three types of 
VST plug-ins with GigaStudio:  
 

• VST Effect plug-ins 
• VSTi Virtual Instruments 
• GVI Instruments 

 
You can see which VST plug-in directory, if any, GigaStudio is set to monitor in the first plug-in pane. In the 
example below, GigaStudio has not yet been set to monitor a plug-in directory.  
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To choose a plug-in directory, click the "Add/Remove" button. You'll be able to scan your computer using the 
standard Windows Open window to select a VST plug-in path.  
 
To view a list of plug-ins that are available in your system, including plug-ins that were blocked, click the 
"View Plugin Information" button. It will open the Configure Plug-ins window:  

 

 
 

Note: As of version 4.00 of GigaStudio, 32-bit VST and VSTi plug-ins cannot be used in 64-bit mode. This 
may explain why instrument plug-ins are ending up in the "Blocked Plugins" penalty box on a 64-bit system. 
Plug-ins are also placed here if GigaStudio crashes while scanning them for the first time.  
 
Using GVI Instruments in GigaStudio  
Instruments "Powered by GVI" can be loaded in GigaStudio and played with the same kernel-level 
performance as GIG files. Set the GVI Instrument search path the same way you set the VST search path above.  
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Once the GVI plug-in is installed and authorized, you can load GSI files from the library the same way you 
would load normal GSI files.  
 

 
 
TIP: simply double clicking on the appropriate line in the search path list box can quickly disable a search 
path. Conversely, the path can be re-enabled by again double clicking on the search path. 
 
 
GigaPulse/Convolution 
This window sets the search path for GigaPulse impulse files. The top section of the window loads bank files 
(reverb and instrument impulses). The bottom section specifies microphone modeling impulse files.  

 

Moving your reverb impulses to an external hard drive, just like moving GIG files to an external system 
drive, can help increase GigaPulse performance. GigaPulse banks can stream from the same hard drive as your 
GIG files.  
 
You can add and remove search paths for the impulse files in this window. It is recommended that you leave 
the other settings at their defaults unless instructed by TASCAM operational support.  
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Troubleshoot 
If you should have problems getting GigaStudio to run properly, the Troubleshoot tab contains a number of 
helpful options for isolating the source of the problem. Many of these settings are best used when GigaStudio 
is not running – quit GigaStudio and launch the Giga Configuration Manager from the Windows Start menu.  
 
Startup Options 

 

 

 
This section allows you to disable sections of GigaStudio for the purpose of Troubleshooting. This can help if 
you're trying to narrow down the root for a problem. For example, if you suspect that GigaStudio is having 
trouble with the latest driver version of your audio interface, try turning it off, disabling the hardware and see 
if GigaStudio launches.  
 
Warning Messages 

 

These are all enabled by default. Deselect an option to disable any warning messages. If you have no Giga 
compatible (GSIF) sound card installed, you may still run in ReWire mode, but you will always get a warning 
that you have no Giga compatible cards installed ay time you launch GigaStudio.  In this setup, it would be a 
good idea to deselect the “No Giga Compatible Cards” warning message. 
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Diagnostics 

 
 
This section allows you to run a diagnostic utility with several levels of options so that you can e-mail the 
report to TASCAM tech support. The Debug mode is a sophisticated extension of the diagnostics utility 
recommended for advanced users only. 
 
System Memory Configuration 

 

 
 
Clicking the "Configure" button allows you to optimize the memory settings for GigaStudio. This is not 
necessary for the 64-bit version of GigaStudio.  
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The Memory Configuration Panel allows you to optimize the memory in a 32-bit operating system so that 
more RAM will be available to GigaStudio.  
 
To run the memory test:  
 
1. Quit GigaStudio and launch the Giga Configuration Manager in standalone mode.  
2. Select "Preset 1" from the Preset Configuration List 
3. Click "Run Memory Test" and make a note of the memory capacity it tells you.  
4. Close the window and quit Giga Configuration Manager by clicking the close boxes.  
5. Open the Memory Configuration panel again, select the next preset, and run the test again. 
6. Repeat steps 4 and 5 until you have gone through all of the presets. 
 
Whichever preset gets the "high score" – the highest memory percentage – that's the preset to use. If you're 
seeing weird errors when you open an instrument, you make have the wrong preset selected for your PC.  
 

GigaStudio Settings 
 

General 

 

 

External Editor/Sequencer  
This section assigns a default application for those buttons in the main application toolbar:  
 

 

From left: GigaEditor, Sequencer, Wave Editor, QuickSound 
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Browse to the program file location of your preferred sequencer and wave editor application. It must be 
located on the same computer as GigaStudio. 
 
There is also an instrument editor, which launches the GigaStudio Instrument Editor. You can change this 
default if third-party tools become available. 

 
Startup and Recovery 
You can set GigaStudio to load a default performance or load the last performance used.  
 
“Load the last Window sizes and position at startup” retains the size and position of the interface elements of 
the last saved session. 
 
“Always start audio engine during startup” enables the audio engine automatically whenever GigaStudio is 
started. This is recommended unless you are having difficulties with your audio hardware when starting 
GigaStudio. You can then use this option as a means of troubleshooting your system at startup.  
 
When GigaStudio is already running, you can start and stop the audio engine by clicking the tool bar icon to 
enable/disable it. When the audio engine button is running as normal, the state will be displayed with a red 
square in its corner.  

 
 
If you stop the engine, the button will show a green pointer in its corner and your audio interface at the bottom 
of the GigaStudio mixer will have a red highlight. Stopping the audio engine can help resolve a program 
conflict or audio driver problem. 
 

 
Visual Preferences 
GigaStudio auto-hides the cursor when you adjust a fader or knob so that you can see the parameter you're 
changing. To disable this feature, uncheck the "Auto hide cursor" box. You can also decrease the user interface 
refresh rate and quality for better polyphony performance.  
 
Reset Options 
These checkboxes set the default behavior of the Reset button. “Reset Instruments” will clear any instruments 
currently loaded into the MIDI Mixer port channel slots as well as any loaded in memory. 
 

• “Reset Mixer” will return all mixer settings to their default state. 
• “Reset Hardware” will clear any audio driver buffers and streams that are currently active. 
• “Reset User Interace (Window sizes and positions)” is like the startup option. The main difference is 

that this setting is used specifically for a “Reset” operation while the startup is intended to be used as 
a “startup state”. You may wish for both to do exactly the same thing. If you would prefer not to 
retain the window sizes and positions on a “Reset” then you should leave this option disabled. 

• “Load Default performance after reset”. Use this option to load a preferred default performance upon 
“Reset” whether or not you have defined this as a “startup state”. 

 
Use combinations of reset options depending on the project and its specific needs. Here are some examples: 
 

• Reset only the loaded instruments while retaining all the mixer settings and window positions and 
sizes. 

• Reset only the hardware in the case of overly stressed hardware/drivers. 
• Reset the preferred default performance such as an orchestral template with a palette of instruments, 

mixer settings, effects, and all the window sizes and positions. 
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Performance/Instrument Loading 
 

 
 

Performance 
“Remember recent performance files” will define a number from 0-16 recent performance files in the File 
menu list. 
“Remember recent .gig files” will define a number from 0-16 recent instrument files in the File menu list. 
 
Loading/Removing 
"Ask for confirmation on 'Unload all instruments" will prompt you when you clear the RAM buffer.  
 
General MIDI Support 
Define a folder where your General MIDI library is located. This helps GigaStudio to make instrument 
assignments by program change numbers whenever a standard GM file is dragged to the MIDI Mixer 
interface. A standard file browser window is provided for this preference. 
 
“Launch Sequencer on downloading MIDI file” will open your sequencer automatically whenever a standard 
GM file is dragged to the MIDI Mixer interface. This feature particularly pertains to certain GM libraries for 
GigaStudio such as the Conexant GM500 General MIDI sample library available from TASCAM®. 
 
 
General PC Optimization 
Here are some general tips for optimizing Windows XP for use with GigaStudio or any other Windows 
application. Start by making sure that Windows is running normally: 
 
  
  1.  Begin with a fresh install of Windows XP. 
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  2.  Open Control Panels, open the System control panel and select the Hardware tab. Click the "Device 
Manager" button and look at the list of drivers. Make sure that all devices (AGP, PCI, FW, USB etc…) 
are functioning. (No “yellow exclamation marks” or “other device” categories.) If you see a yellow 
question mark, then you need to install a driver for that device. The device may be a component on your 
motherboard, so try putting in the Install CD that came with your PC Motherboard.  

   
   Now it is recommended that you turn off any services or programs in Windows that run in  
the background. TASCAM Recommends the following XP tweaks:  
   
Note: For consistency, before carrying out the tuning tips suggested below, you may want to switch to classic 
view in the control panel as well as the start menu so that you can follow along:  
  
Start > Control Panel > "Switch to Classic View".  
Start > Control Panel > Taskbar and Start Menu > Start Menu Tab > Classic Start Menu  
  
Switch off the Desktop Background Image  
Right Click Desktop > Properties > Desktop Tab > Background None  
  
Disable Screen Saver  
Right Click Desktop > Properties > Screen Saver > None  
  
Switch off Power Schemes  
Start > Settings > Control Panel > Power Options > Always On > Set: Turn off monitor and  
turn off hard discs to Never  
  
Disable Automatic Desktop Cleanup  
Start > Settings > Control Panel > Display > Desktop > Customize Desktop > Untick "Run  
Desktop Cleanup Wizard every 60 days  
  
Disable Hide Inactive Icons  
Start > Settings > Taskbar and Start Menu > Taskbar TAB > Uncheck "Hide Inactive Icons"  
  
Set Visual Effects to “Best Performance”  
Start > Settings > Control Panel > System > Advanced > Performance Settings > Visual  
Effects Tab > Adjust for best performance  
  
Disable Remote Assistance  
Start > Settings > Control Panel> System > Remote > Untick Allow remote assistance  
invitations to be sent from this computer  
  
Disable Automatic Updates  
Start > Settings > Control Panel> System > Automatic Updates > Turn off automatic  
updating. I want to update my computer manually  
  
Disable System Restore  
Start > Settings > Control Panel> System > System Restore Tab. Tick the "Turn off System  
Restore on all Drives"  
  
Disable Internet Synchronize Time  
Start > Settings > Control Panel > Date and Time > Internet Time > Untick "Automatically  
synchronize with internet time server"  
  
Disable Windows Sounds  
Start > Settings > Control Panel > Sounds and Audio Devices > Sounds Tab > Sound Scheme  
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to None.  
  
Disable Fast User Switching  
Start > Settings > Control Panel > User Accounts > Change the way users log on or off >  
Untick Use Fast User Switching  
  
These are the tweaks that we use on our systems here at TASCAM and they have proven  
effective through the beta testing cycle of GS3 as a good starting point. Our Value Added  
Retailers (VARs) take system tweaks to the next level by fine tuning these tweaks to get every  
last ounce of power out of a PC. They are you best source for a glitch free computer creativity.  
  
A good resource to learn more about these tweaks and how they affect your operating system  
can be found at: http://www.musicxp.net/tuning_tips.php  
 
 
More Troubleshooting Tips 
 
This section may help you if you're having trouble with GigaStudio. Check this section before calling 
Operational Support.  
 
Don't do the '3GB RAM tweak' 
There is a "system hack" for 32-bit operating systems that allows you to access 3GB of RAM in GigaStudio. 
Our advice is to not use that hack. If we thought the system would be stable with that tweak, it would be in the 
software installer to begin with. Mess with Windows registry tweaks at your own peril, but don't complain 
when your system becomes unstable. TASCAM doesn't support this tweak. 
 
Turn off 'Monitor File Activity' 
If you're having problems even when Giga isn't running, try turning off the automatic disk activity 
monitoring. You can turn this off in QuickSound Explorer application. However, when you load new sounds 
into the system, you'll have to manually refresh or rebuild your Quicksound database. (Right click on your 
Gigs disk in the QuickSound database.) 
 
Try 16-bit samples instead of 24-bit samples 
16 bit samples place less of a strain on your system than 24-bit samples do. If you have a 24-bit sample that's 
giving you headaches, try converting it to 16-bit and see if the problems go away. Make a copy of the 
instrument, open it in GigaEditor, go to Edit > Convert Wave Pool Format and convert it to 16-bit or 24-bit 
accelerated.  
 
MIDI Loop 
A MIDI loop in your system can cause problems. You may have a controller keyboard with both USB and 
MIDI connections. If you connect both of these to your computer (USB to the computer and MIDI to another 
interface going to your computer) you may create a MIDI loop. When this happens, a MIDI note message may 
get caught in a feedback loop, repeating over and over, causing note delays overloading the system. If you 
think ths may be a problem, start disconnecting MIDI cables in your system and see if the problem goes away.   
 
MIDI Program Changes and Bank Select 
If instruments are "disappearing," your sequencer or controller keyboard may be sending MIDI program 
changes. Try disabling program changes to see if the problem goes away.  
 
If you're trying to send a bank select message to GigaStudio, it needs to be in the MIDI standard LSB + MSB 
format, sending a command on MIDI Controller 00 and 32. Most sequencers communicate this way, but some 
controllers (e.g. Roand) may not.  
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"My system worked great in Giga 2.54, but GS3 (or GS4) has given me problems." 
Try running the diagnostics report command by going to System Settings > Troubleshoot tab > "Generate and 
View Diags." You'll see a page of code, but what you're looking for is something that says "Found Old 
Binaries." If you see this, then you have old code on the system and you have to reinstall GigaStudio.  
 
Open the Control Panel, and choose "Add/Remove Software." Remove GigaStudio 2 and GigaStudio 3, then 
install GigaStudio 4. Finally, check the TASCAM website for any updates. If that doesn't clear things up, then 
you may have an old video card driver or something else that's mucking things up. 
 
Hearing pops and clicks 
The first thing to look at is the buffer setting in your audio card control panel, the lower the audio buffer 
setting, the greater the chance of pops and clicks. Keep in mind that the higher you set the buffer setting the 
more latency you will experience. You may want to start with a setting of about 256 and adjust accordingly for 
your system.  
  
The other issue may be the hard drive. First make sure you have a second drive just for the .gig samples to be 
streamed from and that your drive meets our spec (7200 rpm or above and a seek time of 8.9 ms or better).  
  
The next thing to look at is how the drive is connected to the computer, If you are using IDE drives make sure 
that you don’t have the drive slaved to anything or have anything slaved from it. The drive must be on its own 
IDE buss set as a master.  
  
The Ideal set up with two IDE drives and a DVD-Rom would be set up like this, The system (boot drive) 
would have the DVD-Rom slaved from it and the Second drive with your .gig samples on it would be on the 
second IDE buss set as a master.  
  
One more thing to look at if it’s not these two issues would be word clock. Check with your audio card 
manufacture to make sure you have the proper word clock setting.  
  
Here is test to narrow down your problem between the audio card or Hard drive.: Use the audio capture in 
Giga to record the sound that you hear the clicks and pops on. When you play it back, if the pops and clicks are 
there then it is your Hard Drive. If they aren’t then it has to do with your sound card driver.  
 
GigaStudio crashes during splash screen 
GigaStudio 4 now supports both VST and VSTi-style plugins. At startup the software will interrogate all the 
plugins in the search paths defined in the ‘ReWire/Plugins’ section of this manual. If a plugin crashes during 
this interrogation, the GigaStudio software could also crash. The easiest way to determine if there is an invalid 
plugin in the system is to launch Giga Configuration Manager (standalone, not from the GigaStudio 
application), disable the VST search paths and restart the GigaStudio application. Also, the plugin’s name will 
be display in the splash screen it is being interrogated. This name can help locate the problem plugin. 
 
QuickSound database is too slow 
If QuickSound is acting very slow – it takes 1-2 seconds to do anything – turn off "monitor file activity" in the 
Edit Settings menu. See the Quicksound chapter for more on this setting.  
 
Major QuickSound database problems 
If QuickSound is crashing or hopelessly confused, open "C:\Program Files\Tascam\GStudio\bin" and delete 
everything in the folder. Launch QuickSound again and rebuild your database from scratch.  
 
Windows Registry Problems 
This section is reserved for Windows specialists, or when you have abandoned all hope and things couldn't 
possibly get worse... 
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Corrupted Registry Settings 
GigaStudio may have corrupted registry settings that are effecting performance or causing crashes. If you're 
no comfortable messing with these settings, you can always reinstall Windows.  
 

1.  Open the Control Panel > Add or Remove Software > Uninstall GigaStudio 
2. Click on the Start menu, choose "Run..." type "regedit" and press Enter.  
3. Remove the following registry branches: 

Under HKEY_CURRENT_USER\Software\TASCAM 
Delete the ‘DataBase’ folder 
Delete the ‘GigaStudio 4’ folder 
Delete the ‘QuickSound’ folder 
Under HKEY_LOCAL_MACHINE\Software\TASCAM 
Delete the ‘GigaStudio 4’ folder 
 

4. Remove the dbase files located in 
C:\Documents and Settings\All Users\Application Data\TASCAM\QuickSound (XP) 
C:\ProgramData\All Users\Application Data\TASCAM\QuickSound (Vista) 

 
 NOTE: These are hidden, system folders that require that you have the Folder Options set to 

‘Show hidden files and folders’ 
  
5.  Restart your system 
6.  Reinstall GigaStudio 4 

 
 
Midi Ports do not show up properly in GigaStudio 
If the ‘green’ ports in GigaStudio do not light, and/or you unable to see the ‘Giga4: Port 1-8’ from the Control 
Panel > Sound And Audio Devices control application, then there is a chance the midi driver is not properly 
installed. 
 

- Use the registry (see previous section) to open  
My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Drivers  

- Take note of the lines that say ‘midi’, ‘midi1’, ‘midi2’, etc. 
 

If the gmidi4.dll is after the ‘midi10’ line then there might be an issue with the Operating 
system, or with old drivers on your system. Try this: 
1. Uninstall GigaStudio 
2. Go back to this registry setting, and find the first line with ‘midiX’ = ‘wdmaud.drv’. It 

might be midi, midi1, midi2,  but hopefully it is before midi10. Now delete that line. 
3. Reinstall GigaStudio 

 
 
Deciphering the GigaStudio log files 
 
GigaStudio diagnostics 
GigaStudio can create a system diagnostic which you can use to find problems in the system. You can create 
these diagnostics by opening the GigaStudio Configuration Manager, clicking the Troubleshoot tab and 
clicking the "Generate Diags" button.  
 
These can be automatically generated to appear here: 
C:\Documents and Settings\All Users\Application Data\TASCAM\GigaStudio 4\System\gigadiags.txt (XP) 
C:\ProgramData\All Users\Application Data\TASCAM\GigaStudio 4\System\gigadiags.txt (Vista) 
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The diagnostic file provides a snapshot of the system. It is typically used to help technical support identify any 
obvious problems with the system. Important fields are: 
 
Product binaries 

• Make sure version numbers are the same 
• Exception to the above rule are perfutility.exe, rewire.dll, synasUSP.sys 

 
System Info 

• This section tells us about the computer, such as how many cores, OS version, drives and memory 
• WaveOut devices lets us know that there is a valid GSIF audio interface 
• Midi Output devices You should see eight‘Giga4: Port X’ devices here. You have a probem if these are 

missing. (Refer to the Midi Ports do not show up properly in GigaStudio section above) 
• Midi In devices should indicate the MIDI hardware connected to your system. 

 
GSIF Hardware Info 

• You need to have at least one GSIF device listed here, otherwise the software will only be able to run 
in REWIRE mode. 

 
Registry Info 

• GigaStudio application settings: 
Software\TASCAM\GigaStudio 4\Settings 

• GigaStudio hardware settings: 
Software\TASCAM\Hardware\Settings 

• GigaPulse settings: 
Software\TASCAM\Gpulse 

• VST/VSTi plugin settings: 
Software\TASCAM\GigaStudio 4\Plugins 

 
Plugin Information 
This sections prints out all the information about the NFX, VST, and VSTis plugins. At the very least, there 
should be 5 NFX plugins in this section: GigaPulse, NFX 1, NFX 2, NFX 3, and NFX 4. 
 
GigaSystem Log file 
This is an internal logging of the kernel mode filter starting up and initializing. It probably beyond the scope 
of this documentation to discuss this section, but here is a typical log of a normal behaving driver: 
 
Log File: C:\Documents and Settings\All Users\Application Data\TASCAM\GigaStudio 
4\System\GigaSystem.log 
 
=================================Process GStudio4.exe is starting GS4 Server  
 
 
Process GS4Server.exe: Loading Kernel level drivers ...  
   InstallDriver(): Unable to CreateService: The specified service has been marked for 
deletion. 
  
   StartDriver(): StartSevice() failed -  The service cannot be started, either because 
it is disabled or because it has no enabled devices associated with it. 
  
   StartDriver(): Even though StartSevice() failed, we will continue on as normal 
   LoadDeviceDriver(): Able to install and start driver: GS4ENGINE (C:\Program 
Files\TASCAM\GigaStudio 4\\system\GS4Engine.sys)  
   OpenDevice(): Failed to CreateFile with name \\.\GS4ENGINE1  
   OpenDevice(): Failed CreateFile with backup name \\.\Global\GS4ENGINE  
   SetSecurityLevelForService(): Finished changing security level. 
   LoadDeviceDriver(): Able to install and start driver: GS4ENGINE (C:\Program 
Files\TASCAM\GigaStudio 4\\system\GS4Engine.sys)  
   GS4Engine.sys loaded on second iteration. 
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Loading Kernel level drivers completed ============  
 
*** Process GS4Server.exe establishing a link with the kernel driver. Driver reference 
count = 2  
 
   _GetGlobalSpaceForProcess(), cnt:1 GS4Server.exe 
MSG32    thread: Thread handle = fffffffe, Id = f48  
MidiLoop Thread creation: handle = e8, Id = be4  
Event    Thread creation: handle = ec, Id = bd0  
Strm Mgr Thread creation: handle = e4, Id = 880  
 
================================= GS4 Server has successfully started/initialized 
 
 
*** Process GStudio4.exe establishing a link with the kernel driver. Driver reference 
count = 2 
 
GigaStudio loader log 
Whenever you load a GIG, GSI or GSP file into GigaStudio, Giga creates a record of that here:  
 
C:\Documents and Settings\All Users\Application Data\TASCAM\GigaStudio 4\loader.log (XP) 
C:\ProgramData\All Users\Application Data\TASCAM\GigaStudio 4\System\loader.log (Vista) 
 
This file provides a log of the last file loaded into the system. This log file can be helpful in diagnosing a 
problem with loading a particular instrument. The information in this file is very detailed and its discussion 
is beyond the scope of this document. If you encounter a problem loading content, please make a copy of this 
file and send it to technical support. 
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